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TRADEMARKS
ASAP is a registered trademark of Micromeritics Instrument Corporation.
MicroActive is a registered trademark of Micromeritics Instrument Corporation.
Micromeritics is a registered trademark of Micromeritics Instrument Corporation.

This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code
is provided under the following license:
This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the use of
or inability to use this software.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it
and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of con-
ditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list of
conditions in documentation and/or other materials provided with the distribution.

3. Altered versions— including, but not limited to, ports to new operating systems, existing ports with new graph-
ical interfaces, and dynamic, shared, or static library versions—must be plainly marked as such and must not
be misrepresented as being the original source. Such altered versions also must not be misrepresented as
being Info-ZIP releases— including, but not limited to, labeling of the altered versions with the names "Info-ZIP"
(or any variation thereof, including, but not limited to, different capitalizations), "Pocket UnZip," "WiZ" or
"MacZip" without the explicit permission of Info-ZIP. Such altered versions are further prohibited frommis-
representative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases.

Copyright

The software described in this manual is furnished under a license agreement and may be used or
copied only in accordance with the terms of the agreement.

____________________________________________________________________________

Copyright © 2020 - 2025. Micromeritics Instrument Corporation. All rights reserved.



WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and
service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their
reliability and durability. However, these materials cannot be totally guaranteed against wear and/or decomposition by
chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization
to return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. Ser-
vice charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our entire
liability in respect to such products, except as an authorized person of MICROMERITICS may otherwise agree
to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves,
seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such
items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of
manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including
but not limited to, the implied warranties of merchantability or fitness for use.
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MICROMERITICS CORPORATE PROFILE
Micromeritics is the global leader in analytical instrumentation for the physical characterization of
particles, powders, and porous materials. Our advanced technologies provide precise
measurement of density, surface area, porosity, activity, and powder flow, supporting research,
product development, and quality control. Serving industries like materials science, chemicals,
energy, and natural resources, our instruments enable critical advancements in fields such as
battery materials, hydrogen economy, and carbon capture. Founded in 1962, Micromeritics
operates globally with over 15,000 instruments in daily use, delivering expert support and cutting-
edge solutions from our U.S. headquarters and international locations.For more information,
please visit www.micromeritics.com.

PATENTS
For patent information, visit www.Micromeritics.com/patents.
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CONTACT US
Micromeritics Instrument Corporation

4356 Communications Drive
Norcross, GA 30093-2901 USA
Phone: 1-770-662-3636
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3636
International: Contact your local distributor or call 1-770-662-3636
Service.Helpdesk@Micromeritics.com

Micromeritics Application Support
Support@Micromeritics.com
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About this Manual

ABOUT THIS MANUAL

The following can be found on the Micromeritics web page (www.micromeritics.com).

n Calculations document (PDF)
n Error Messages document (PDF)
n Operator Manual (PDF)

n Parts and Accessories
n Vacuum Pump Guide (PDF)

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear in this manual:

NOTE — Notes contain important information applicable to the topic.

CAUTION—Cautions contain information to help prevent actions that may damage
the instrument or components.

WARNING—Warnings contain information to help prevent actions that may cause
personal injury.
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GENERAL SAFETY

Do not service or modify this instrument without authorization fromMicromeritics Ser-
vice Personnel. It does not include any user-serviceable parts.

Any laboratory equipment can pose a risk to personnel if not operated or maintained correctly. All
employees who operate and maintain Micromeritics instruments should be well-familiar with their
operation and receive proper safety training and instruction

n Read the operator manual for any special operational instructions for the instrument.
n Know how the instrument functions and understand the operating processes.

n Ensure that personnel use the appropriate personal protective equipment (PPE)
when removing, handling, or repairing equipment. This may include gloves, safety
glasses, or other items specific to the equipment or environment.

n When lifting or relocating the instrument, use appropriate lifting and transporting
devices designed for heavy equipment. Ensure that enough personnel are
available to assist with the movement of the instrument.

When relocating an instrument that has wheels, disconnect the power and any gas
connections. Then, unlock the wheels and roll the instrument on a horizontal
surface, ensuring there are sufficient personnel to keep the instrument from
tipping. When the instrument is in its new location, lock the wheels then connect
the power and gas connections.
The ASAP 2425 weighs approximately 160 kg (353 lb).

n Always follow the safety instructions on the labels affixed to the instrument, and
never alter or remove them. During inspections, verify that the safety labels are
intact and not worn or damaged.

n Regular maintenance is essential for ensuring personnel safety and the efficient
operation of instruments. Consistent upkeep helps enhance safety, ensures
optimal test results, and minimizes costly downtime. Neglecting proper
maintenance procedures can create unsafe conditions and reduce the lifespan of
the instrument.

n Improper handling, disposal, or transportation of potentially hazardous materials
can result in serious injury or damage to the instrument. Always consult the SDS
when working with hazardous substances. Safe operation and handling of the
instrument, supplies, and accessories are the responsibility of the operator.

General Safety
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General Safety

EQUIPMENT REMOVAL AND REPLACEMENT PROCEDURES
Follow these procedures to safely remove equipment from service for repair or disposal and to
ensure safety is maintained when new equipment is put into service.

n Before removing equipment from use for repair or disposal, ensure that all power sources are
disconnected and all stored energy sources have been discharged to prevent accidental injury
to personnel. Refer to the “Power Instrument On and Off” guidelines for more information.

n Only qualified personnel should perform repairs or dispose of the equipment. This ensures that
the work is done safely and that the equipment is properly disposed of in accordance with local
regulations.

n When removing equipment for repair, clearly label it with the reason for removal and the date it
was taken out of service. This helps ensure that the equipment is not put back into service until
it has been properly repaired and tested.

n Depending on the type of equipment being handled, it may be necessary to address
environmental safety, such as preventing spills or leaks of hazardous substances during
removal or transport.

n When moving an instrument to another location (e.g., by car, truck, or plane), the following is
recommended:
o Pack the instrument in the original shipping materials. If such materials are no longer
available, use packaging material (such as a sturdy box with bubble wrap or foam) that will
keep the instrument safe from damage during transport.

o Identify any special handling the package requires (e.g., "Fragile," "This Side Up," or "Do Not
Stack Heavy Items on Top").

o Strap or anchor the package so that it will not tip or fall during transport.
o Inspect the package on arrival to ensure no damage has occurred. If damage has occurred,
contact the responsible party (such as the shipping carrier) for the next steps.

n Follow local regulations and guidelines when disposing of electrical and electronic equipment,
especially if classified as hazardous waste. This may include specific requirements for removal,
transportation, recycling, or other disposal methods.

n Keep records of all equipment removed from service, including the reason for removal and any
repair or disposal actions taken. This helps ensure that the equipment is properly tracked and
that safety issues are addressed in a timely manner.

n Ensure that all replacement equipment meets the same safety standards as the equipment
being replaced. This helps ensure that safety is not compromised when new equipment is put
into service.

n After replacing or repairing equipment, re-calibration or verification may be necessary to
ensure the equipment functions correctly and meets operational standards.

n Before returning equipment to service, ensure that it has been properly repaired and tested to
ensure that it meets all safety requirements. Only qualified personnel should perform this work.
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INTENDED USE

The instrument is intended to be operated by trained personnel familiar with the
proper operation of the equipment recommended by the manufacturer and as well as
relevant hazards involved and prevention methods. Other than what is described in
this manual, all use is seen as unintended use and can cause a safety hazard.

The instrument is intended to be used as per applicable local and national regulations.

TRAINING
It is the customer's responsibility to ensure that all personnel operating or maintaining the
equipment participate in training and instruction sessions. All personnel operating, inspecting,
servicing, or cleaning this instrument must be properly trained in operation and machine safety
before operating this instrument.

Part Name
Hazardous Substances

Lead
(Pb)

Mercury
(Hg)

Cadmium
(Cd)

Hexavalent
Chromium
(Cr (VI))

Polybrominated
biphenyls
(PBB)

Polybrominated
diphenyl ethers

(PBDE)
Cover o o o o o o

Power
Supplies o o o o o o

Printed
Circuit
Boards

x o o o o o

Cables, Con-
nectors &
Transducers

x o o o o o

Diaphragm
Pump (if
applicable)

x o o o o o

Hazardous Substances Table

o Hazardous substance is below the specified limits as described in SJ/T11363-2006.
x Hazardous substance is above the specified limits as described in SJ/T11363-2006.

Equipment Removal and Replacement Procedures
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General Safety

The Environmentally Friendly Use Period (EFUP) for all enclosed products
and their parts are per the symbol shown here unless otherwise marked. Cer-
tain parts may have a different EFUP (for example, battery modules) and are
marked to reflect such. The Environmentally Friendly Use Period is valid only
when the product is operated under the conditions defined in the product
manual.
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SYMBOLS THAT MAY APPEAR ON THE INSTRUMENT

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear on your instrument:

Use extreme caution when working on the instrument where one of these symbols
may be displayed. These symbols indicate the part may be hot and cause serious
burns.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

When working on an instrument where this symbol is displayed, refer to the cor-
responding Operator Manual for additional information.

When this symbol is displayed, toxic or flammable gases require proper venting of
exhaust.

This symbol can also indicate the instrument uses mercury which is an extremely
toxic substance. Read the Safety Data Sheet (SDS) and be aware of the hazards of
mercury and know what to do in the event of a spill or an exposure incident.

Equipment Removal and Replacement Procedures
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1 ABOUT THE ASAP 2425
Surface area and porosity are important physical properties that influence the quality and utility of
many materials and products. Therefore it is critically important that these characteristics be
accurately determined and controlled. Likewise, knowledge of surface area and especially
porosity often are important properties in understanding the formation, structure, and potential
application of many natural materials.

High Performance and High Sample Throughput. The automated Micromeritics® ASAP® 2425
surface area and porosimetry system is designed to help busy laboratories expand their workflow
while providing highly accurate and precise surface area and porosimetry data. High
performance, versatile analysis, and sample preparation systems are included in the same
instrument.

FEATURES AND BENEFITS

n Fully automated analyses

n High throughput with six independent analysis stations

n Each analysis port has a dedicated analysis and Po pressure transducer

n Twelve independently controlled degas ports

n Evacuation rate precisely regulated by a servo valve

n BET surface area measurements in as little as 1 hour

n Dosing options of maximum volume increment or dosing over specified pressure ranges

n Entered or calculated analysis temperature

n Equilibration option allows user to specify equilibration times for different parts of the isotherm

n Low surface area option with five independent analysis ports

1 About the ASAP 2425
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1 About the ASAP 2425

ANALYZER COMPONENTS FOR THE ASAP 2425 ANALYZER

FRONT COMPONENTS
The upper front panel contains 6 analysis ports. The lower front panel contains 12 degas stations
with status indicator lights and heating mantle connections for each station.

Component Description
A Heating mantle power receptacles

B Heating mantle thermocouple receptacles

C Heating mantle

D Degas ports

E Degas port indicator lights

F Dewar

G High vacuum pump power indicator lights. turn on and remain solid green when
power is applied to the high vacuum pump(s) and they are at full operating
speed. Applies only to units with high vacuum pumps installed

Front Panel Components
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Component Description
H Power indicator light. Blinks when power is applied to the analyzer; illuminates

when the analysis program is initiated and ready for operation.
I P0 port. For saturation pressure tube installation.

J Analysis ports

Front Panel Components (continued)

DEGAS PORT INDICATOR LIGHTS

When an indicator light is red, do not touch the sample tube, heating mantle, or mantle
clip on the associated port. These components may be hot enough to cause burns.

A blinking indicator light indicates the port valve is open. Do not remove a sample tube
or port plug while a valve is open. Doing so could contaminate the degas manifold.

Light Color Description
Red Heat is being applied to the port. Do not touch the sample tube, heating

mantle, or heating mantle clip.
Yellow Cool down is in progress. Heat is no longer being applied to the port, but the

sample tube, heating mantle, and mantle clip may still be hot. Avoid touching
these components.

Green The port has cooled down and is idle. A degas operation can be started.

Indicator Lights

Analyzer Components for the ASAP 2425 Analyzer
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1 About the ASAP 2425

SIDE PANEL COMPONENTS

GAS CONNECTIONS

Component Description
Gas inlet ports 1 - 6 Use to connect up to six analysis gas supplies to the analyzer. When

measuring free space, any one of the ports may be used for helium.
Degas backfill port Allows connection of a gas to use after degassing the sample to back-

fill the sample tube with a clean dry gas.

Side Panel Components
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LOWER RIGHT SIDE PANEL

Component Description
A Port for a shielded Ethernet cable allowing communication between the ana-

lyzer and the computer.
B Service access panel to be used by Micromeritics service personnel.

C Valve circuit breaker to protect the circuitry for the valves in the event of a fail-
ure. If the circuit breaker trips (pops out), call the Micromeritics Service Rep-
resentative.

D Voltage selector switch for setting the analyzer to the correct incoming AC line
voltage.

E Power connector for connecting the analyzer to the power supply.

F Power switch for powering the analyzer on and off. This switch also serves as
the main breaker for the analyzer; it switches off automatically in the event of an
electrical fault.

Side Panel Components

Analyzer Components for the ASAP 2425 Analyzer

ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025 5



1 About the ASAP 2425

REAR PANEL COMPONENTS

A. The vacuum pumps are located on a shelf at the bot-
tom on the unit. Remove the lower rear panel or the
lower front panel of the unit to access the pumps.

B. Vacuum pump power connectors to connect the
vacuum pumps to the power supply.

6 ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025



EQUIPMENT OPTIONS AND UPGRADES
Parts and accessories are located on the Micromeritics web page.

Option Description
Krypton Option For very low surface area analyses. The option consists of a high-

vacuum pump, and 10 mmHg transducer.
Micropore Option For analyses that require measurement and equilibration at

pressures as low as 1.0 μmHg. A 1 mmHg transducer is available for
micropore analyses that require better resolution at lower pressures.

The micropore option is required to run krypton.

Equipment Options and Upgrades
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1 About the ASAP 2425

GAS REQUIREMENTS AND PURITY

Improper handling, disposal, or transportation of potentially hazardous materials can
result in serious injury or damage to the instrument. Always consult the SDS when
working with hazardous substances. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

Compressed gases are required for analyses. Gas cylinders or an outlet from a central source
should be located near the analyzer. Up to five different non-reactive adsorptives— for example,
N2, Ar, CO2, and Kr, plus helium for free space— can be attached to the analyzer simultaneously.
A separate gas inlet is provided for the degas system. Helium or nitrogen are typically used for
degas.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are
required. Pressure relief valves should be set to no more than 30 psig (200 kPag). All gases
should be of a purity listed below. Gas regulators can be ordered from Micromeritics. Parts and
accessories are located on the Micromeritics web page.

Gas Purity

(CGA 580) N2
(CGA 580) He
(CGA 580) Kr

99.999%
99.999%
99.995% (Required for krypton units only)

CRYOGEN REQUIREMENTS
Liquid nitrogen is commonly used as the cryogen to cool the sample during analysis. A liquid
nitrogen transfer system eliminates the need to pressurize storage Dewars. The Model 021 liquid
nitrogen transfer system is available from Micromeritics (www.micromeritics.com).

Improper handling, disposal, or transportation of potentially hazardous materials can
result in serious injury or damage to the instrument. Always consult the SDS when
working with hazardous substances. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.
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SPECIFICATIONS FOR THE ASAP 2425

Voltage 100/115/230V~ (± 10%)

Frequency 50/60 Hz

Power 800 VA, exclusive of vacuum pumps, which are powered sep-
arately

Electrical

Temperature 10 °C to 30 °C (50 °F to 86 °F), operating
-10 °C to 55 °C (14 °F to 131 °F), non-operating

Humidity Up to 90% (non-condensing) for instrument

Indoor Outdoor Use
Indoor only (not suitable for wet locations)
Altitude: 2000 mmax (6500 ft)
Pollution degree of the intended environment: 2

Degree of Ingress
Protection IPX0

Environment

Analysis System 6 sample ports, each with a constantly monitored saturation pres-
sure port

Degas System 12 degas ports, each with independently controlled heating mantle

Capacity

Manifold Temperature
Transducer

Type: Platinum resistance device (RTD)
Accuracy: ±0.10 °C by keyboard entry
Stability: ±0.10 °C per month

Manifold Pressure
Transducer

Range: Vacuum to 950 mmHg operating:

1000 mmHgmaximum
10 mmHg added for krypton option
1 mmHg for micropore option

Analysis System

Specifications for the ASAP 2425
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1 About the ASAP 2425

Resolution: 1000 mmHg Transducer:

0.01 mmHg
10 mmHg Transducer: 0.0001 mmHg
1 mmHg Transducer: 0.00001 mmHg

Accuracy: 1000 mmHg Transducer: within 0.1% FS

10 mmHg Transducer1 ) : within 0.15% of reading
1 mmHg Transducer2 ) : within 0.12% of reading

Includes nonlinearity, hysteresis, and non-repeatability

Sample Port Transducer
and Po Port Transducers

Range: 0 to 950 mmHg
Resolution: 0.01 mmHg
Accuracy: ±0.1% Full Scale

Vacuum Gauge Type: Thermocouple
Range: 0.001 to 1 mmHg

Analysis System (continued)

Height 159 cm (62.5 in.)

Width 103 cm (40.5 in.)

Depth 51 cm (20.2 in.)

Weight 160 kg (353 lb)

Physical

Nitrogen System Pumps
2 oil-based pumps: 1 analysis, 1 degas
4 pumps (optional): 2 oil-free (1 analysis, 1 degas), 2 high vacuum
(1 analysis, 1 degas

Krypton & Micropore
Pumps

4 pumps: 2 oil-free (1 analysis, 1 degas),
2 high-vacuum (1 analysis, 1 degas)

Vacuum System

1 ) The 10 mmHg transducer is active only when performing krypton analyses
2 ) The 1 mmHg transducer is present only in the enhanced micropore option.
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Oil-based mechanical pump: 5 × 10-3mmHg ultimate vacuum
Oil-free and high vacuum pump: 3.8 × 10-9mmHg ultimate
vacuum1 )

Vacuum System (continued)

Capacity 12 degas ports

Vacuum Control Selectable target pressure controls switchover from restricted to
unrestricted evacuation

Evacuation Selectable evacuation rate from 1.0 to 50.0 mmHg/s

Manifold Pressure
Transducer

Range: 0 to 950 mmHg
Resolution: 0.01 mmHg
Accuracy: ±0.1% Full Scale

Vacuum Transducer Type: Thermocouple
Range: 0.001 to 1 mmHg

Titled Backfill Gas User-selectable at dedicated port, typically nitrogen or helium

Temperature Control

Temperature Range: Ambient to 450 °C (Programmable)
Temperature Control: 1 ramp during evacuation phase, 5 addi-
tional selectable ramps during heating phase
Selection: Digitally set, 1 °C increments from computer
Accuracy: Deviation less than ±10 °C of set point at the sensing
thermocouple embedded in the heating mantle

Degas System

Operating System Windows 10 or higher operating system is required.

Desktop Installation
Required

The application should not be installed on a network drive with
shared access.

Multiple users cannot operate the application at the same time.

Computer Requirements

1 ) Ultimate vacuummeasured by pump manufacturer according to Pneurop Standard 5608

Specifications for the ASAP 2425
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1 About the ASAP 2425

Ensure the "Sleep" setting on the desktop is set to
"Never" to avoid interruption while running an analysis.
If this occurs, the application loses network
connectivity with the instrument and a communications
error will be reported. A restart of the Windows
application may be required if automatic reconnection
is not successful.

10 Base T or 100 Base T
Ethernet Port

If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet-based unit is connected to
the same computer, an Ethernet switch will also be required.

Read/Write Permissions All application users will need Read/Write permission to all
directories and subdirectories where the application is installed.

Drives USB port

Computer Requirements (continued)

Due to continuous improvements, specifications are subject to change without notice.
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2 ABOUT THE SOFTWARE

The analyzer allows other computer programs to run while an automatic operation is in progress.
The Helpmenu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its
own tab and reflects data collected during the analysis.

MENU STRUCTURE
All program functions use standard Windows menu functionality. The title bar contains a Unit [n]. If
multiple analyzers are installed, ensure the appropriate unit is selected before continuing.

Selections Description
File Use to manage files used by the application— such as sample files, ana-

lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations. Unit 

[n] displays on the menu bar for each analyzer attached to the computer.
Reports Use to start or initiate reports and view the results.

Options Use to change presentation options, set the method and active metals
defaults, configure signal calibration, manage libraries, select units, and
create report styles.

Window Use to manage open windows and display a list of open windows. A
checkmark appears to the left of the active window.

Help Use to access the embedded operator manual, Micromeritics web page,
and information about the application.

Main Menu Bar Options

2 About the Software
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2 About the Software

COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located in multiple windows throughout the
analyzer application and have the same description or function. Fields and button descriptions not
listed in this table are found in tables in their respective sections. All entry fields will accept
information when using a bar code reader.

Selections Description
Add Adds an item to the list.

Add Log Entry Use to enter information that will display in the sample log report that
cannot be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-axes
to be scaled automatically. Autoscalemeans that the x- and y- ranges
will be set to show all the data. If Autoscale is not selected, the entered
range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field
label name)

Use to enter additional information about the sample, such as a sample
lot number, sample ID, etc.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window and displays a prompt to either accept or
reject changes.

Close All Closes all active windows. If changes were made and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments to display in the report header about the sample or
analysis.

Copies Selects the number of copies to print. This field is only enabled when
Print is selected.

Delete When working with tables, deletes the selected information.

Destination Selects the report destination.

Common Fields and Buttons
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Selections Description
Edit When working with report parameters, highlight the item in the Selected

Reports list box and click Edit to modify the report details.
Exit Exits the application. If a file is open with unsaved changes, a prompt

displays the option to save the changes and exit or exit the application
without saving the changes. If an analyzer is currently operating, an
additional prompt displays to confirm exiting from the software.

Export Exports data in a sample file as a .TXT, .XML or .XLS file. When saved
to a file, the data can be imported into other applications.

File Selects the destination directory. Enter a new file name in the File
name field or accept the default. Select to save the file as a spread-
sheet (.XLS), a portable document format (.PDF), or an ASCII text
(.TXT) file format.

File name Selects a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From / To Indicates the From and To range for x- and/or y-axes when working
with report parameters windows.

Insert Inserts one row above the selected row in the table.

List Creates a list of samples or other types of files. The list will contain the
file name, date/time the file was created or last edited, file identification,
and file status.

Name Contains a list of files in the selected directory or library.

Next Moves to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double-click the file name in the
Name column to open the file.

Prev Moves to the previous window.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer, or file).

Remove Removes the selected file or files from the list.

Replace Selects another file where the values will replace the current file’s val-
ues.

Common Fields and Buttons (continued)

Common Fields and Buttons
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2 About the Software

Selections Description
Replace All Selects another .SMP file where the values will replace all values for

the active sample file. The original file will remain unchanged. No
analysis data is added to the file. The only information added is sample
information, material properties, liquid properties, analysis, and
reporting parameters.

Report Displays a window to specify report output options.

Save Saves changes.

Save As Saves a file in the active window under a different file name. A portion
can be saved as a separate, stand-alone file, such as Analysis Condi-
tions or Report Options, when saving sample information.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Displays the data from the current analysis.

Instrument Log. Displays recent analyses, calibrations, errors, or
messages. Enabled only in Service Test Mode.

Instrument Schematic. Displays a schematic of the analyzer system.

Common Fields and Buttons (continued)
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FILE STATUS
In the File Selector window, theMic Description column and theMic Status column display the file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right-clicking an entry to display a menu of
standard Windows functions.

File Status Description
Analyzing Sample files that are currently used for analysis.

Complete Sample files used in an analysis that is completed.

Entered Sample files containing manually entered data.

No Analysis Sample files that have not been used to perform an analysis.

Prepared Sample files that have been used in an automatic degas operation but
have not been analyzed.

Preparing Sample files that are currently being used in an automatic degas oper-
ation.

File Status

File Status
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2 About the Software

File Type File Name
Extension

Alpha-s Curve1 ) .ALS

Adsorptive Properties .ADP

Analysis Conditions .ANC

Calibration .CAL

Degas Conditions .DEG

Heat of Adsorption
Report

.HOA

Methods .MTH

Report Options .RPO

Sample Information .SMP

Sample Tube Prop-
erties

.STB

SPC Report .SPC

Thickness Curve2 ) .THK

File Type and File Name Extension

1 ) Saves the relative pressures and resulting quantities adsorbed as an ASCII text file. These
data are derived by dividing the isotherm by the quantity adsorbed at 0.4 relative pressure.
2 ) Saves the relative pressures and corresponding thicknesses as an ASCII text file. These data
are derived by dividing the condensed volume of adsorptive by the selected surface area. The
density conversion factor in the adsorptive properties file is used to convert quantity adsorbed to
volume of condensed adsorptive.
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File Type File Name Extension
Portable document
format

.PDF

Report .REP

Spreadsheet .XLS

Unicode .TXT

Extensible markup lan-
guage

.XML

File Types for Printing or Exporting

File Status
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2 About the Software

KEYBOARD SHORTCUTS
Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the
menu command. For example, to access the Filemenu, press Alt + F, then press the underlined
letter on the submenu (such as pressing Alt + F) then pressingO to open the File Selector).

If the underscore does not display beneath the letter on the menu or window, press
the Alt key on the keyboard.

Selections Description
Alt +[Unit n] Opens the Unit [n]menu.

Alt + F Opens the Filemenu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to
save changes displays.

Alt + H Opens the Helpmenu.

Alt + I Opens theOptionsmenu.

Alt + R Opens the Reportsmenu.

Alt + W Opens theWindowmenu.

Ctrl + N Opens a new sample file.

Ctrl + O Opens the File Selector window.

Ctrl + P Opens the File Selector to start a report from a selected .SMP file.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Opens the File Selector window.

F3 When in the File Selector window, opens the file search box.

F4 When in the File Selector window, opens the address bar.

F6 Cascades open windows.

F7 Tiles all open application windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

Keyboard Shortcuts
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Selections Description
F9 Closes all open reports.

F10 Opens the Heat of Adsorption window.

Shift + F9 Opens the shortcut menu of either the selected component on the ana-
lyzer schematic when manual control is enabled or the onscreen reports.

Keyboard Shortcuts (continued)

Keyboard Shortcuts
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2 About the Software

OPTION PRESENTATION
Options > Option Presentation
Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted.
Each display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option

is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted Displays the sample file in a single window like the Basic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same password must be entered
to change to the Basic or Advanced display option. This display type
is typically used in laboratories — such as the pharmaceutical
industry — where analysis conditions must remain constant. The
Advanced option is not available in the view selector at the bottom of
the window when using the Restricted display option.

Show Degas
Conditions

When enabled, displays the Degas Conditions tab when using
Advanced option presentation and the Degas Conditions drop-down
list when using Basic or Restricted option presentation. This option
may be deselected to hide the Degas Conditions tab.

Check Shield When enabled, checks to ensure the shield is in place around the
Dewar or furnace prior to starting an analysis. If this option is
selected and the Dewar or furnace shield is not in place prior to
starting an analysis, a warning message displays on the analyzer
schematic window. An entry is made in the analyzer log regardless of
operator choice. 

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.
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The following examples show the same sample file in Advanced and Basic display. Basic and
Restricted displays will look the same. A password is required if using Restricted format.

Option Presentation Examples

Advanced view Basic or Restricted view

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.

Option Presentation
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2 About the Software

LIBRARIES
Options > Manage Libraries

This feature is not available when using Restricted option presentation.

The library provides an easy way to locate and open specific analyzer files. Libraries are located
within the File Selector window and can be viewed only within the application.

The library gathers sample and parameter files stored in multiple locations, such as folders on a C:
drive, a network location, a connected external hard drive, or a connected USB flash drive, and
provides access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items, such as saved searches and search
connectors, cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original
file storage location. However, when deleting files or folders from within a library, they are deleted
from their original file storage location. Deleted files and folders can be recovered from the
Recycle Bin located on the Windows desktop.
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METHODS

File > New Method

Options > Default Method
File > Open > [.MTH File]
AMethod determines the default sample identification format and sequence number. AMethod is
a template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed. Only a single selection
is required for each new sample file created.

TheMethod drop-down list displays only those methods applicable to the open sample file type.

Default Method Sample file

Selections Description
Sample file name
[text box]

Enter a format for the sample identification. The entry in this field
becomes a part of the saved sample file name. Include the $ symbol
to have the sample file number included as part of the identification.

Sample
Operator
Submitter
Bar Code [text box]

These field labels may be renamed, and the new label becomes a
part of all new sample files.

Sequence number
[text box]

Specify a default numeric string to use as a prefix in the Sample field
when a new sample file is created. This number increments with
each sample file created.

Default Methods

Methods
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2 About the Software

CONFIGURE THE ANALYZER

UNIT CONFIGURATION AND GAS SPECIFICATION

Unit [n] > Unit Configuration
The gases connected to the inlets must be specified in the analysis program. If the gas is changed
on one of the inlets, the same change must be made on the Unit Configuration window.

Selections Description
Calibrations [button] Displays calibration information for analyzer components.

Configuration
[group box]

Displays the IP address used by the analysis program, serial number,
and type of analyzer.

IP address. Displays the IP address of the analyzer.

Change IP. [button] Displays the Board ID dialog, which describes the
circuit boards in the analyzer. Use the Board drop-down list to select a
board to view.

Board ID. [button]Click to display information from the circuit boards in
the analyzer. Use the drop-down list to select a board to view. The
parameters shown cannot be edited.

Gas Selections
[group box]

Displays ports for gas selections.

Options [group box] Displays options installed on the analyzer.

Unit Configuration
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Selections Description
Software Versions
[group box]

Displays the software versions of the MIC BIOS, controller, and ana-
lysis program.

Unit Configuration (continued)

UNIT SELECTION

Options > Units
Use to specify how data should appear on the application windows and reports. This menu option
is not available if using Restricted option presentation in a standard installation environment.

Unit Selection
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2 About the Software

ANALYSIS MODES

The analysis program supports four analysis modes:

n Standard. See Perform a Sample Analysis on page 6 - 17.

In Standardmode, the system performs nitrogen or similar gas analyses. All analyses must
use the same gas. Samples can be removed and added to any of the ports without disturbing
the analyses being performed on other ports.

n High Throughput. See Perform a High Throughput Analysis on page 6 - 20.

In High Throughputmode, up to six nitrogen, or similar gas, analyses are started
simultaneously. All analyses must use the same analysis gas and the same Psat gas, which
may be different from the analysis gas. Once a set is started, no other samples can be started
until the set is complete. The data collection is done in parallel. This mode also supports
measured freespace.

n Krypton. See Perform a Krypton Analysis on page 6 - 21.

In Kryptonmode, the analyses are started simultaneously. Krypton may be dosed from the last
sample ports (port 6). The data collection is done sequentially — one analysis starts and
completes before the next is started.

n Micropore. See Perform a Micropore Analysis on page 6 - 24.

InMicroporemode, up to six analyses are started simultaneously. Once a set is started, no
other samples can be started until the set is complete.

n Sample Tube Free Space. See Perform a Sample Tube Free Space Analysis on page 1.

In Sample Tube Free Spacemode, select sample tube files (.STB), a free space gas, and
method to perform a free space analysis. The ambient and analysis free space values are
stored in the sample tube file (.STB). Once the free space is measured and stored in the
sample tube file, the sample tube file can then be selected in the sample analysis.
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INSTRUMENT STATUS

SHOW DASHBOARD

Unit [n] > Show Dashboard
Data for the dashboard comes from the logged diagnostic data. The dashboard remains current
as the relevant diagnostic data items are updated. The gauges will be updated even if the
dashboard window is not open.

Red numbers on the dashboard require attention. To reset the dashboard numbers,
right-click on the dashboard setting, then click Reset.

Selections Description
Analyses
completed / started

Displays N/M where N is the number of analyses that have finished
data collection andM is the number of analyses that have been star-
ted. Analyses canceled or terminated by errors before the termination
stage starts are not counted as completed.

Days until roughing-
pump service is due

Annual maintenance is recommended. The number of days until the
anniversary of the last pump maintenance is shown. The displayed
value is updated at least once per day and when the maintenance
time is reset. When the displayed value is 30 or less, the value is dis-
played in red. Red negative numbers display if maintenance is past
due.

Dashboard Gauges

Instrument Status
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2 About the Software

Selections Description
Manifold outgas rate Provides the qualitative indication of the outgas rate in the dosing

manifold. LED images constitute a bidirectional bar graph of the
outgas rate.

The gauge is updated when the Analysis Manifold Test is run. See
Start Diagnostic Test on page 9 - 2.

n Three green LEDs are lit if outgas rate is below 30% of outgas rate
limit.

n At 30%, the left LED turns off.
n At 60%, the center LED turns off.
n At 90%, three green LED lights turn off and the center yellow

LED turns on.
n At 110% and above, only the red LED turns on and attention is

required.

Nitrogen P0 Displays statistics of the saturation pressures measured with nitrogen
gas at liquid nitrogen temperatures. The mean, two-sigma, minimum,
and maximum values display. The gauge is updated when a P0 is
logged with nitrogen as the adsorptive and a bath temperature of
77±2 K.

Dashboard Gauges (continued)
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SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log
Use to display a log of recent analyses, calibrations, errors, or messages.

Selections Description
Add Log Entry [button] Use to enter information to appear in the sample log report that can-

not be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Analysis/
Calibration/
Message [check box]

Select the logs to display.

Report [button] Click to select the print destination and the report start date.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Instrument Log

Show Instrument Log

ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025 2 - 19



2 About the Software

SHOW ANALYSIS SCHEMATIC

Unit [n] > Show Analysis Schematic
Use to display an analyzer schematic. To operate the valves and elevator from this window,
manual control must be enabled (Unit [n] > Enable Manual Control).

A. Servo
B. Micropore transducer
C. Vacuum gauge
D. 1000 mmHg transducer
E. Analysis manifold temperature
F. Servo valve
G. Sample tube
H. Elevator
I. P0 tube

Valve Description
1-6 Sample ports

7 Lower manifold isolation

8 Sample ports unrestricted vacuum

9 P0 ports access

10 P0 unrestricted vacuum

11-16 P0 ports

17 Upper manifold isolation

18 Gas inlets unrestricted vacuum

21-26 Gas inlet port valves

Unmarked Servo

Analysis Schematic Components
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Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. When manual control is
disabled, closed valves appear white.
Servo Valve. Closed.

Servo Valve. Open.

Elevator. The elevator icon indicates the position of the Dewar. The
arrow inside the Dewar icon indicates the direction of Dewar movement.

Sample Tube. Cannot be manually controlled.

P0 (Psat) tube.

Transducers Each sample port and P0 port contains a 1000 mmHg transducer. The
transducer readings display next to the ports.

Displays the temperature, the 1000 mmHg,
10 mmHg transducer readings, and vacuum gauge
pressure.

The 10 mmHg transducer (for krypton or Micropore
installations).

Displays the micropore transducer reading. This
transducer is optional and is shown only if installed.

Analyzer Schematic Icon Table

Show Analysis Schematic
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2 About the Software

Icon or Symbol Description
Valve options Open.Opens the selected valve.

Close. Closes the selected valve.

Pulse. Use to quickly turn the valve on and off allowing the operation to
proceed in small increments.

For Servo valve:

n Set. Use to set the servo valve target pressure and dose or evacuate.
n Close. Closes the servo valve. The valve symbol changes to solid

black.

Elevator options Right-click the elevator icon, then select:

Raise. Select Raise to raise the elevator. When it is moving, press the
keyboard space bar to stop the movement (or right-click and select Stop
from the menu).

Lower. Select Lower to lower the elevator. When it is moving, press the
keyboard space bar to stop the movement (or right-click and select Stop
from the menu).

Stop. Stops the elevator from moving.

Schematic Shortcuts
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SHOW STATUS

Unit [n] > Show Analysis Status

Unit [n] > Show Status
Use to show the current status for each port.

If multiple units are attached to the computer, select Show Status on each Unit [n]menu. The
status for all units displays.

Show Status
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2 About the Software

DEGAS STATUS
Unit [n] > Show Degas Status

Field Description
Sample status Displays the status of the degas operation for each port.

Check [button] Click to check the outgassing rate of the samples on the selected
ports. The following actions occur:

n The current degassing step is suspended.
n The vacuum valves are closed and the vacuum level on the selec-

ted ports is monitored.
n The status window indicates that the degassing operation is being

checked and displays the outgassing rate.

During the degas check, the Check button change to Continue.
Click Continue to resume the degassing operation.

If the outgassing rate indicated that the sample has been freed of
contaminants (minimal pressure increases), click Skip to advance to
the next state of the degassing operation.

Skip [button] Skips the current degas operation.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Degas Status
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SHOW DEGAS SCHEMATIC

Unit [n] > Show Degas Schematic
Use to display the degas schematic. To operate the valves, manual control must be enabled (Unit
[n] > Enable Manual Control).

Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. When manual control is
disabled, closed valves appear white.

Servo Valve. Closed.

Servo Valve. Set

Degas Sample Tube.

Analyzer Schematic Icon Table

Show Degas Schematic
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2 About the Software

Schematic
Components

Description

1 through 12 Sample ports

13 Backfill

14 Servo vacuum

15 Unrestricted vacuum

Analyzer Schematic Icon Table

DEGAS SCHEMATIC SHORTCUT MENUS

Each manually controlled schematic component has a shortcut menu displaying the operations
available for that particular component. To access the shortcut menu, hover the mouse pointer
over the component icon and right click.

Schematic Shortcut
Icon

Available Options:

Valve options Open.Opens the selected valve.

Close. Closes the selected valve.

Pulse. Use to quickly turn the valve on and off allowing the operation
to proceed in small increments.

Temperature control
options

Set. Select to set the ramp rate and target temperature.

Disable. Disables the temperature control.

Schematic Shortcuts
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EXPORT FILES
File > Export
Exported Data Example on page C - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or a file. Data can be exported as a .PDF, .TXT, .XML, or .XLS file format. The
type of data to include or exclude can be selected during the export process. The data can be
imported into other applications that read these file formats when exported to a file.

1. Click List and open an .SMP file.
2. Select an experiment and the applicable options.
3. ClickOK.

Export Files
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2 About the Software

LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the
file was created or last edited, file identification, and file status.

Select one or more files from the file selector, click List, then provide the file destination.

Example of
File List
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SOFTWARE UNINSTALL
The software can be uninstalled in two ways. Either method removes only the files required to run
the software, not the analysis files.

n Click the Windows Start icon. Scroll to the Micromeritics entry. Select the Uninstall [analyzer]
option, then follow the prompts.

n Locate the uninstall.exe file in C:\Program Files (x86)\Micromeritics\[analyzer name] (or
wherever the application was installed). Double-click the uninstall.exe file, then follow the
screen prompts.

SOFTWARE UPDATES

A User Account Control in the Windows operating systemmust be enabled to ensure
all components of the Micromeritics application are correctly installed. If UAC is not
enabled, right-click the setup.exe installer file and select Run as administrator.

The most current version of the instrument software can be found on the Micromeritics web page
(www.micromeritics.com).

When performing a software update, existing data files are not overwritten.

Insert the setup media into the media drive. The setup program starts automatically. If the
program does not start automatically, navigate to the installation media drive, locate and double-
click the setup.exe file.

Software Uninstall
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3 SAMPLE FILES
Option Presentation on page 2 - 10
Software in 21CFR11 Environments on page 1

Sample files include the information required by the analyzer to perform analyses and collect data.
A sample file identifies the sample, guides the analysis, specifies report options, and may be
displayed in Advanced, Basic, or Restricted presentation display mode. After data is collected, the
file is shown in MicroActive mode or the tabbed file editor.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either before or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

3 Sample Files
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3 Sample Files

CREATE SAMPLE FILES
Options > Option Presentation > Show Degas Conditions

File > New Sample > [.SMP File]

File > Open > [.SMP File]

For 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in
this section helpful. Sample file information that is available to Analysts is created by
a member in the Developer group using information in this section.

Each analysis must be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the option presentation by selectingOptions > Option Presentation or use
the view selector drop-down list at the bottom of the window.

Sample files created in the Basic option presentation are selected from parameter files created in
the Advanced option presentation. The values specified in the parameter portions of the default
method are the defaults for new sample files. To navigate from one set of parameters to another,
select the parameter tab across the top of the window.

Sample Tube parameters are edited on the Sample Description tab.

The Degas Conditions tab displays only if enabled inOptions > Option
Presentation > Show Degas Conditions
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Advanced view Basic view

A bar code reader may be used to enter text into many of the fields on the Sample
Description window. Use a mouse to click in the field first where information is to be
entered then scan the bar code with the bar code reader.

Selections Description
Add Log Entry [button] Use to enter information that will display in the sample log report that

cannot be recorded automatically through the application. Click the
button again to enter multiple log entries.

Bar Code [text box] * Use to enter additional information about the sample, such as a
sample lot number, sample ID, etc.

Comments [text box] Enter comments to display in the report header about the sample or
analysis.

Mass [group box] If mass = 1, the reported surface area equals the total surface area
but it is always shown as m2/g. If an accurate mass is entered, the
reported surface area is normalized per gram of sample. Choose
whether to enter mass manually or have the system automatically
calculate mass. Enter a value for sample mass. Mass can be
changed any time before, during, or after analysis.

Enter. Enables the Sample mass field. Enter a value for the sample
mass.

Calculate. Enables the Empty tube and Sample + tube fields. Enter
the values necessary to calculate the sample mass. Equation used

Sample Files

Create Sample Files
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3 Sample Files

Selections Description
to calculate sample mass:

Masssample = Masssample+tube – Masstube

Density. Value is used for the calculated free space method only.
Use 0.000 for a blank analysis.

Method [drop-down box] Select a method from the drop-down list.

Operator [text box] * Enter operator identification information.

Sample [text box] * Enter a sample description.

Sample Tube
[drop-down box]

Select a sample tube file from the drop-down list, or click Edit to
modify or create a new sample tube file.

Submitter [text box] * Enter submitter identification information.

Type of Data
[group box]

Automatically collected. Select if the type of data will be
automatically collected by the system while an analysis is running.

Manually entered. Use to enter data manually that was collected
from another source. IfManually entered is selected, the Isotherm
Report becomes available in the Basic/Advanced drop-down list for
pasting or importing data into the file.

SeeManually Enter Data on page 3 - 6.
User Parameters
[group box] *

These fields are primarily used for the SPC (Statistical Process Con-
trol) reporting to specify sample characteristics or its manufacturing
process but may be used for other data by entering specific analysis
conditions or sample criteria. The entered parameters display on the
SPC Report.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Sample Files (continued)

* This field label may have been renamed or may not display if modified inOptions > Default
Methods.
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OPEN A SAMPLE FILE
File > Open > [.SMP File]

When working with an existing sample file, consider copying the sample file to
maintain the original configuration options.

File Status Displays
Preparing
Prepared
No Analysis

Tabbed file editor

Complete
Analyzing
Entered

MicroActive report window

Tabbed file editor in
Advanced view

Example of a Report window

To view the tabbed file editor for a sample file with a Complete status, select Advanced from the
view selector drop-down list at the bottom of the window.

Open a Sample File

ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025 3 - 5



3 Sample Files

MANUALLY ENTER DATA

n Copy and paste onto the graph area of the interactive window.
n Import data into the interactive window.

COPY AND PASTE MANUALLY ENTERED DATA

To display the file status in a search window, go to File > Open. Right-click the
column header then clickMore... Scroll to theMIC entries and enableMIC Status.

1. Open a sample file with a Complete status. The file will open in the interactive reports win-
dow.

2. Right-click in the graph area of the interactive reports window, then select Copy data.

Example of a Report window.

3. Open another sample file using the Advanced option presentation.
4. On the Sample Description tab, selectManually entered in the Type of Data group box.
5. In the view selector drop-down list at the bottom of the window, click Advanced, then select

Isotherm.
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6. Ensure that all parameter fields are set appropriately, then click Paste.

Manually Enter Data
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3 Sample Files

IMPORT MANUALLY ENTERED DATA
When importing isotherm data from an external ASCII text file using the Import button on the
interactive window, the ASCII text file must use the following rules:

ASCII text file format rules

Data must be in two columns and separated by a comma or white-space. Acceptable column
headings are:

n Relative Pressure
n Absolute Pressure (mmHg)
n Absolute Pressure (kPa)
n Absolute Pressure (mBar)

n Quantity Adsorbed (mmol/g)
n Quantity Adsorbed (cm³/g STP)
n Quantity Adsorbed (cm3/g STP)

Sample Physisorption ASCII Text File

Silica Alumina : Adsorption
Relative Pressure        Quantity Adsorbed (cm3/g STP)
0.108629                 50.6657
0.22288                  60.7813
0.339909                 71.3095
0.459512                 84.4172
0.577447                 102.672
0.654583                 121.707
0.760074                 179.096
0.855713                 334.565
0.958511                 394.675
0.996251                 403.793

Silica Alumina : Desorption
Relative Pressure        Quantity Adsorbed (cm3/g STP)
0.996251                 403.793
0.86016                  389.626
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0.753567                 256.264
0.664418                 133.099
0.542416                 96.7366
0.422295                 79.7351
0.346371                 71.5994
0.2519                   62.8256
0.152718                 54.2336
0.103389                 49.5803

To import the ASCII text file

1. Open a new sample file in Advanced option presentation.
2. On the Sample Description tab, selectManually entered.
3. In the view selector drop-down list at the bottom of the window, click Advanced, then select

Isotherm.

4. Ensure that all parameter fields are set appropriately, then click Import.
5. Open the .TXT file. The data from the original sample file is imported and displayed. If an

error message displays instead, verify that the .TXT file format is correct.

Manually Enter Data
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4 PARAMETER FILES
Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

Methods include both analysis conditions and report options, offering the most convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited as needed, or new
parameter files created.

The following file types can exist as part of the sample file as well as individual parameter files.

File Type File Extension
Adsorptive Properties .ADP

Analysis Conditions .ANC

Degas Conditions .DEG

Method .MTH

Report Options .RPO

Sample Tube .STB

Parameter File Types

4 Parameter Files
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4 Parameter Files

ADSORPTIVE PROPERTIES
File > Open > [.ADP File]
(or click Edit next to the Adsorptive selection on the Analysis Conditions tab when in Advanced
option presentation)

Adsorptive properties provide the adsorptive (analysis gas) characteristics for the analysis.

Selections Description
Adsorbate molecular
weight [text box]

The molecular mass is used for the weight % column of the iso-
therm tabular report and the pressure composition isotherm plot.

Adsorptive [text box] Name of the adsorptive gas whose properties are being defined.

Density conversion
factor [text box]

Factor determined by obtaining the ratio of the gas density (STP)
to the liquid density. This field is disabled if Non-condensing
Adsorptive is selected.

Dosing Method
[group box]

Normal. Dose from a pressurized tank of gas attached to a gas
inlet port.

From last sample port. For krypton analysis only, the krypton is
stored and dosed on the last port.

Adsorptive Properties
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Selections Description
High-resolution fluid
properties [selection]

Use to import parameters from a Fluid Properties (.FPI) file.
Changing fluid properties should only be necessary if an adsorpt-
ive is to be used for which no adsorptive properties are provided.
Contact Micromeritics Scientific Services if new fluid properties are
required.

Mnemonic [text box] Enter the mnemonic name for the adsorptive. See Unit Con-
figuration and Gas Specification on page 2 - 14.

Molecular cross-sec-
tional area [text box]

The area that a single adsorbed molecule occupies on the surface
of the sample. It is used in surface area calculations.

Non-condensing adsorpt-
ive [check box]

Select if using a non-condensing analysis gas. When selected, the
Density conversion factor field and the PSAT vs T button are dis-
abled.

Non-ideality factor
[text box]

Compensates for the forces of attraction between molecules in a
real gas. This value is used for a calculated free space.

Psat vs T [button] Click to edit the Psat vs Temperature table. The table contains sat-
uration pressures and their corresponding temperatures. To edit,
click in a field and enter the value.

Therm. tran.
hard-sphere diameter
[text box]

Estimate of the molecular size used in calculating the thermal
transpiration correction.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Adsorptive Properties (continued)

Adsorptive Properties
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4 Parameter Files

ANALYSIS CONDITIONS
File > Open > [.ANC File]
Or, click the Analysis Conditions tab when in Advanced option presentation.

Analysis conditions specify the parameters used to guide an analysis.

Selections Description
Absolute pressure
dosing [check box]

Specifies pressure targets in mmHg or mbar instead of relative pres-
sure. If this option is selected, the Relative Pressure labels and
entries change to Absolute Pressure in the selected pressure units.
This option is typically selected when using adsorptives at analysis
conditions above the critical point of the gas; for example, H2 adsorp-
tion on carbon at liquid nitrogen temperature.

Adsorptive
[drop-down box]

Select an Adsorptive Properties file from the list of defined gases to
be used for analysis. After selection, click Edit to modify adsorptive
properties. See Adsorptive Properties on page 4 - 2. 

Analysis Conditions
[drop-down box]

Use to browse for an Analysis Conditions file that contains analysis
condition parameters to be used in the analysis.

Analysis Conditions
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Selections Description
Backfill [button] Select gas for backfilling the sample tube at the start and end of an

analysis.

The options are disabled if the file status is Entered, Complete, or
Analyzing.

Dose increments
[selection]

The sample is dosed repeatedly with a fixed amount of gas and
isotherm points are collected after equilibrating each dose.

Options. [button] Each entry in the table defines how much to dose
for a segment of the isotherm. In this form of dosing, there is no
predefined pressure table. Define target ranges for up to 10 dose
increments. The ending relative pressure and the dose amount
(entered or as the fraction of the previous quantity adsorbed) for
each target range are shown.

Analysis Conditions (continued)

Analysis Conditions
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4 Parameter Files

Selections Description
Equilibration [button] Provides options to specify the equilibration interval and delay time.

(Column heading reads Absolute Pressure (mmHg) when Absolute
Pressure Dosing is selected.)

Minimum equilibration delay at p/po > = 0.995. The minimum
number of seconds required before equilibration can occur for a
relative pressure greater than or equal to 0.995. This field is not
available if Absolute pressure dosing is selected on the Analysis
Conditions tab.

Relative Pressure (p/po) or Absolute Pressure. The pressure the
equilibration interval will be applied.

Free Space [button] Use to enter the free space measurement type.

Measure:

n Lower Dewar for evacuation. If the Dewar is to be lowered for
evacuation, select this option and enter the length of time for evac-

Analysis Conditions (continued)
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Selections Description

uation after the free space measurement in the Evacuation time
field. If using a cryostat, the operator must manually move the
cryostat assembly when prompted.

n Evacuation time. The length of evacuation time prior to free
space measurement.

n Outgas test. Checks for system leaks or sample outgassing.
After free space is measured, the Dewar is lowered and the
sample evacuated for the specified amount of time. The leak test
is performed after evacuation. If the pressure rises more than
0.025 mmHg within the time specified in theOutgas test duration
field, outgassing is present. If a leak is found, the analysis stops
and the operator is notified. While leak testing slightly increases
analysis time, it prevents the continuation of analysis and col-
lection of erroneous data if a leak occurs.

Enter.Measures free space after analysis ends. Enter the estimated
free space measurements.

n Ambient free space. Empty sample tube gas capacity measured
at room temperature.

n Analysis free space. Empty sample tube gas capacity measured
with the Dewar raised.

Calculate. Use to have the free space measurement calculated
using the sample and tube parameters.

Analysis Conditions (continued)

Analysis Conditions
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4 Parameter Files

Selections Description
Options [button] Available when the Target Pressures option is selected.

First Pressure Fixed Dose.

This option is most frequently used when performing a standard
nitrogen analysis of mesoporous materials such as catalysts. If
the first pressure table point is low and the gas uptake of the
sample is expected to be high, this option can shorten the time
required to reach the first point on the pressure table.

The sample is dosed repeatedly at low pressures with a specified
amount of gas until the first pressure point is reached. This initial
dosing quickly meets the adsorptive demand of the sample.

The first point on the pressure table is the threshold value. Once
this first pressure point is reached, points are equilibrated and
recorded in accordance with the specified pressure table.

Enter the amount of gas to be added to the sample for each dose
cycle.

Maximum volume increment.

Select to determine when additional data points are collected
between target pressures in regions of adsorption. When the
maximum increment has been adsorbed since the last collected
data point, another point is equilibrated and collected. During
desorption, this field is treated as a maximum volume decrement
value.

Analysis Conditions (continued)
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Selections Description
Absolute / Relative pressure tolerance.

Values used to determine how close the actual pressure must be
to each target pressure from the pressure table. At lower
pressures, the relative tolerance value is lower. At higher
pressures, the absolute tolerance value is lower.

Experiment 1. There might be an absolute tolerance of 5 mmHg,
a relative tolerance of 5%, and a target pressure of 40 mmHg; 5%
of 40 mmHg is 2 mmHg. Since 2 mmHg (relative tolerance) is
lower than 5 mmHg (absolute tolerance), 2 mmHg is used.
Therefore a minimum pressure of 38 mmHg (40 - 2) must be
attained to collect data for a target pressure of 40 mmHg.

Experiment 2. There might be an absolute tolerance of 5 mmHg,
a relative tolerance of 5%, and a target pressure of 200 mmHg;
5% of 200 mmHg is 10 mmHg. Since 5 mmHg (absolute
tolerance) is lower than 10 mmHg (relative tolerance), 5 mmHg is
used. Therefore a minimum pressure of 195 mmHg (200 - 5) must
be attained to collect data for a target pressure of 200 mmHg.

Normally, surface area measurement points are widely spaced
and the resulting measurement is not very sensitive to the precise
location of points so wider tolerances may be used.
Unnecessarily tight tolerances lengthen the analysis.

p° and T [button] Click to select one option for obtaining the saturation pressure (Po)
and analysis bath temperature. Each selected option presents a
different set of parameters at the bottom of the window.

Options and descriptions:

1. Analysis bath temperature (not used for krypton analyses).

Analysis Conditions (continued)

Analysis Conditions
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4 Parameter Files

Selections Description
Measures the p0 on a continuous basis. Allows the meas-
urement of each data point without slowing the analysis.

2. Analysis bath temperature (not used for krypton analyses).
Measures the p0 on a continuous basis and over the sample,
then adjusts the measured p0 in the sample tube to agree with
the p0 over the sample.

3. The p0 and analysis bath temperatures or an analysis bath
temperature only (when Absolute pressure dosing is selected
on the Analysis Conditions window). This method uses the
entered values.

4. Psat gas. If this is a krypton analysis, select the Nitrogen@
77.35K option from the Adsorptive drop-down box. Click Psat
vs T to edit the values of the Psat vs T table. Editing the values
in the current table does not affect the original table.

5. Analysis bath temperature. Analysis bath temperature and
an estimate for the initial p0 (not used for krypton analyses).
Measures the p0 over the sample. After the p0 is measured,
the value is reapplied to all data points.

6. Analysis bath temperature. This method calculates the p0 at
the time of analysis using the entered temperature.

Preparation [button] Use to enter analysis preparation details.

Evacuation rate. The rate for restricted evacuation.

Evacuation time. The length of time for preliminary evacuation
which takes place prior to the free space measurement or sample
analysis if free space is to be entered or calculated.

Fast Evacuation. Select for samples (such as pellets) that do not
fluidize or shed particles during evacuation.

Leak Test. Enables the system to check for leaks or sample

Analysis Conditions (continued)
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Selections Description
outgassing before the analysis. The leak test allows sample pressure
to rise during the test. If the pressure rises more than 0.15 mmHg,
the analysis does not proceed and the operator is notified. While leak
testing slightly increases analysis time, it prevents the continuation of
analysis and collection of erroneous data if a leak exists.

Leak test duration. Enter the duration of the leak test.

Unrestricted evac. from. The pressure at which unrestricted
evacuation is to begin. This option is enabled when Fast evacuation
is not selected.

Use TranSeal. Select if using the TranSeal to transfer the sample
from the preparation port to the analysis port under vacuum.

Pressures [button] Available when the Target Pressures option is selected. Use to edit
the Entered Pressures table.

The pressure table consists of relative pressure points at which
isotherm data are to be collected. An optional pressure increment
can be entered in the Pressure Increment column, which will cause
additional points to be collected at intervals of the pressure
increments up to the relative pressure specified in the Ending
Pressure column.

The relative pressure points may span the entire range of
0.000000000 to 0.000000001 p/p0. There must be one adsorption
branch (strictly increasing pressures) followed optionally by one
desorption branch (strictly decreasing pressures).

Analysis Conditions (continued)

Analysis Conditions
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4 Parameter Files

Selections Description

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Analysis Conditions (continued)
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DEGAS CONDITIONS
File > Open > [.DEG File]
(or click the Degas Conditions tab when using Advanced option presentation)

The Degas Conditions tab displays only if enabled inOptions > Option
Presentation > Show Degas Conditions.

Selections Description
Backfill [group box] Backfill sample tube. Indicate if the sample tube should be

backfilled automatically or wait for operator response.
Degas Conditions
[drop-down box]

Use to browse for a .DEG file that contains degas condition para-
meters to be used in the analysis.

Heating Phase [table] Enter up to five stages of degas conditions.

Temperature. Temperature at which the sample is to be held while
degassing.

Time. How long the sample is to be held at the specified temperature
before beginning to cool down.

Temperature Ramp Rate. The rate at which the temperature will
change while advancing to the hold temperature.

Degas Conditions

Degas Conditions
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4 Parameter Files

Selections Description
Evacuation [group box] Evacuation rate. Rate used for evacuation.

Evacuation time. Length of time for preliminary evacuation before
proceeding with the Heating Phase temperature schedule. The timer
starts when the vacuum level is reached.

Target temperature. Targeted temperature for evacuation.

Temperature ramp rate. Rate at which the temperature is to
change when advancing to the target pressure.

Unrestricted evac. from. Pressure at which the unrestricted
evacuation is to begin.

Vacuum level. Evacuation time starts when the vacuum level is
reached.

Evacuation and Heating
[group box]

Hold pressure. Pressure at which heating will stop and hold the
sample temperature approximately constant until the pressure falls
below the Hold pressure. This prevents damage to the sample struc-
ture due to 'steaming' and /or elutriation due to excessive escaping
gas velocity.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Degas Conditions (continued)
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REPORT OPTIONS

File > Open > [.RPO File]
(or click the Report Options tab when in Advanced option presentation)

The Calculations document can be found on the Micromeritics web page
(www.micromeritics.com).

Additional reports are available using the Reportsmenu.

Use to specify report options for data collected from an analysis or manually entered data. Report
Options files also help in customizing report details such as axis scale, axis range, column
headings, and components of thickness curve equations. These files may contain tabular reports,
plots, or both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options files may be defined to include overlay options. This system allows the overlay of
up to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a
different plot type from the same analysis.

Report Options
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4 Parameter Files

SAMPLE TUBE
File > Open > [.STB File]
Or, click Edit next to the Sample Tube selection on the Sample Description tab when in Advanced
option presentation.

Sample Tube files specify information about the sample tube.

Selections Description
Ambient free space
[text box]

Empty sample tube gas capacity measured at room temperature.

Analysis free space
[text box]

Empty sample tube gas capacity measured with the Dewar raised.

Load from Sample
File [button]

Loads parameters from the selected sample file.

Sample tube
[drop-down box]

It is a good practice to label each sample tube with a unique iden-
tification. Enter that information here. This information will also appear
in the Sample Tube drop-down list on the Sample Description tab.

Use filler rod
[check box]

Select if a filler rod is to be used in the sample tube. A filler rod reduces
the stem free space volume resulting in reduction of free space error. It
is generally a good practice to use filler rods for samples having less
than 100 square meters of total surface area.

Sample Tube
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Selections Description
Use isothermal jacket
[check box]

Select if an isothermal jacket is to be used. An isothermal jacket main-
tains a constant temperature profile along the sample tube stem during
an extended analysis of more than 1 or 2 hours.

Vacuum seal type
[group box]

Select the seal type to be used.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Sample Tube (continued)

Sample Tube

ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025 4 - 17





5 DEGASSING
Most solid materials absorb moisture and other contaminants when exposed to the atmosphere.
The sample must be clean when an analysis is performed. The degas process heats the sample
with an inert gas flowing over it to remove the moisture and contaminants.

Samples can be degassed one at a time using the Start Single Degas option or simultaneously
using the Start Multiple Degas option. Select the file for each degas port to be used, then load the
sample into the sample tube and install the sample tube on the degas port. Allow the sample to
cool before transferring to the analysis port to start the analysis.

SAMPLE TUBE INSTALLATION ON DEGAS PORTS
Sample Tube Installation on the Analysis Port on page 6 - 12

1. While holding the degas port plug, loosen, then remove the connector nut and plug from the
degas port by turning the connector nut counterclockwise.

A. Plug
B. Degas port connector plug
C. O-ring (1/4 in. from top of tube)
D. Ferrule

5 Degassing
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5 Degassing

2. Remove the rubber stopper (if used instead of a seal frit) from the sample tube. Place the
degas port connector nut, ferrule, and O-ring onto the sample tube set.

3. Attach the sample tube set to the degas port. Push the sample tube in to a full stop. Secure
the sample tube in place by sliding the connector nut, ferrule, and O-ring up onto the degas
port and turning the connector nut clockwise. Tighten the nut securely by hand.

4. Place a heating mantle over the bulb of the sample tube and secure the mantle in place with
a mantle clip.

A. Power plug
B. Thermocouple plug
C. Heating mantle
D. Mantle clip

5. Insert the heating mantle thermocouple plug into the thermocouple connector on the ana-
lyzer. Insert the heating mantle power plug into the power connector on the analyzer and
twist to lock securely.
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DEGAS THE SAMPLE

DEGAS A SINGLE DEGAS PORT

Unit [n] > Start Single Degas
Degassing a single port is useful for degassing samples without using predefined parameter files.

Guidelines for degassing a single port:

n One degas operation can be started at a time.
n A sample can be added to any idle port and a degas operation started. When a sample is

added, the degas operation in progress will be suspended until the sample reaches the target
temperature, then degassing on all ports will resume.

n Samples can be removed from any of the 12 ports without disturbing the degas operations
being performed on other ports.

n Amanual evacuation can be performed on any idle degas port.

1. Click Browse to select the sample file.
2. Select the Degas Conditions from the drop-down list.
3. Select the port to be used for degassing.
4. Click Start to begin the degas process on the selected port.

Degas the Sample
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5 Degassing

DEGAS ON MULTIPLE DEGAS PORTS

Unit [n] > Start Multiple Degas

Guidelines for degassing on multiple ports:

n Up to 12 degas operations can be started simultaneously.
n A sample can be added to any idle port and a degas operation started. When a sample is

added, the degas operation in progress will be suspended until the sample reaches the target
temperature, then degassing on all ports will resume.

n Samples can be removed from any of the 12 ports without disturbing the degas operations
being performed on other ports.

n Amanual evacuation can be performed on any idle degas port.

1. For each sample port to be used, click Browse to select the sample file.
2. Click Start to begin the degas process on the selected ports.
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DEGAS ON ANALYSIS PORTS

The characterization of microporous materials may be significantly improved by starting the
analysis with the sample pre-evacuated. The additional time required is often offset by improved
analyses and faster run time. To avoid exposure to contaminants, it is often best to degas a
microporous sample on the same port that will be used for analysis. Heating mantles (provided
with the micropore option) are required for this type of degassing.

To degas a sample on an analysis port:

1. With the sample tube mounted in the sample port, position the P0 tube so that it is away
from the sample tube.

2. Slide the isothermal jacket up to the top of the sample tube.

A. P0 tube
B. Move isothermal jacket to top of sample tube
C. Isothermal jacket

The isothermal jacket fits tightly on the sample tube to ensure thermal stability. Use
care when changing the position.

3. Go to Unit [n] > Evacuate Analysis Port.
4. Select the port where the sample tube is attached.
5. Enter the evacuation parameters. Click Start. Repeat the previous steps for each sample to

be degassed.

Degas the Sample
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5 Degassing

6. Go to Unit [n] > Enable Manual Control. If the analyzer schematic does not display, go to
Unit [n] > Show Analysis Schematic. Ensure a checkmark displays to the left of the
Enable Manual Controlmenu item

7. When the evacuation for each selected port is finished, ensure valve 8 is left open. See
Show Analysis Schematic on page 2 - 20.

8. Open the sample ports that are in use. Also open corresponding P0 ports 11 through 16.
Open ports 7, 9, and 10. For example, if only four samples are to be degassed and they are
on ports 1, 2, 3, and 5, open ports 1, 2, 3, 5, 11, 12, 13, 15, 7, 9, and 10.

9. Insert the heating mantle thermocouple plug into the thermocouple connector on the degas
portion of the analyzer below the sample port. Insert the heating mantle power plug into
power connector below the thermocouple connector and twist to lock securely.

A. Power plug
B. Thermocouple plug

10. Loosen the lace on the heating mantle.
11. Slide the heating mantle around the sample tube, then tighten the lace.
12. Secure the heating mantle with a mantle clip.

A. Clip

13. Go to Unit [n] > Show Degas Schematic.
14. Right-click the degas port where the heating mantle power plug and thermocouple are con-

nected. Select Set. Enter 10 °C/min for Ramp Rate and 200 °C for Target Temperature.
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15. Allow the sample to degas for a minimum of one hour. Additional time may be required to
fully degas the sample.

16. Right-click the degas port sample tube. Select Disable.

Do not touch the sample tube or heating mantle until cooled. Touching the sample
tube, heating mantle, or heating mantle clip before they have cooled could result in
burns.

17. When the heating mantle is cool enough to touch, remove it from the sample tube.
18. Allow the sample to cool to room temperature.
19. Slide the isothermal jacket down.
20. Place the sample tube Dewar cover over the sample tube stem just above the isothermal

jacket. Ensure the P0 tube is next to the sample tube.

Degas the Sample
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5 Degassing

A. Dewar cover
B. P0 tube

21. Place the safety shield over the sample tube and Dewar cover, then begin the analysis. See
Perform an Analysis on page 6 - 1.
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TRANSFER A DEGASSED SAMPLE TO AN ANALYSIS PORT
Sample Data Worksheet for Gas Adsorption on page F - 1

The sample tube must be removed from the degas port, weighed, and then installed onto the
analysis port for analysis.

If the sample tube will not be mounted on the analysis port immediately, leave it on the
degas port. If it is necessary to remove the sample tube and a Seal Frit was not used,
insert a rubber stopper into the sample tube.

A. Insulated Dewar cover
B. P0 tube isothermal jacket
C. P0 tube
D. Rubber stopper
E. Port fitting
F. Seal frit (optional)
G. O-ring
H. Ferrule
I. Connector nut
J. Sample tube isothermal

jacket
K. Sample tube

1. Allow the sample tube to cool.

Do not touch the sample tube or the heating mantle until they have reached room
temperature. Touching the sample tube, heating mantle, or heating mantle clip before
they have cooled could result in burns.

2. If using the heating mantle option, carefully remove the heating mantle clip and the heating
mantle from the sample tube.

Transfer a Degassed Sample to an Analysis Port
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5 Degassing

3. Hold the sample tube, loosen the port connector nut, and remove the sample tube from the
degas port.

4. Remove the connector nut, ferrule, and O-ring from sample tube stem.
5. Weigh the sample tube set.
6. Use the Sample Data Worksheet to determine the sample mass.
7. Slide an isothermal jacket down over the sample tube stem until it touches the sample tube

bulb.
8. Place the connector nut, ferrule, and O-ring onto the sample tube stem.
9. Remove the stopper and immediately attach the sample tube to the analysis port, pushing it

fully up into the port. Secure it in place by screwing the connector nut onto the analysis port
connector; hand tighten the connector nut. If a Seal Frit was used, it does not have to be
removed.

10. Place the Dewar cover over the sample tube stem just above the isothermal jacket.

ENABLE MANUAL CONTROL OF DEGAS PORTS
Unit [n] > Enable Manual Control

Unit [n] > Show Degas Schematic
Show Degas Schematic on page 2 - 25

Use to enable the manual control of degas ports.
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EVACUATE PORTS

EVACUATE ANALYSIS PORT

Unit [n] > Evacuate Analysis Port
Allows the manual evacuation of a single analysis port.

Selections Description
Port [selection] Select the ports to evacuate.

Backfill gas
[drop-down box]

Select the backfill gas from the drop-down list.

Fast evacuation
[check box]

Select when analyzing samples (such as pellets) that do not fluidize
or shed particles under evacuation.

Unrestricted evac. pressure. Pressure at which the unrestricted
evacuation is to begin.

Evacuation rate. The maximum rate of change of pressure when
evacuating the sample tube.

Vacuum setpoint. The vacuum level to be achieved before timed
evacuation begins.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Evacuate Ports

Evacuate Ports
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5 Degassing

EVACUATE DEGAS PORTS

Unit [n] > Evacuate Degas Ports
Allows the manual evacuation of multiple degas ports.

Selections Description
Evacuation Options
[group box]

Unrestricted evac. pressure.Pressure at which the unrestricted
evacuation is to begin.

Vacuum setpoint. The vacuum level to be achieved before timed
evacuation begins.

Evacuation rate. The maximum rate of change of pressure when
evacuating the sample tube.

Evacuate Port[s]
[group box]

Select the ports to evacuate.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Evacuate Ports
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6 PERFORM AN ANALYSIS

DEWAR PRECAUTIONS

Always handle glass Dewars with care. Any product incorporating a vacuum is a
potential safety hazard and should be treated with caution. If in doubt, contact your
safety officer.

Improper handling, disposal, or transportation of potentially hazardous materials can
result in serious injury or damage to the instrument. Always consult the SDS when
working with hazardous substances. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

When handling Dewars containing liquefied gases or cryogenic liquids:

n Wear protective equipment:
o goggles or face shield
o an insulated or rubber apron
o insulated gloves

n When pouring liquefied gases from one container to another:
o cool the receiving container gradually to minimize thermal shock
o pour the liquified gas slowly to prevent splashing
o vent the receiving container to the atmosphere

FOR GLASS DEWARS

n Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases (or
other materials of extremely low temperature). Do not use a glass or metal stirring rod unless it
has a protective coating.

n Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover over the
Dewar opening. If an object of sufficient weight is accidentally dropped into the Dewar, shat-
tering may occur.

n If the Dewar has a protective mesh covering, do not remove it. This cover minimizes the risk of
flying particles should the Dewar be knocked over, dropped, or broken.

6 Perform an Analysis
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6 Perform an Analysis

6 - 2 ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025



PREPARE FOR ANALYSIS
It is recommended to perform the tasks in the provided order.

Prepare for Analysis
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6 Perform an Analysis

SELECT A SAMPLE TUBE

A sample tube set consists of:

n Sample tube
n Stopper or Seal Frit
n Filler rod

Standard sample tubes for the analyzer have a 1.27 cm (1/2 in.) outside diameter (OD). Stepped
ferrules, smaller O-rings, isothermal jackets, and filler rods are available for adapting the smaller
stems to the degas or analysis ports. The stem diameter selected for use is a matter of accuracy
and precision requirements, as well as personal preference and convenience in loading the
sample.

A rubber stopper may be used with all size sample tubes; however, seal frits are recommended for
1.27 cm (1/2 in.) OD sample tubes.

Filler rods help to ensure accuracy in samples with lower total surface areas by reducing the free
space volume. It is generally a good practice to use filler rods for samples having less than 100
square meters of total surface area. Filler rods are unnecessary for samples with total surface
areas greater than 100 square meters.

Filler rods can interfere with thermal transpiration correction and, therefore, should
not be used when performing micropore analyses.

The weight of the empty sample tube should be determined after it has been cleaned, degassed,
and filled with backfill gas. The sample tube should be allowed to cool to room temperature before
backfilling. After the sample tube has cooled, remove it from the degas port and weigh it.

If a Seal Frit is not used, insert a stopper immediately after removing the sample from
the degas port.

The mass of the isothermal jacket may vary slightly and cannot be considered as constant;
therefore, do not weigh it with the sample tube set.
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CLEAN AND LABEL SAMPLE TUBES

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

Sample tubes and filler rods must be clean and dry before samples are added and weighed. The
following table indicates which materials are needed for cleaning. The procedures following the
materials list are recommended.

1. Preheat drying oven to 110 ºC.
2. Verify that the ultrasonic cleaning unit is clean.
3. Use 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water and fill the

ultrasonic unit with enough water to cover the sample tubes and filler rods (if used). If too
much detergent is used, it may be difficult to rinse from the sample tubes. Ensure the deter-
gent is dissolved before placing the sample tubes and filler rods into the water.

4. Fill the sample tubes with warm water and place them in the ultrasonic cleaning unit, then
place the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately 15
minutes.

5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler
rods, then remove the sample tubes and filler rods from the unit.

6. Clean the interior of the sample tubes with the brush supplied with the analyzer.
7. Rinse the sample tubes and filler rods thoroughly with hot water. Rinse again with isopropyl

alcohol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be
used.

Clean and Label Sample Tubes
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6 Perform an Analysis

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in
the rack. Bake in a vacuum oven for two hours at 110 °C.

Samples tubes can also be cleaned with high-purity acetone or isopropyl alcohol and
dried for about 10 minutes under heat. If using this method, continue with step 10.

9. Remove the sample tubes and filler rods from the oven and allow to cool.

Do not insert the filler rods at this time. Filler rods are inserted before the sample tube
is installed on the analysis port.

10. Blow out the sample tubes with oil-free compressed air.
11. Rinse the sample tube closure with isopropyl alcohol, then wipe the sample tube closure dry

with a clean, lint-free cloth.
12. Label the sample tube and stopper for identification.
13. Replace the rubber stopper.
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CREATE SAMPLE FILES

Options > Option Presentation > Show Degas Conditions

File > New Sample > [.SMP File]

File > Open > [.SMP File]

For 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in
this section helpful. Sample file information that is available to Analysts is created by
a member in the Developer group using information in this section.

Each analysis must be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the option presentation by selectingOptions > Option Presentation or use
the view selector drop-down list at the bottom of the window.

Sample files created in the Basic option presentation are selected from parameter files created in
the Advanced option presentation. The values specified in the parameter portions of the default
method are the defaults for new sample files. To navigate from one set of parameters to another,
select the parameter tab across the top of the window.

Sample Tube parameters are edited on the Sample Description tab.

The Degas Conditions tab displays only if enabled inOptions > Option
Presentation > Show Degas Conditions

Create Sample Files
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6 Perform an Analysis

Advanced view Basic view

A bar code reader may be used to enter text into many of the fields on the Sample
Description window. Use a mouse to click in the field first where information is to be
entered then scan the bar code with the bar code reader.

Selections Description
Add Log Entry [button] Use to enter information that will display in the sample log report that

cannot be recorded automatically through the application. Click the
button again to enter multiple log entries.

Bar Code [text box] * Use to enter additional information about the sample, such as a
sample lot number, sample ID, etc.

Comments [text box] Enter comments to display in the report header about the sample or
analysis.

Mass [group box] If mass = 1, the reported surface area equals the total surface area
but it is always shown as m2/g. If an accurate mass is entered, the
reported surface area is normalized per gram of sample. Choose
whether to enter mass manually or have the system automatically
calculate mass. Enter a value for sample mass. Mass can be
changed any time before, during, or after analysis.

Enter. Enables the Sample mass field. Enter a value for the sample
mass.

Calculate. Enables the Empty tube and Sample + tube fields. Enter
the values necessary to calculate the sample mass. Equation used

Sample Files
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Selections Description
to calculate sample mass:

Masssample = Masssample+tube – Masstube

Density. Value is used for the calculated free space method only.
Use 0.000 for a blank analysis.

Method [drop-down box] Select a method from the drop-down list.

Operator [text box] * Enter operator identification information.

Sample [text box] * Enter a sample description.

Sample Tube
[drop-down box]

Select a sample tube file from the drop-down list, or click Edit to
modify or create a new sample tube file.

Submitter [text box] * Enter submitter identification information.

Type of Data
[group box]

Automatically collected. Select if the type of data will be
automatically collected by the system while an analysis is running.

Manually entered. Use to enter data manually that was collected
from another source. IfManually entered is selected, the Isotherm
Report becomes available in the Basic/Advanced drop-down list for
pasting or importing data into the file.

SeeManually Enter Data on page 3 - 6.
User Parameters
[group box] *

These fields are primarily used for the SPC (Statistical Process Con-
trol) reporting to specify sample characteristics or its manufacturing
process but may be used for other data by entering specific analysis
conditions or sample criteria. The entered parameters display on the
SPC Report.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Sample Files (continued)

* This field label may have been renamed or may not display if modified inOptions > Default
Methods.

Create Sample Files
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6 Perform an Analysis

DETERMINE THE SAMPLE MASS

Sample Data Worksheet for Gas Adsorption on page F - 1

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

There are several different surface area ranges that require different protocol for optimal results.

n If there is between 0.1 m2 and 1 m2 in the tube, follow the recommendations for balancing the
free space using glass beads, along with filler rods, and measure the resulting free space
difference.

n If there is between 1 m2 and 5 m2 of total surface under test, measure the free space difference
between the two tubes as a part of each analysis.

n If there is between 5 m2 and 30 m2, use the option to calculate the free space difference
between the two tubes using the density of the sample in the tube, along with the mass entered.
There are some special considerations when using the tubes with the cylindrical bulb on the
end as opposed to the straight-walled tubes.

n If there is more than 30 m2 in the tube total, it may not be necessary to determine the free
space difference between the two tubes as a part of the analysis.

Smaller quantities are required for samples having high surface areas. These samples require
careful weighing after degassing because a small error may represent a considerable percent of
total mass. Proper weighing techniques are most important in this case. Use no less than 100 mg
to reduce the effect of weighing errors.

Care should be taken when loading powders: the accessory funnel is useful for this purpose.
Large granules or chunks may be loaded with forceps.

Analysis results are expressed in units of surface area per gram of sample; therefore, it is
important to know the true sample mass.

Follow the instructions on the Sample Data Worksheet and complete all fields to find the true
sample mass.

1. Record the sample tube identification on the Sample Data Worksheet.
2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize

at zero (0).
3. Place the empty sample tube set (empty sample tube and stopper) on the sample weighing

support and place it on the balance.
4. Record the stabilized mass on the Sample Data Worksheet. Remove the sample tube set

from the balance.
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Do not touch the sample with bare hands while performing the following steps. Doing
so could affect the accuracy of results.

5. Place a sample container on the balance. Tare the balance and allow it to stabilize to zero.
6. Slowly pour the specified amount of sample into the sample container.
7. Remove the rubber stopper, Seal Frit, Check Seal, or TranSeal from the sample tube.
8. Use the sample tube funnel (provided in the accessories kit) and pour the sample from the

weighing container into the sample tube.
9. On the Sample Data Worksheet, record the following:

n Mass of the sample tube set with the sample.
n Subtract theMass of empty sample tube set from theMass of sample tube set plus

sample.

Determine the Sample Mass
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6 Perform an Analysis

DEGAS THE SAMPLE

Degassing on page 5 - 1

SAMPLE TUBE INSTALLATION ON THE ANALYSIS PORT

Sample Tube Installation on Degas Ports on page 5 - 1

If using... Then...
A rubber stopper Remove it.

An isothermal jacket Slide the jacket down over the stem of the sample tube until it touches
the sample tube bulb.

A filler rod Hold the sample tube horizontally and carefully slide the filler rod into the
tube.

Do not hold the rod vertically and drop the rod into the tube;
this could break the rod and/or tube.

1. Remove the closure from the sample tube.
2. If a filler rod is used, slide the filler rod slowly into the sample tube.
3. Slide an isothermal jacket down over the sample tube stem until it touches the sample tube

bulb.
4. Place the connector nut, ferrule, and O-ring onto the sample tube stem.
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A. Isothermal jacket
B. Connector nut
C. Ferrule
D. O-ring (1/4 in. from top of sample tube)

5. Attach the sample tube to the analysis port, pushing it fully up. Turn the connector nut clock-
wise to hand tighten.

A. Connector nut

Sample Tube Installation on the Analysis Port
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6 Perform an Analysis

FILL AND INSTALL THE DEWAR

Dewar Precautions on page 6 - 1

DEWAR COVERS

Dewar insulator

Dewar insulators cover the opening in the top of a Dewar. These covers help maintain the purity of
the liquid cryogen, as well as preventing objects from falling into the Dewar.

When a Dewar is not in use, lower the Dewar elevator and cover the top of the Dewar with an
insulator.
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FILL THE DEWAR

1. Fully lower the elevator.
2. Fill the analysis Dewar with analysis bath liquid to approximately 5 cm from the top of the

Dewar. Filling the Dewar higher than this will cause an error in the free space measurement.

Incorrect fluid levels can lead to measurement errors. Check the level of the bath
liquid before each analysis.

3. Insert the dipstick into the Dewar and check the level of the analysis bath liquid.
Condensation should not exceed the level indicator mark.

Fill and Install the Dewar
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6 Perform an Analysis

A. Wetness or frozen
condensation indicates bath
liquid level

B. Level indicator mark

4. For best results, if the Dewar has not been used for a while, allow approximately 30 minutes
for the temperature of the Dewar to stabilize with the bath liquid, then recheck the level of
the bath liquid. Add additional liquid if necessary.

5. Attach the safety shield to the brackets on the front of the analyzer.
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PERFORM A SAMPLE ANALYSIS
Unit [n] > Start Analysis

Before beginning an analysis, ensure the tank pressure for the gas regulator is at
least 200 psig. Pressures less than 200 psig may cause the sample to be
inadequately saturated, resulting in inaccurate data or termination of analysis.

Ensure that the analysis gas and the Psat gas (if used) specified in the sample file
match the system configuration gases; if they do not, correct the sample file or correct
the unit configuration gas. See Unit Configuration and Gas Specification on
page 2 - 14.

Evacuation through the Unit > Evacuate Port option can be performed on any idle port while
analyses are in progress.

Standard Analysis Guidelines

n Standard analyses cannot be performed if a high throughput or krypton analysis is in pro-
gress.

n One analysis can be started at a time.
n A sample can be added to any idle port and an analysis started without disturbing the ana-

lyses being performed on other ports.
n Samples can be removed from any of the six ports without disturbing the analyses being per-

formed on other ports.
n The sample dosing method should be Normal.
n All analyses must use the same gas.
n If saturation pressure is being measured, all analyses must use the same Psat gas.

Perform a Sample Analysis
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6 Perform an Analysis

Selections Description
Port Select the port to be used for the analysis.

Density / Mass /
Sample + Tube /
Empty Tube [text box]

Enter values for the sample’s mass and density. These values may
be edited after analysis.

New [button] Creates a new sample file.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Sample Analysis

A. Suspend/Resume/Skip but-
tons

B. Port report buttons
C. Live graph settings

Selections Description
Report Port [button] Generates a report on data being collected . The reports are

displayed on the computer monitor only.
Live Graph Settings
[button]

Select Thermal transpiration, x-axis Quantity (relative or absolute
pressure), and the x-axis Scale (linear or logarithmic).

Report after analysis
[button]

Generates reports to the selected destination when the analysis is
complete.

Status window Displays the last point pressure and relative pressure for each port.

Sample Analysis Graph
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Selections Description

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Sample Analysis Graph (continued)

Perform a Sample Analysis
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6 Perform an Analysis

PERFORM A HIGH THROUGHPUT ANALYSIS
Unit [n] > Start High Throughput Analysis
Use to perform up to six simultaneous high throughput analyses.

High Throughput Analysis Guidelines

n All ports must be idle in order to start an analysis.
n All analyses must use the same analysis gas.
n All analyses that measure Psat must use the same Psat gas (which may be different from the

analysis gas).
n The sample file must specify Normal as the Dosing Method in the Adsorptive Properties.
n From one to six analyses can be started simultaneously.
n Samples cannot be removed from or added to ports until the full set of analyses has com-

pleted.

The steps for performing a high throughput analysis are the same as the Krypton analysis. See
Perform a Krypton Analysis on the facing page.
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PERFORM A KRYPTON ANALYSIS
Unit [n] > Start Krypton Analysis
Krypton analyses can be performed using one of the following methods:

Krypton Methods Description
Normal dosing n A dosing method of Normalmust be selected in the adsorptive

properties.
n The manifold is dosed directly form the gas inlet.
n All ports can be used for analysis.

Dosing from the last
sample port

n A dosing method of From last sample portmust be selected in the
adsorptive properties.

n Krypton is purified and stored in the last sample port.
n The manifold is dosed from the last sample port.
n All ports except the last can be used for analysis.

Krypton analyses are available only if the krypton option is installed.

Data collection is done sequentially — one analysis starts and completes before the
next analysis begins.

Type of Analysis Guidelines
All krypton
analyses

n All ports must be idle in order to start an analysis.
n All analyses must use krypton gas.
n Samples cannot be removed from or added to ports until the full

set of analyses has completed.

Perform a Krypton Analysis
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6 Perform an Analysis

Type of Analysis Guidelines
Dosing from the last
sample port

n From one to five analyses can be started simultaneously. The last
port is used to store krypton for dosing.

n An empty sample tube must be installed in the last port.
n The sample file must specify From last sample port as the Dosing

Method in the Adsorptive Properties.

The Dewar below the port used to store and purify krypton must be at least 50% full of
the analysis bath liquid and an empty sample tube must be installed on the port before
starting a krypton analysis.

1. If dosing from the last sample port, install an empty sample tube on the port to be used to
store krypton and place a Dewar cover over the sample tube stem and the P0 tube stem.

2. For each port to be used, either click Browse and select a sample file or click New to create
a new sample file.

3. Verify the information populated into the sample identification fields. This information is
pulled from the sample file. The Density value is applicable only if using the Calculate
method for the free space determination.

4. Edit the P0 and Bath temperature fields, if necessary.
5. Click Report after analysis to generate reports automatically when the analysis is com-

plete. On the Report Settings window, select the report destination. ClickOK to return to the
previous window.

6. Click Start to start the analysis. A window displays data as they are collected. A short delay
is encountered before the port status at the bottom of the window changes from the Idle
state.
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A. Suspend/Resume/Skip but-
tons

B. Port report buttons
C. Live graph settings

Use the Skip function with caution; the analyzer performs multiple steps for a given
task. Skipping certain steps may cause data quality to be degraded, instrument dam-
age, or personal injury.

7. To view an analysis report, click the appropriate Report Port button.
8. When the analysis is complete, the Next button is displayed. Click Close to exit or Next to

perform another analysis.

Perform a Krypton Analysis
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6 Perform an Analysis

PERFORM A MICROPORE ANALYSIS
Unit [n] > Start Micropore Analysis

Micropore analyses are available only if the Micropore option is installed.

Micropore Analysis Guidelines

n All ports must be idle in order to start an analysis.
n All analyses must use the same analysis gas.
n All analyses that measure Psat must use the same Psat gas (which may be different from the

analysis gas).
n The sample dosing method should be Normal.
n From one to six analyses can be started simultaneously.
n Samples cannot be removed from or added to ports until the full set of analyses has com-

pleted.

The steps for performing a Micropore analysis are the same as the krypton analysis. See Perform
a Krypton Analysis on page 6 - 21.
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7 ABOUT REPORTS
Reports can be generated for data collected on a sample that has completed analysis, collected
on a sample currently being analyzed, or manually entered.

Reports > Start Report
Generates a report on a sample analysis.

Reports > Close Reports
Closes all open reports. This option is unavailable if reports are being generated.

START REPORTS
Reports > Start Report
Starts the selected report. Select a file from the Files list. Ensure the selected file has a status of
either Complete or Analyzing.

7 About Reports
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7 About Reports

HEAT OF ADSORPTION REPORT
Reports > Heat of Adsorption

Use to select sample files, define quantities, and generate a Heat of Adsorption report. The
isosteric heat of adsorption is an important parameter for characterizing the surface heterogeneity
and for providing information about the adsorbent and the adsorption capacity. Multiple adsorption
isotherms are obtained on the same sample using the same adsorptive but at different
temperatures to obtain the heat of adsorption.

Selections Description
Add Samples [button] Adds a sample file to the table.

Clear Samples [button] Removes all entries from the table.

Edit Quantities [button] Specifies the range of surface coverage to include in the report.

Heat of Adsorption Report
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Selections Description

Insert Range. Specifies the starting and ending quantities adsorbed
and number of points to insert.

Load Table. Imports values from another file.

Save Table. Saves the current table as a .QNT file.

Apply. Applies all table changes.
Heat of adsorption plot
[selection]

Generates the Heat of Adsorption data in a graphical format.

Isostere plot [selection] Generates a graph showing quantities of gas adsorbed versus the
temperature.

Remove Sample
[button]

Removes the selected sample from the list.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples that contains the
numeric values contributed by each sample.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Heat of Adsorption Report (continued)

Heat of Adsorption Report
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7 About Reports

SPC REPORT
Reports > Open SPC Report
Use to generate reports with various SPC (Statistical Process Control) options. All selected
variables must be computed for each sample file used in an SPC report; therefore, it is more
efficient to select only the necessary variables.

Selections Description
Edit [button] Defines the x-axis and y-axis of each graph. Highlight a report in the

Selected Reports list box, then click Edit.

Regression report. Select to run a Regression report.

Control chart. Select to run a Control chart report.

X-Axis.
n Autoscale. Allows the y-axis to be scaled automatically. To spe-

cify a range, deselect this option and enter a range in the From
and To fields.

Select the order in which x-axis statistics are placed. Sort by: 

n Time. Time the files were analyzed.
n File name. Alphanumeric order.
n Date. Date the files were analyzed.
n Minutes.Minutes elapsed from the first file placed on the list,

which is the earliest-analyzed file.
n Days. Number of days elapsed from the first file placed on the list,

which is the earliest analyzed file.

SPC Report
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Selections Description
Y-Axis. ClickOptions to define the control chart graph.

n Center Line. Displays placement options for the center line in the
graph. Select Entered to specify placement of the line orMean to
place the center line at the calculated mean value for the selected
samples.

n Limit Lines. Displays limiting lines options. Lines can be placed
at some multiple of the standard deviation or at specified positions
(Entered). When Entered is selected, enter the High limit and Low
limit fields with appropriate values.

Label data [check box] Use to label the points on the plot to correspond with the values in
the sample files.

Quantities [button] The selected items display as graph variable selections in the
Regression report and the Control Chart report. If report options for
NLDFT Advanced PSD are required, clickMore.

Recalculate
SPC results when
reporting [check box]

If selected, SPC results are archived in the sample files when a
report is generated. If deselected, previously archived results are
used to save time when generating reports. Since this option
updates and saves sample files, do not use it with sample files that
need to remain compatible with other applications.

SPC Report (continued)

SPC Report
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7 About Reports

Selections Description
Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report. Select the samples
in the Available Files list box then click Add to move them to the
Selected Files list box. ClickOK when done.

Selected Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated
report.

Show report title
[text box]

Enter a report title to appear on the report header.

SPC Report options
[drop-down box]

Select the applicable Control or Regression report from the list.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

SPC Report (continued)
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MICROACTIVE REPORTS
This feature provides a quick and easy way to investigate and manipulate analysis data using a
variety of reporting methods.

When a sample file with a status of Complete, Analyzing or Entered is opened, a linear plot and
log plot of the data collected during analysis are displayed as well as a summary of the analysis
giving the total pore volume. Numerous reports are accessible from a drop-down menu.

When a report is opened, plots and summary data are displayed, and in some reports certain
parameters (for example, thickness curve type, pore geometry, and interaction parameters) are
also displayed. Plots may be edited by selecting the data points or data point range to be included
in the plots and modifying the parameters. When a report is edited, the results are immediately
reflected in the plots and summary data.

MicroActive Reports
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7 About Reports

INTERACTIVE REPORTS
When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

n a linear plot and log plot of the data collected during analysis.
n a summary of the analysis giving a single total pore volume and surface area.

1. To view the plots in either relative or absolute pressure, select either the Relative Pressure
or Absolute Pressure option.

2. To view the reports selected for generation during the analysis, click Preview.
3. From the view selector drop-down list at the bottom of the window, do either of the following:

n Change the option presentation of the sample description window to either Basic or
Advanced to modify certain file parameters.

n Select another plot from the list and edit the data contained in the plot.

4. When ranges are edited, the changes are reflected immediately in the plots and the sum-
mary data displayed in the window. Some editing options are:
n Drag the blue bars to increase or decrease the range of data included in the plot.
n Edit the Isotherm Linear Plot to include or omit the data point from the BET plot.
n Right-click to display a popup menu to include reports; enable or select overlays; edit

curves, axes, legends, titles; and copy and paste the data in a graph or in tabular
format.

5. Click Save.
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EVALUATE REPORT RESULTS
Analysis reports provide a record of test conditions, experimental data, and information extracted
from the experimental data by application of various reduction methods. This topic discusses the
elements of various reports presented by Micromeritics’ static volumetric physisorption analyzers
and suggests ways by which the merit of the reported information may be evaluated.

Regardless of the precautions exercised before the analysis, problems still may occur during the
analysis, or as a result of using inappropriate parameters or even inappropriate methods. The
analysis data should be inspected for evidence of experimental error. The traditional method of
confirming the quality of the experiment is to repeat the analysis. Toward that end, Micromeritics’
analyzers log and report the exact conditions of each analysis.

Analysis data can be evaluated by:

n Viewing the Validation Report
n Inspecting the Isotherm Plot
n Evaluating the Isotherm Tabular Data Set
n Reviewing Reduced Data

Evaluate Report Results
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7 About Reports

VIEW THE VALIDATION REPORT
The Validation report shows whether the data collected during an analysis are within typical
ranges. Select the types of reports to include by selecting the report in the Validation Report
Options window.

When a selected report is generated, if errors occur, a message is displayed across the top
portion of the report and a unique symbol displays on the graph.

INSPECT THE ISOTHERM PLOT

Evaluation of data should begin with a visual inspection of the isotherm plot. The plot should be
composed of data which have not been subjected to mathematical smoothing as far as possible. If
the data describe a Type I isotherm, then the plot is best shown on a logarithmic pressure axis so
that details of the low pressure region are revealed. Data in this region are important particularly
for micropore studies. Examine the plot to determine if any points are outliers or if a region of the
isotherm exhibits characteristics (spikes, steps, etc.) which are inconsistent with the physical
process being monitored. The philosophical question of whether or not these suspected
extraneous data points should be removed from the raw data is not considered here, but it may be
appropriate to exclude an outlier from reduced data. Too many outliers can cause the integrity of
the total data set to come under suspicion.

Examine specific reported values to confirm that the isotherm data were collected under
reasonable conditions and using reasonable parameters. For example, confirm that the free
space values reported are typical for the sample holder and bath in use. A problem with either
ambient or analysis free space values may indicate a free space measurement error and affect all
calculations of quantity adsorbed.

7 - 10 ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025



The raw data should be carefully examined before it is reduced. Errors that occur in raw data will
only be exacerbated in reduced data.1 )

EVALUATE THE ISOTHERM TABULAR DATA SET

Another place to look for reasonableness of the data is the adsorptive uptake by the sample in the
BET range (P/P0 = 0.05 to 0.30). Total uptake is the specific quantity adsorbed (cm3/g STP) times
the sample mass (g). As an example, the level of uncertainty in this range typically is less than
0.1 cm3 STP for a high performance system. Total uptake quantities should be some multiple of
this level of uncertainty. Otherwise, an unfavorable signal-to-noise ratio and unreliable data result.
The solution is to use a greater quantity of sample to increase adsorptive uptake.

Another valuable bit of information resides in the tabulated saturation pressure. This pressure is
expected to change somewhat over the duration of an analysis, but it is not expected to do so with
large or abrupt transitions. Unreasonable saturation pressures or unusual changes may indicate
that a gas different from the adsorptive was used in determining P0, that the level of the cryogen
fell too far, or that the cryogen is impure or inappropriate.

With experience, obvious signs of problems can be detected by a quick inspection of the tabular
and graphical data. If the data appear satisfactory, the next step is to evaluate the reduced data.2 )

REVIEW REDUCED DATA

Isotherm data may be analyzed by any one of several reduction methods depending on the
analyzer model and pressure range employed. The quality of the results depends on the quality of
the isotherm, the congruity of the data reduction parameters with experimental conditions, the
agreement of the theoretical model with the physical gas-solid system, and compliance to the
pressure range over which the method is valid. Typically, results can be appraised by examining a
few salient areas of the report as described in the following topics.3 )

1 ) The information in this article is extracted from Analytical Methods in Fine Particle Technology,
Webb, P. and Orr, C., (1997).
2 ) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).
3 ) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).

Evaluate Report Results
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7 About Reports

PHYSICAL PARAMETERS

The value of physical parameters which are used only in data reduction routines should be
reviewed to assure that they agree with experimental conditions. These parameters can be
changed and the experimental data recalculated if an error is discovered or if exploring an
alternate value is desired. Analysis condition values used in the calculation of quantity adsorbed
can be changed also. These are typically the manually entered free space(s), nonideality
correction factor, and bath temperature.

The area occupied by a single adsorbed molecule is a required parameter in the calculation of
surface area by the BET and Langmuir methods. The software provides a default value, but other
values are found in the literature. McClellan and Harnsberger1 ) provide a comprehensive review
of such values.

The volume of pores of a specific size range is calculated from the gas quantity adsorbed in them
by converting the quantity to its liquid equivalent volume. This is achieved through use of a density
conversion factor calculated from the ratio of molar densities of the condensed adsorbate at bath
temperature to the gaseous phase at STP. The necessary information is found in handbooks. The
software contains default values for common adsorptives; values for other adsorptives must be
calculated.

The terms for liquid surface tension , contact angle between solid and liquid phase , molar
volume of the adsorbate , gas constant , and sample temperature are treated as one
constant, the adsorbate property factor expressed by:

using which, the Kelvin equation2 ) reduces to

Either surface tension, contact angle, or molar volume can be revised individually to give a new
value for the factor , or can simply be altered arbitrarily for exploratory purposes.

The thermal transpiration correction requires two parameters which may be adjusted from those
of the default values. The first is the inside stem (neck) diameter of the sample holder, and the
second is the hard-sphere diameter of the adsorptive molecule. The sample holder inside
diameter is available from the documentation provided with it or is measurable. Information on
hard-sphere diameters of molecules may be obtained from handbooks.

1 ) McClellan, A.L., and Harnsberger, H.F., Journal of Colloid and Interface Science, 23, 577
(1967).
2 ) Thomson, W., Phil. Mag. S., 42, 448 (1871).
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For terms such as the interaction parameter found in the Horvath-Kawazoe calculation1 ) , the
Dubinin affinity coefficient, or Astakhov exponent2 ) , the default values as provided by the
software generally are adequate. A search of the technical literature is required if the analysis
involves a gas-solid system other than that covered by the default values.

The t-Plot method plots quantity adsorbed against thickness (t) derived from a thickness equation,
and the Dubinin transform plots quantity adsorbed against log(P/P0)n. All of these data reduction
methods were first proposed for specific applications. The user must make a judgment as to the
applicability of the method to a gas-solid system.

If applied appropriately, all transform plots will exhibit a linear range and the regression analysis
must be applied only over the linear range and within the range of application. Fitting a regression
line to surface area transformation plots should yield a correlation coefficient of 0.9999 or better
and for t-plots and Dubinin plots the correlation coefficient should be 0.99 or better.

If the data reduction model does not apply to the gas-solid system under examination, then it may
be that either no linear range exists within the pressure range of validity, or that solutions derived
from the regression line of the linear range are intuitively incorrect, that is, they have no relevance
to the physical situation, such as a negative C-value from a BET transform.

BET C-VALUE

BET theory assumes uniform surface coverage with no favored adsorption sites and it also
assumes that the gas is more strongly attracted to the surface than to other gas molecules. The
typical range of BET C-values is from about 5 to well over 100. Values much less than 5 imply that
the gas-to-gas affinity is competing with the gas-to-solid affinity which conflicts with the basic
assumptions of BET theory. C-values much greater than 100 indicate very strong attraction for the
surface or preferential adsorption.

Provided the isotherm was determined with negligible error and the regression line to the BET
transformation data was fit properly, then an out-of-range C-value probably indicates that the gas-
solid interaction for the particular sample material does not conform to the BET model. An
inappropriate adsorption model may be indicated also by the coefficient of correlation of the
regression line, 0.999 being about the minimum value expected with five more or less equally
spaced points. In the case of indications of poor conformance to the BET model, the Langmuir
data reduction method should be examined.

1 ) Everett, D.H. and Powl, J.C., J. Chem Soc., Faraday Trans. 1, 72, 619 (1976).
2 ) Dubinin, M. and Radushkevich, L.V., Proc. Acad. Sci. USSR, 55, 331 (1947).

Evaluate Report Results
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7 About Reports

DATA ANALYSES BY THE BJH METHOD

In general, this method visualizes the incremental decomposition of an experimental isotherm,
starting at the highest relative pressure or pore size. At each step the quantity of adsorptive
involved is divided between pore-emptying and film-thinning processes and is accounted for
totally. This computational algorithm frequently leads to inconsistencies when carried to small
mesopore sizes. If the thickness curve used is too steep, ultimately it will predict a larger
increment of adsorptive for a given pressure increment than is actually observed. The algorithm
must stop since a negative pore volume is nonphysical. Accumulated error results in the
calculation of a too large volume of (possibly nonexistent) small pores if the thickness curve used
underestimates film thinning.
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REPORT FEATURES AND SHORTCUTS
Graph Features and Shortcuts on page 7 - 19

Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature,
or axis cross-hairs.

n After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
n The report zoom feature provides the viewing of fine graph details and the ability to shift the

axes.
n All reports contain a header displaying file statistics.

A. Data display (graph or
text)

B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

If configured, the report header can also contain a graphic and/or a title.

n Tabular and graphical reports contain sample and analyzer statistics such as analysis date/-
time, analysis conditions, etc.

n The headers contain notes of sample file changes occurring after analysis.

Report Features and Shortcuts
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7 About Reports

REPORT HEADER SHORTCUTS
Right-click in the report header to display header shortcuts.

Selections Description
Copy header as text Copies the report header as text. Text is copied to the clipboard and

then can be pasted into other documents.
Edit Opens a dialog box for editing the report title.

Report Header Shortcuts
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REPORT TOOLBAR
The Report window has a toolbar on the right portion of the window and selectable tabs at the top
of the report header. To view a specific report, either select the tab or the report in the Reports list
box, then click Show.

A. Data display (graph or
text)

B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

Selections Description
Default Style [button] Specifies default report parameters for fonts and curve properties.

Delete [button] Deletes the selected report in the Reports list box. Deleted reports
will have to be regenerated if deleted in error.

Hide [button] Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in the Reports list box.

Print [button] Displays the Print window for report output.

Reports [group box] Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hid-
den using the Hide button.

Show [button] Displays the selected or hidden report in the Reports list box.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Report Toolbar

Report Features and Shortcuts
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7 About Reports

TABULAR REPORT FEATURES AND SHORTCUTS
Display tabular report shortcuts by right-clicking in the body of the tabular report. Column
shortcuts require right-clicking on the column to be modified.

Selections Description
Align column Changes the column alignment to either left, right, or centered.

Copy table as text Copies the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.

Edit title Edits the report title and/or title font attributes. Click Font to modify
font attributes.

Move column Right-click the column to be moved. SelectMove column on the short-
cut menu and select Left or Right for the move.

Rename column Right-click the column to be renamed. Select Rename column on the
shortcut menu and enter the new column name.

Resize column Right-click the column to be resized. Select Resize column on the
shortcut menu and enter the new column width in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right-click in the report data. Select Table data font on the shortcut
menu.

Table header font Right-click in the report data. Select Table header font on the shortcut
menu.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Tabular Report Shortcuts
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GRAPH FEATURES AND SHORTCUTS
Right-click in the graph area to display graph report shortcuts.

Selections Description
Autoscale all axes Returns the report to full view after using the zoom feature.

Edit axis Edits the selected axis properties.

Gridlines. Changes how to display major / minor grid lines.

Scale.
n Autoscale minimum/maximum. To manually specify minimum /

maximum autoscale, deselect the option and enter the new
amount in the text box.

n Invert scale. Inverts the scale.
n Linear/Logarithmic. Scales the graph as linear or logarithmic.
n Scale font. Modifies the font for the scale label. Deselect Use

default font to enable font options.

Title. Edits the selected axis label.

Title font.Modifies the font for the selected axis label. Deselect Use
default font. Select new font attributes for report data. Enable Use
default font to reset default fonts.

Edit curve Edits selected curve properties.

Graph Shortcut Options

Graph Features and Shortcuts
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7 About Reports

Selections Description

Color. Changes the curve color.

Curve. Changes the interpolation, point style, and pen style for the
selected curve. These options are disabled if Use default fill style is
selected in the Histogram group box.

Histogram. Enabled only if Histogram is selected in the Style drop-
down list. Specifies the type of fill, fill color, and label position for the
selected curve.

Label. Designates where the graph point labels will display (left,
right, center, etc.) on the SPC report.

Style. Selects another style for the collected data curve.

Title. Changes the title of the selected curve.

Use default thickness. Uses the default curve thickness. Deselect
to enter a new thickness number in the Thickness text box.

Graph Shortcut Options (continued)
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Selections Description
Edit legend Changes the legend location and font.

Edit title Changes the report title.

Reset axis limits to
initial setting

Removes the cross-hair and returns the graph back to the initial set-
ting.

Show curve Displays a list of all curves. Select the curve(s) to display.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Graph Shortcut Options (continued)
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7 About Reports

AXIS CROSS-HAIR
Left-click on the graph to view the cross-hair coordinates.

Example of
Axis cross-hair feature

ZOOM FEATURE
Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A box will display in the area to be enlarged. To return to normal
view, right-click in the graph and select Autoscale all axes.

GRAPH GRID LINES
Options > Graph Grid Lines

Use to select how grid lines appear on reports. This menu option is not available if using
Restricted option presentation.
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Selections Description
Grid Line Styles
[selection]

Select if the major and/or minor grid lines should appear as solid or
dotted lines.

X-Axis / Y-Axis
[selection]

Select major and/or minor lines to display in reports for the
logarithmic and linear scales. Deselect this option to remove the grid
lines.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Graph Grid Lines

Graph Features and Shortcuts
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7 About Reports

GRAPH AND SAMPLE OVERLAYS

n Multiple Graph Overlays.Overlay two different types of graphs from one sample.
n Multiple Sample Overlays.Overlay graphs of the same type with that of the current plot.

This feature is available only when using Advanced option presentation. Go to
Options > Option Presentation > Advanced.
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GENERATE PORE SIZE DISTRIBUTION GRAPH OVERLAYS

The following reports in the physisorption applications can produce graphical results for a sample
material's pore size distribution:

BJH Adsorption/Desorption Report on page 8 - 7
DFT Pore Size Report on page 8 - 13
Dollimore-Heal Adsorption/Desorption Report on page 8 - 17
Horvath-Kawazoe Report on page 8 - 30

Two methods can be used to import and overlay report data into another interactive graph using
shortcut menu options:

n Import ASCII text data. Data can be imported from an ASCII text file into the interactive graph.
The ASCII text file must follow certain rules.

n Copy/paste. Data can be copied from one sample file (source) and pasted into another sample
file (target).

Pore size distribution report overlays menu selections are:

n Copy data
n Paste data
n Edit Imported Data
n Display Imported Data

Generate Pore Size Distribution Graph Overlays
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7 About Reports

IMPORT ASCII TEXT DATA
ASCII text file format rules

n The header must consist of one line to include title, two unit specifications, and distribution
type:

o Accepted pore dimension units are: A, nm, um
o Accepted pore volume units are: cm3/g, cm3/g, mL/g
o Accepted distribution types are: cumulative, incremental

Two examples of a header format:

My Title (A, cm3/g, incremental)
My Title (A, cm3/g, cumulative)

n The data must be in two columns and should be separated by a comma or white space.
n The data lines must be ordered so that pore dimensions are monotonically increasing or

decreasing.

Window appearance will vary depending on the selected report. This function can be performed
on samples files with a Complete status or during an analysis.

1. Create the ASCII text file using the proper format as indicated above.
2. In the analyzer application, go to File > Open.
3. Select a sample file to overlay graphs on to.
4. ClickOpen (or double-click the file name).
5. Right-click in the graph area and select Edit imported data.

7 - 26 ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025



6. In the Select Imported Overlays window, if the ASCII text file does not display, click Import
to locate the file.

7. Select the ASCII text file in the Select Imported Overlays window, then clickOK. If an error
message is displayed, verify that the .TXT file format is in the correct format.

8. To include the overlay data in a printed report, see Print Pore Size Distribution Overlay
Data in Reports below.

OVERLAY PORE SIZE DISTRIBUTION DATA USING COPY/PASTE
1. Open a source sample file and a target sample file; both should have a Complete status.

The report will open to the interactive reports window.
2. In the source sample file, right-click on the graph and select Show Curve.
3. Deselect any differential curve data to hide them in the graph.
4. Right-click in the graph area again and select Copy Data.
5. Change to the target sample file, right-click the graph, and select Paste data. The graph

now displays overlayed data from the source sample file.

Typically, one new graph will appear showing both the cumulative and differential curves.
To show or hide individual curves, right-click the graph and select (or deselect) Display
imported data.

6. Ensure that all parameter fields are set appropriately, then click Paste.
7. To include the overlay data in a printed report, see Print Pore Size Distribution Overlay Data

in Reports.

Print Pore Size Distribution Overlay Data in Reports

1. Open the sample file containing the overlay data and select Advanced from the view
selector drop-down list at the bottom of the window.

2. Click the Report Options tab.
3. In the Selected Reports list box, select the cumulative, differential, or incremental intrusion

graph to show the imported distribution data, then click Edit (or double-click the selected
report).

4. In theOverlay drop-down box, select Imported.
5. ClickOK to close the window.
6. Click Preview on the Report Options tab.
7. Click Print in the reports toolbar section to display print options.

Generate Pore Size Distribution Graph Overlays
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7 About Reports

OVERLAY MULTIPLE SAMPLE FILES

1. Go to File > Open.
2. Select a .SMP file, then clickOpen. If the Isotherm plot displays, select Advanced from the

view selector drop-down list at the bottom of the window to display the tabbed window view.
3. Click the Report Options tab.
4. In the Selected Reports list box, highlight a report then click Edit. Use the following table to

complete the process for the selected report.
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If overlaying this type of
report...

Then...

n Isotherm

a. On the Isotherm Report Options window, select one or
more plots in the Selected Reports group box, then click
Options to the right of the selected plot.

b. On the Plot Options window, select Plot curve and/or Plot
points if they are to be included in the overlay. If the x-
and/or y-axes are to be autoscaled, enable Autoscale; oth-
erwise, enter the From and To points for the axes. Click
OK.

c. On the Isotherm Report Options window, in the Plot
Options group box, select Plot overlays. ClickOK.

d. Continue to Step 5.

n Alpha-S Method
n BET Surface Area
n f-Ratio Method
n Freundlich
n Langmuir Surface Area
n t-plot
n Temkin

a. On the pop-up window, selectOverlay samples. Verify
other fields. ClickOK.

b. Continue to Step 5.

n BJH
n Dollimore-Heal
n MP-Method

a. Select the report variable from the Selected Reports
group box, then click Edit.

b. Click the down arrow on theOverlay field, then select the
Samples option.

c. Verify other fields.
d. ClickOK.
e. ClickOK again.

5. On the Report Options tab, clickOverlays.
6. On the Plot Overlay Sample Selection window, move up to 25 files from the Available Files

box to the Selected Files box:

7. ClickOK.
8. To view the report, click Preview.

Overlay Multiple Sample Files
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7 About Reports

Selections Description
Available Files
[selection]

Lists files that meet the selected criteria. Select the files to be com-
bined, then click Add. The selected files are moved to the Selected
Files list box.

Look in [button] Changes the file folder location. Click the Browse icon.

Selected Files
[selection]

Lists the files selected to be combined. Click Remove to move a file
back to the Available Files list box. ClickOK to combine the files.

Status [drop-down box] Selects the status of files to be combined.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Overlay Sample Selection
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IMPORT ASCII PORE DISTRIBUTION DATA

Manually Enter Data on page 3 - 6

IMPORT AN ASCII TEXT FILE USING GRAPH SHORTCUTS
1. Create an ASCII text file.
2. Open a report with a Complete status.
3. Select a pore-size distribution report from the view selector drop-down list at the bottom of

the window.
4. Right-click on the graph and select Edit imported data on the shortcut menu.
5. If the ASCII text file does not display on the Selected Imported Overlays window, click

Import.
6. Select the file, then clickOpen. Header information from the ASCII text file will appear in the

Select Imported Overlays window.
7. Select the entry, then clickOK. If an error message appears, verify that the .TXT file format

is correct.
8. To hide or show imported data, right-click in the graph area and use the Display imported

data option on the shortcut menu.

COPY/PASTE AN ASCII TEXT FILE USING GRAPH SHORTCUTS
1. Create an ASCII text file.
2. Copy the ASCII text data to the clipboard.
3. Open a report with a Complete status.
4. Select a pore-size distribution report from the view selector drop-down list at the bottom of

the window.
5. Right-click on the graph and select Paste data on the shortcut menu.
6. To hide or show imported data, right-click in the graph area and use the Display imported

data option on the shortcut menu.

COPY/PASTE GRAPH DATA FROM ANOTHER GRAPH

1. Open a source pore distribution data report with a Complete status.
2. Right-click on the graph and select Copy Data on the shortcut menu.
3. Open the target pore distribution data report.
4. Right-click on the graph and select Paste Data on the shortcut menu.
5. To hide or show imported data, right-click in the graph area and use the Display imported

data option on the shortcut menu.

Import ASCII Pore Distribution Data
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7 About Reports

REPORT EXAMPLES

GOODNESS OF FIT
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HORVATH-KAWAZOE CUMULATIVE PORE VOLUME PLOT

Horvath-Kawazoe Cumulative Pore Volume Plot
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7 About Reports

HORVATH-KAWAZOE DIFFERENTIAL PORE VOLUME PLOT
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HORVATH-KAWAZOE

Horvath-Kawazoe
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7 About Reports

INCREMENTAL SURFACE AREA VS PORE-WIDTH
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ISOTHERM LINEAR PLOT

Isotherm Linear Plot
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8 SELECTED REPORTS
ADVANCED REPORTS - PYTHON MODULE

The mic Python module is automatically imported when running a user supplied script. The
module provides access to primary and overlay isotherm data and provides support for summary,
tabular, and graphical reports.

n Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

n Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with themic.table call.

n Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.

Advanced Reports

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. SeeMicModule Python Calls on page A - 17 for an
example of a Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.
2. Open a sample file with a Complete status.
3. Select Advanced in the view selector drop-down list at the bottom of the window to return to

the tabbed view.
4. On the Report Options tab, select Advanced in the Selected Reports list box, then click

Edit.
5. On the Advanced Report Options window, click Add in the Available Scripts group box to

locate and select the Python script. Repeat for each script to be added.

8 Selected Reports
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8 Selected Reports

6. In the Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. Click Pressures to add pressure points to the report. ClickOK to return to the Report
Options tab.

8. Select theOverlay samples checkbox to enable the overlay sample feature.
9. On the Report Options tab, click Preview. The Python Reports will be included on the tabs

across the top portion of the Reports window.

Selections Description
Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace,
edit, or remove reports.

Overlay samples (if
shown) [check box]

Use to overlay samples as defined by the function.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Advanced Reports
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ALPHA-S METHOD REPORT

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm using
the quantity adsorbed at a relative pressure of 0.4.

One predefined curve is located in the Reference file directory. Use the table buttons to enter
relative pressure and the Alpha-S values.

Selections Description
Open [button] Use to import values from an existing thickness curve (.ALS).

The table to be imported must be saved as ASCII text with a .ALS file
extension. It must have a two-column format with the relative
pressures in the first column and the alpha-s values in the second
column. Columns must be separated by a space or a tab.

Alpha-S Method Report

Alpha-S Method Report
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8 Selected Reports

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Ref. surface area
[text box]

Enter the surface area from the reference curve. This value is used
to calculate the sample surface area.

Select Range
for Alpha-S Fit
[group box]

Enter minimum and maximum relative pressures to determine the fit.

Selected Reports
[group box]

Alpha-S Plot. Use to plot data in graph format.
n Autoscale x-axis. The x-axis field shows the relative pressure.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the plot.
Tabular Report. Use to have a tabular report of data generated.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Alpha-S Method Report (continued)
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BET SURFACE AREA REPORT

The BET calculation obtains the sample surface area value by determining the monolayer
capacity of adsorbed gas from the isotherm data. BET uses a multilayer model.

Selections Description
Pressures [button] This option is available when the sample file has a status of Ana-

lyzing or Complete. Use to enter a range of pressure points to be
included in the report or to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table if not using the Use
Interpolation option.

Exclude All. Select to exclude all pressure points in the table.

BET Surface Area Report

BET Surface Area Report
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8 Selected Reports

Selections Description
Include All. Select to include all pressure points in the table.

Insert Predefined. Click to insert a predefined (default) set of points
into the report. Use Interpolationmust be selected to enable this
button. This button displays for BET reports only.

Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for BET fit [text box]

Enter values to indicate the fitted pressure range.

Selected Reports
[group box]

BET Isotherm plot. Uses BET monolayer capacity and constant to
produce an isotherm.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the relative pressure for BET.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the

BET isotherm plot.
BET Transform plot. Use to generate a traditional BET surface
area plot used to determine monolayer volume and BET C constant.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the relative pressure for BET.
n Autoscale y-axis. The y-axis field shows BET transformation.
n Overlay samples. Use to overlay sample files on the

BET transform plot.

Tabular report. Use to have a table of measured and calculated
values generated.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

BET Surface Area Report (continued)
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BJH ADSORPTION/DESORPTION REPORT

The BJH calculation determines the mesopore volume/area distribution, which accounts for both
the change in adsorbate layer thickness and the liquid condensed in pore cores. Reports can be
generated from both adsorption and desorption data. The fields for both BJH Adsorption Report
Options and BJH Desorption Report Options are identical unless otherwise specified.

An incomplete pore distribution may be generated if a thickness curve selection is not
a good match for the sample being analyzed.

Circled selection is applicable to BJH
Adsorption only

Selections Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

BJH Adsorption/Desorption Report

BJH Adsorption/Desorption Report
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8 Selected Reports

Selections Description

BJH Correction
[group box]

Select the type of correction to apply to calculations. The selected
type will display in the report header.

Faas.Good for statistical thickness curves.

Kruk-Jaroniec-Sayari.Good for reference thickness curves.

Standard. Uses original BJH models.
Cumulative Reports
[group box]

Larger. Use to report the total volume found in pores larger than the
current pore size.

Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box] Enter the minimum and maximum diameter (radius or width) of pores
to include in the BJH reports.

Fraction of pores open at both ends. This field is not available for
the BJH Desorption Report Options window.

During adsorption calculations, the analysis program assumes that
all pores are closed at one end. Occasionally, a percentage of pores
may be open at both ends causing disagreement in the adsorption
and desorption data or in the values for total volume and total BJH
pore volume. Enter the fraction of pores open at both ends to
compensate for this error.

BJH Adsorption/Desorption Report (continued)
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Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

BJH Adsorption/Desorption Report (continued)

BJH Adsorption/Desorption Report
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8 Selected Reports

Selections Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

BJH Adsorption/Desorption Report (continued)
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BJH Plot

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the BJH Report Options window, then
click Edit.

Selections Description
Autoscale [check box] When enabled on the report parameters windows, allows the x- and

y- axes to be scaled automatically. Autoscalemeans that the x- and
y- ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Plot curve / Plot points
[check box]

Select to plot points on the graph.

X-Axis [group box] Use to have the x-axis on a logarithmic or linear scale.

Y-Axis [group box] Overlay. Select an option to overlay onto the current report.

Variable. Select a variable.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

BJH Plot Report

BJH Adsorption/Desorption Report
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8 Selected Reports

BJH Tabular Report

Highlight BJH Tabular Report in the Selected Reports list box on the BJH Adsorption Report
Options window, then click Edit to specify the method of data reduction.

Selections Description
Collected points
[selection]

Use to include all relative pressure points collected. See the
Columns button below.

Columns [button] Select the data types to include in the report. Column [n] indicates
the column order and data contents for the report.

Fixed pore size table
[selection]

Use to specify exact pore sizes for volume or area data. Click Table
to modify the fixed pore size table. See the Table and Columns but-
tons elsewhere in this table.

Table [button] The fixed pore size table must contain a minimum of two points. The
points must be strictly decreasing. Enabled only when Fixed pore
size table is selected.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

BJH Tabular Report
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DFT PORE SIZE REPORT

The DFT Pore Size report contains the results of pore size distribution analyses using a non-local
DFT range of micro and mesopore ranges.

Selections Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

DFT Pore Size Report

DFT Pore Size Report
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8 Selected Reports

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user)
is selected, enter a number in the text box giving a relative weight for
the smoothing during deconvolution. Larger values produce more
smoothing.

Select Isotherm Data
[group box]

Select the isotherm data to be used in the report.

Select Reports
[group box]

Select the reports to generate. To edit graph details, highlight the
graph option and click Edit. The Log Goodness of Fit andGoodness
of Fit graphs cannot be edited.

Autoscale Options. Use to autoscale the x-axis and/or y-axes.

DFT Pore Size Report (continued)
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Selections Description
Axis Range. From/To fields are enabled when Autoscale options
are not selected. Enter the starting and ending values for the x-
and/or y-axes.
n x-axis. Shows the pore size.
n y-axis. Shows the area.

Overlay. Select an overlay for the report.

Plot Type. Select the method for data display.
Type [drop-down box] Classical.Model based on the Kelvin equation and thickness for

determining the pore size distribution. See DFT Models on page B -
1.

DFT.Model based on the density functional theory.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

DFT Pore Size Report (continued)

DFT Pore Size Report
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8 Selected Reports

DFT SURFACE ENERGY REPORT

DFT Pore Size Report on page 8 - 13

The DFT Surface Energy report contains the results of surface energy distribution analyses.

DFT Surface Energy Report Options fields and buttons are identical to the DFT Pore Size Report
Options.
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DOLLIMORE-HEAL ADSORPTION/DESORPTION REPORT

BJH Adsorption/Desorption Report on page 8 - 7

The Dollimore-Heal Adsorption Report Option and the Dollimore-Heal Desorption Report Option
generate reports from both adsorption and desorption data.

Selections Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

Dollimore-Heal Adsorption/Desorption Report

Dollimore-Heal Adsorption/Desorption Report
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8 Selected Reports

Selections Description
Cumulative Reports
[group box]

Larger. Use to report the total volume found in pores larger than the
current pore size.

Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box] Enter the minimum and maximum diameter (radius or width) of pores
to include in the BJH reports.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

Dollimore-Heal Adsorption/Desorption Report (continued)
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Selections Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Dollimore-Heal Adsorption/Desorption Report (continued)

Dollimore-Heal Adsorption/Desorption Report
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8 Selected Reports

Dollimore-Heal Desorption Plot Options

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the Dollimore-Heal Report Options
window, then click Edit. The fields and buttons for these reports are identical to the BJH Plot
Report Options.

Dollimore-Heal Tabular Report Options

Dollimore-Heal Tabular Report Options are identical to the BJH Tabular Report Options.
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DUBININ REPORT

The Dubininmethod provides pore volume distributions for microporous materials by making use
of an expression for the adsorption potential.

Selections Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

Fitted Relative
Pressure Range
[group box]

Enter the minimum and maximum limits for Radushkevich or Astak-
hov relative pressures included in the line fit.

Dubinin Report

Dubinin Report
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8 Selected Reports

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Report Type
[group box]

Select report types. If Astakhov is selected, either selectOptimize
exponent or enter an appropriate exponent value in the text box.

Select Reports
[group box]

Select the reports to generate. Highlight the report, then click Edit to
modify report options.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Dubinin Report (continued)
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Dubinin Pore Volume Report Options

In the Dubinin Report Options window, highlight dV/dw Pore Volume in the Selected Reports list
box, then click Edit.

This option plots differential pore volume as a function of pore width.

Selections Description
Autoscale x-axis /
Autoscale y-axis
[check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Enable to enter beginning and ending values manually.
Overlay samples
[selection]

Use to overlay sample files on the plot.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Dubinin Report

Dubinin Report
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8 Selected Reports

Dubinin Tabular Report Options

In the Dubinin Report Options window, highlight Dubinin Tabular Report in the Selected Reports
list box, then click Edit. Column [n] indicates the column order and data contents for the report.

Log (po/p )^n. The value for [n] is the optimized exponent ifOptimize exponent is selected on the
Dubinin Report Options window. If not, then the value for [n] is the entered exponent value.
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Dubinin Transformed Isotherm Plot Options

Highlight Transformed Isotherm in the Selected Reports list box in the Dubinin Report Options
window, then click Edit.

The transformed Dubinin isotherm is the logarithm of quantity adsorbed as a function of the log of
relative pressure raised to a power. Isotherms for which the Dubinin method is applicable produce
straight lines when transformed in this way.

Selections Description
Autoscale x-axis /
Autoscale y-axis
[check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Deselect to enter beginning and ending values manually.

Autoscale x-axis. Shows the quantity of gas adsorbed at standard
temperature and pressure.

Autoscale y-axis. Shows the log of relative pressure.
Overlay samples
[check box]

Use to overlay sample files on the plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Dubinin Transformed Isotherm Plot Report

Dubinin Report
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8 Selected Reports

F-RATIO METHOD REPORT

The f-Ratio report uses the measured isotherm and normalizes it using a reference isotherm.

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Reference isotherm
[group box]

Browse to select a sample file to use as a reference for the isotherm.
Select a file containing an isotherm measured from a non-porous
sample of the same material as the current sample.

f-Ratio Report
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Selections Description
Selected Reports
[group box]

Tabular Report. Use to have a tabular report of data generated.

f-Plot. Use to generate a normalized isotherm.

n Autoscale x-axis. The x-axis field is dimensionless in units of f-
ratio.

n Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

n Overlay samples. Use to overlay sample files on the f-plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

f-Ratio Report (continued)

f-Ratio Method Report
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FREUNDLICH REPORT

The Freundlich Isotherm is an empirical isotherm used to model low pressure adsorption data. It
can also be applied to model some micropore isotherms. In the Selected Reports list box, highlight
Freundlich, then click Edit.

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Freundlich Report
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Selections Description
Select Reports
[group box]

Freundlich Isotherm plot. Plots the absolute pressure vs quantity
adsorbed. Shows best fit line.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure.
n Autoscale y-axis. y-axes begin at zero. The y-axis field shows

the quantity of gas adsorbed.
n Overlay samples. Use to overlay sample files on the Freundlich

isotherm plot.
Freundlich Transform plot. Plots the log(P) vs log(Q) and the best
fit.
n Autoscale x-axis. The x-axis field shows the absolute pressure.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the Freundlich

transform plot.

Tabular report. Select to include pressure points included in the
report.

Specify monolayer
capacity [selection]

Select and enter the monolayer capacity of the sample.

Tabular report
[selection]

Use to have a report of the pressure points generated.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Freundlich Report (continued)

Freundlich Report
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HORVATH-KAWAZOE REPORT

The Horvath-Kawazoemethod plots individual peaks for different pore sizes even if the difference
between one pore size and the next is only one angstrom (0.10 nm) or less.

Selections Description
Apply Cheng-Yang
correction [selection]

Use to apply the Cheng-Yang correction to the pore size analysis.
This correction substitutes the Langmuir equation of state for Henry’s
Law in the Horvath-Kawazoe derivation.

Interaction Parameter
[group box]

Use to determine which interaction parameter will be used in the
report. These options are disabled if Sphere is selected in the Pore
Geometry group box.

Computed. Use to calculate using the parameters on the Horvath-
Kawazoe Physical Properties window (click Properties to display
the Physical Properties window). The interaction parameter is
recalculated each time a parameter in the Physical Properties
window is edited.

Entered. Calculates using the value entered in the text box.
Pore Geometry
[group box]

Select the option that best represents the physical geometry of the
micropores in the sample material. When Sphere is selected, options
in the Interaction Parameter group box are disabled.

Horvath-Kawazoe Report
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Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Properties [button] Click to view or edit the constants describing the physical properties

of the adsorbent and adsorptive.

Adsorbent. Contains the parameters for the sample. If using
Computed for the interaction parameter, all fields are enabled. If
using Entered, only the values in the Diameter and Diameter at zero
energy text fields may be edited.

n Density. Enter the density per unit area of the sample. *
n Description. Select the name of the sample used in the analysis.
n Diameter. Enter the diameter of the sample atom.
n Diameter at zero energy. Enter the diameter of an atom at zero

interaction energy: (2/5)1/6 × diameter.
n Magnetic susceptibility. Enter the magnetic susceptibility of the

sample. *
n Polarizability. Enter the polarizability of the sample. *
Adsorptive. Contains the parameters for the adsorptives. If using
Computed for the interaction parameter, all fields are enabled. If
using Entered, only the values in the Diameter and Diameter at zero
energy text fields may be edited.

n Density. Enter the density per unit area of the adsorptive. *
n Diameter. Enter the diameter of the gas phase atom.
n Diameter at zero energy. Enter the diameter of an atom at zero

Horvath-Kawazoe Report (continued)

Horvath-Kawazoe Report
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8 Selected Reports

Selections Description

interaction energy: (2/5)1/6 × diameter.
n Magnetic susceptibility. Enter the magnetic susceptibility of the

adsorptive. *
n Mnemonic. Select the mnemonic of the adsorptive gas in use.
n Polarizability. Enter the polarizability of the adsorptive. *

* Option is disabled if Entered is selected in the Interactions
Parameter group box.

Select Reports
[group box]

Select the types of reports to generate. Highlight the report, then
click Edit to modify report parameters.

Smooth differentials
[selection]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Horvath-Kawazoe Report (continued)
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Horvath-Kawazoe Plots

See BJH Adsorption/Desorption Report on page 8 - 7 for additional information on fields and
buttons for this report.

Highlight a plot option in the Selected Reports list box in the Horvath-Kawazoe Report Options
window, then click Edit to customize the plotting method.

Horvath-Kawazoe Tabular Report

Highlight H-K Tabular Report in the Selected Reports list box in the Horvath-Kawazoe Report
Options window, then click Edit. Select the data types to include in the report. Column [n]
indicates the column order and data contents for the report.

Horvath-Kawazoe Report
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ISOTHERM REPORT

The Isotherm report indicates adsorption (up to saturation pressure) and desorption (down from
saturation pressure) of a gas by a solid held at constant temperature.

Selections Description
Options [button]  Click to display related linear plot options. All plot windows contain

identical fields.

Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes
begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Plot curve / Plot points. Select to plot points on the graph.

Isotherm Report
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Selections Description
Plot Options [group box] Select the types of isotherm to plot.

Quantity Adsorbed
[group box]

Select how to report the quantity adsorbed.

n per gram (cm3/g) STP
n per BET Surface Area (cm3/m2) STP or mmol/g
n per other Surface Area (cm3/m2) STP or mmol/m2

Selected Reports
[group box]

Select each option to include on the final report. Click the Options
button of a selected item to include plot curve, plot points, and to
autoscale x- and y-axes.

Tabular Options
[group box]

Select the options to include on the report.

Elapsed time. Time elapsed during the analysis.

Time between points. Time elapsed between points during the
analysis.

Weight %. Enter the mass percentage when plotting pressure
composition.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Isotherm Report (continued)

Isotherm Report
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LANGMUIR REPORT

The Langmuir calculation determines the surface area of a sample by relating the surface area to
the volume of gas adsorbed as a monolayer. Langmuir uses a single layer model.

Selections Description
Pressures [button] This option is available when the sample file has a status of

Analyzing or Complete. Use to enter a range of pressure points to be
included in the report or to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table. To exclude a point from
the calculations used to generate the report, select Exclude.

Langmuir Report
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Selections Description
Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for Langmuir fit
[group box]

Enter values to indicate the fitted pressure range.

Langmuir Report (continued)

Langmuir Report
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Selections Description
Select Reports
[group box]

Langmuir Isotherm Plot. Uses the Langmuir monolayer volume
and constant to produce an isotherm.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure for Langmuir.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the Langmuir

isotherm plot.
Langmuir Transform Plot. Use to generate a traditional Langmuir
surface area plot used to determine monolayer volume constant.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure for Langmuir.
n Autoscale y-axis. The y-axis field shows Langmuir trans-

formation.
n Overlay samples. Use to overlay sample files on the Langmuir

transform plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Langmuir Report (continued)
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MP-METHOD REPORT

TheMP-Method Report provides pore volume distributions for microporous materials by
correlating quantity adsorbed with the thickness of the adsorbed layer as determined from a user-
selected thickness curve. Pore size can be expressed in angstroms or nanometers. Go
to Options > Units to specify the unit.

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

MP-Method Report

MP-Method Report
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Selections Description
Select Reports
[group box]

Select the reports to generate. Highlight the report, then click Edit to
modify report options.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

MP-Method Report (continued)
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MP-Method Plot Report

In theMP-Method Report Options window, highlight a plot option in the Selected Reports list box,
then click Edit to customize the plotting method.

Selections Description
Overlay [drop-down box] Select an option to overlay on the current report.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve.

X-Axis [check box] Use to have the x-axis autoscaled or enter beginning and ending
values.

Y-Axis [group box] Autoscale. Use to have the y-axis autoscaled or enter beginning
and ending values.

Overlay. Select an option to overlay on the current report.

Variable. Select a variable.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

MP Method Plot Report

MP-Method Report
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MP-Method Tabular Report

In theMP-Method Report Options window, highlightMP Tabular Report in the Selected Reports
list box, then click Edit. Column [n] indicates the column order and data contents for the report.

The MPMethod reports hydraulic radius only. If Pore size in diameter is selected on
the Unit Selection window, pore size in radius will be reported.
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NLDFT ADVANCED PSD REPORT

The NLDFT Advanced PSD report allows for more advanced computation of the pore size
distribution of a material using two separate analyses and two non-local DFT models.

The NLDFT Advanced PSD report option provides the same calculations as the DFT Pore Size
report option and more. The NLDFT report compares two sample files. The models that can be
selected are restricted to only those models which have the same analysis temperature and
analysis gas as the sample file that is open. For instance, if the sample file was analyzed with N2
at 77 degrees Kelvin, then only the N2 DFT models at 77 degrees Kelvin will be available in the
Model drop-down list.

The model curve fit is shown in the lower right quadrant along with the adsorption isotherm. This
curve fit is updated each time the calculation parameters change (selection of isotherm data
points, choice of model, choice of regularization parameter).

A second sample file and second model is used to compute a more accurate pore size distribution
(PSD), which is shown in the upper left quadrant. Typically, the second sample file will have used
the same sample material as the first sample file yet will have used a different analysis gas and
temperature.

In general, the isotherm for this second sample will be different than the first sample. The
advanced DFT calculation takes the data from both sample files and combines all this data into a
more accurate calculation of the pore size distribution. More accurate means getting the pore
distribution at smaller pore sizes (a few Angstroms) as well as larger pore sizes (one thousand
Angstroms).

NLDFT Advanced PSD Report
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8 Selected Reports

To make a successful Advanced calculation, a second sample file must be selected
using the Select button. A second model must also be selected. Use the options next
to the two sample file names to select the isotherm data points for each sample. After
selecting an option, the blue bars in the isotherm graph will be toggled to select either
the red points or the green points. Once these selections have been done, the results
will appear in the left-hand plots and a second isotherm will appear in the isotherm
plot (lower right) as well as a second curve-fit. As the selection of points is adjusted,
the DFT editor will recalculate the PSD results and also recalculate the two model
curve fits.

Selections Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user)
is selected, enter a number in the text box giving a relative weight for
the smoothing during deconvolution. Larger values produce more
smoothing.

Select Reports
[group box]

Use to select the second sample file.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

NLDFT Advanced PSD Report
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To run the NLDFT report:

1. Go to File > Open. Select a sample file with a Complete status, then clickOpen.
2. In the view selector drop-down list at the bottom of the window, select NLDFT Advanced

PSD. Graphs for the first sample file display and the sample description shows as the first
group box title in the upper right corner of the window.

A. First selected sample file
B. Second selected sample file

a. Select theGeometry andModel from the drop-down lists for the first sample file.
b. To select isotherm data points for calculation for the first sample file, ensure the option

to the left of the first sample file description is selected. Slide the two blue bars on the
isotherm graph to select data points. Without a second sample selected, the report will
perform a single model DFT calculation and show the results in the two left-hand result
windows.

3. To calculate data from the second sample file, click Select to locate and open the second
sample file with a Complete status. Graphs for the second sample file display and the
sample description will display as the second group box title in the upper right corner of the
window.
a. Select theGeometry andModel from the drop-down lists for the second sample file.
b. To select isotherm data points for calculation for the second sample file, ensure the

option to the left of the second sample file description is selected. Slide the two blue
bars on the isotherm graph to select data points. Data are automatically calculated for
both sample files.

c. Click Edit to make any necessary modifications to the second sample file.

NLDFT Advanced PSD Report
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OPTIONS REPORT

Lists the conditions used to perform the analysis such as:

n Adsorptive properties
n Analysis conditions
n Analysis method
n Degas conditions
n Free space
n Saturation pressure (P0) and temperature

Options reports cannot be edited.

Options Report
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SUMMARY REPORT

The Summary Report for physisorption analyses provides a condensed summary of selected data
results.

In the Pore Volume group box, if Adsorption total or Desorption total is selected, the p/po field is
enabled. Enter the relative pressure used to calculate the total pore volume.

Selections Description
Item [n] [selection] Use to enable the first Pass/Fail item. Until the Summary Report is

selected, S A Single-point BET will be displayed by default. When
selected, click Pass/Fail, then select pass/fail criteria options.

Pass/Fail [n]. Click to display the Pass/Fail Options window for
selection of pass/fail criteria.

S A: Single-point BET. Use to enable Pass/Fail [n] in the Item [n]
group box.

Upper/Lower. Specify upper and lower limits for the selected
parameter. A range can be left open by not selecting the limit. In the
text box to the right of Upper / Lower, enter operator instructions to
be displayed if a failure is encountered.

Summary Report
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Selections Description
Select All / Deselect All
[button]

Selects (or deselects) all options.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Summary Report (continued)

Summary Report
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T-PLOT REPORT

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to
micropores. Matrix area (the area external to micropores) is directly determined and often proves
to be a valuable way of characterizing complex mixed materials.

Selections Description
Fitted thickness range
[text box]

Enter the minimum and maximum thicknesses (in angstroms or nano-
meters) to include in the thickness curve. Go toOptions > Units to
specify default units.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

t-Plot Report
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Selections Description
Selected Reports
[group box]

Tabular Report. Use to have a tabular report of data generated.

t-Plot. Use to have a graphical representation of data generated.
n Autoscale x-axis. The x-axis field shows the statistical thickness

of the adsorbed film.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the t-plot.

Surface area correction
factor [text box]

Enter the value to correct for surface areas that are not smooth. This
brings the values for BET surface area and micropore surface area
into accordance. For most samples, the default value of 1.000 is
adequate.

Surface Area
[group box]

Select the surface area value used for thickness calculations. BET is
the most commonly used option.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

t-Plot Report (continued)

t-Plot Report
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Selections Description
To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

t-Plot [check box] Use to have a graphical representation of data generated.

Autoscale x-axis. The x-axis field shows the statistical thickness of
the adsorbed film.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Overlay samples. Use to overlay sample files on the t-plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

t-Plot Report (continued)
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TEMKIN REPORT

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops linearly
with increasing coverage.

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Tabular Report. Generates a tabular report of the included samples
that contains the numeric values contributed by each sample.

Temkin Isotherm plot. Overlays the Temkin isotherm with the

Temkin Report

Temkin Report
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Selections Description
analysis data.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure.
n Autoscale y-axis. y-axes begin at zero. The y-axis field shows

the quantity of gas adsorbed.
n Overlay samples. Use to overlay sample files on the isotherm

plot.

Temkin Transform plot. Plots a linear form of the Temkin
transform plot.
n Autoscale x-axis. The x-axis field shows the logarithm of pres-

sure (ln).
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the transform

plot.

Specify differential heat
of adsorption
[check box]

Select and enter the differential heat of adsorption at zero surface
coverage. This allows inclusion of all Temkin constants.

Specify monolayer
capacity [check box]

Select and enter the monolayer capacity of the sample.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Temkin Report (continued)
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VALIDATION REPORT

This report allows data to be examined by the analysis program to determine if the results are
within typical ranges. If the data for any reports selected for validation are determined to be out of
range, a warning will display and suggestions are given for corrective action.

Validation Report
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9 DIAGNOSTICS
Unit [n] > Diagnostics
Use to display diagnostic readings, start and schedule diagnostic tests, and open saved
diagnostic reports. Each test generates a file to the default directory name and path of
...\...\Service\userdiag unless another directory name was specified. These reports can be sent to
a Micromeritics Service Representative for examination.

SHOW ALL READINGS
Unit [n] > Diagnostics > Show All Readings
The Show All Readings window displays the calibrated readings of all sensors in the system.

9 Diagnostics
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9 Diagnostics

START DIAGNOSTIC TEST
Unit [n] > Diagnostics > Start Diagnostic Test
Provides a method to start a diagnostic test immediately. Upon completion of the diagnostic test,
the file is saved as a .REP file which can be retrieved by going to Reports > Open Report and
selecting the report file.

Selections Description
Comments [text box] Displays comments from the selected diagnostic test.

Estimated time (min.)
[text box]

Approximate time for test completion.

File [group box] Shows a status bar of steps complete once the test begins.

Next [button] Starts the next test.

Operator [text box] Enter information to identify the person running the service test.

Repeat [button] Repeats the selected diagnostic test.

Report after test
[check box]

Automatically generates reports to the selected destination when the
test is complete.

Sequence Sequence number assigned to the test.

Start [button] Starts the diagnostic test.

Test [drop-down box] Select the diagnostic test to be performed.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Start Diagnostic Test
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10 CALIBRATION
Unit [n] > Calibrate Analysis

A calibration file was created specifically for the analyzer and included with the
accessories. It is not necessary to recalibrate the system unless it seems out of cal-
ibration.

Disabled calibration menu options can be accessed only with the assistance of an authorized
Micromeritics Service Representative. Calibrations can be saved to a file and reloaded later.

Generally, it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

10 Calibration
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10 Calibration

MATCH TRANSDUCERS
Unit [n] > Calibrate Analysis > Match Transducers

This process should not be performed when the main transducer reading is abnormal.

Use to evacuate the system and zero the pressure transducers, then adjust the scale to match
them to the manifold transducer near full scale pressure.

A blank sample tube or small plug must be installed on each selected port prior to start-
ing this process.

1. Ensure that all applicable transducers are selected.
2. Click Start. The window closes when the operation is complete.
3. ClickOK when the process is complete.
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PRESSURE OFFSET

This procedure evacuates the system and zeroes the pressure transducers. This calibration
should only be performed by qualified service personnel. In order to perform this procedure,
sample tubes must be attached to each port.

1. Install a blank sample tube or small plug on each applicable port.
2. Ensure that all applicable transducers are selected, then click Start. ClickOK when the pro-

cess is complete. The current pressure readings and operation status messages display.

SERVO VALVE
Unit [n] > Calibrate Analysis > Sample Servo
Use to calibrate the servo valve to the sample transducer. The servo valve should always be
recalibrated after a pressure calibration has been performed. The pressure transducer should be
calibrated before starting this calibration procedure.

Click Start. The window closes when the calibration is complete.

Click Cancel to stop the calibration process.

Pressure Offset
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10 Calibration

LOAD CALIBRATION FROM FILE
Unit [n] > Calibrate Analysis > Load from File
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved using Unit [n] > Calibrate
Analysis > Save to File prior to loading another calibration file. When loading a previously saved
calibration file, a backup of the current file is created and saved as [SN]last.cal. The backup file is
overwritten each time a new one is created.

Changing the calibration may affect the analyzer’s performance.

SAVE CALIBRATION TO FILE
Unit [n] > Calibrate Analysis > Save to File
Use to save the current calibration settings to a backup file which can later be reloaded using the
Unit [n] > Calibrate Analysis > Load from Filemenu option.

The default file naming convention for calibration files can be used or the file name can be
changed. The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 Analyzer serial number
2013-04-25 Date the calibration file was saved
.CAL File name extension
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DEGAS CALIBRATION
Unit [n] > Calibrate Degas
Unit [n] > Calibrate Degas > Pressure Offset
Unit [n] > Calibrate Degas > Servo Valve

Service Test Mode is required for this test. See Service Test Mode on page 11 - 28.

A calibration file was created specifically for the analyzer and included with the accessories. It is
not necessary to recalibrate the system unless it seems out of calibration.

Disabled calibration menu options can be accessed only with the assistance of an authorized
Micromeritics Service Representative. Calibrations can be saved to a file and reloaded later.

Generally it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

Degas Calibration
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11 TROUBLESHOOTING AND MAINTENANCE

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.micromeritics.com).
n Error Messages document (PDF)
n Parts and Accessories
n Vacuum Pump Guide (PDF)

Most operational problems are caused by the following:

n Leaks (commonly around the sample tube O-ring at the analysis port)
n Sample weighing errors
n Use of too much analysis bath fluid in the Dewar at the start of an analysis
n Entry of incorrect system volume for analysis

Elevator cannot be raised or lowered.

Cause: Dewar elevator stuck.

Action: Check for possible obstruction to elevator movement.

Analysis valves cannot be operated.

Cause A: Circuit opened by circuit breaker.

Action A: Reset breaker (depress Breaker button) located on the right side of the instrument
beneath the tray cover. See Analyzer Components for the ASAP 2425 Analyzer
on page 2. If the circuit breaker trips (pops out), call your Micromeritics Service
Representative.

Cause B: Cable from computer to the instrument is loose.

Action B: Ensure the cable is seated properly.

Vacuum pump gurgles continuously.

Cause A: Sample tube O-ring or fitting loose.

Action A: Tighten fitting. Replace O-ring.

11 Troubleshooting and Maintenance
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11 Troubleshooting and Maintenance

Cause B: Sample tube cracked.

Action B: Replace with new sample tube.

Cause C: No sample tube loaded on a selected port.

Action C: Install plug or empty sample tube.

Cause D: Gas inlet valve open while vacuum valve open.

Action D: Go to Unit [n] > Enable Manual Control to ensure a checkmark appears next the
Enable Manual Control. Open the schematic. Right-click on the open valve and
select Close.

Vacuum gauge shows reading above 20 mmHg, even after extended pumping through
unrestricted valve with analysis or degas ports closed.

Cause A: Vacuum pump oil is low, causing ineffective evacuation.

Action A: Add or change vacuum pump oil. Add oil to proper level according to oil level win-
dow.

Cause B: Filter in port being used is dirty.

Action B: Replace filter in port. See Replace the Analysis Port Filter on page 11 - 19.
Cause C: Leak in vacuum plumbing.

Action C: Check and tighten all connections in vacuum plumbing, including cold traps.

Cause D: Vacuum pump powered off or unplugged.

Action D: Check pump power plug and power switch.

Cause E: The alumina in the oil vapor trap is holding moisture.

Action E: Replace or dry the alumina.

Cause F: Filter in port being used is dirty.

Action F: Replace filter in the port. See Replace the Analysis Port Filter on page 11 - 19.
Cause G: Dry forepump needs to be serviced.

Action G: Replace the diaphragms.

Cause H: High vacuum pump may have timed out.

Action H: Remove the lower front panel of the analyzer and power the high vacuum pump
OFF, then back ON.

Cause I: No diaphragm in the high vacuum pump is worn or damaged.

Action I: Contact your Micromeritics Service Representative.

High vacuum pump indicator light does not illuminate.

11 - 2 ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025



Cause: No power to the high vacuum pump. Remove the lower front panel of the analyzer
and power the high vacuum pump OFF, then back ON

Action: Check for possible obstruction to elevator movement.

11 Troubleshooting and Maintenance
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11 Troubleshooting and Maintenance

GUIDELINES FOR CONNECTING GASES

Analyzer Gauge should indicate
ASAP 15 psig (103 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended pressure could cause personal injury or dam-
age the instrument.

These instructions refer to the installation of a gas line, regulator, and gas cylinder for
each type of gas used. If expansion kits or other accessories are used in the lab, spe-
cial consideration should be given to these configurations when installing the gas
lines.

Improper handling, disposal, or transportation of potentially hazardous materials can
result in serious injury or damage to the instrument. Always consult the SDS when
working with hazardous substances. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

n Ensure the gas cylinder is closed before connecting to the analyzer.
n Place gas cylinders within 6 feet (2 m) of the gas inlets of the analyzer. Place the cylinders

close enough to allow for proper connection at the analyzer inlet.

Using gas line extenders on gas cylinders located in remote areas may degrade gas quality
and reduce pressure. Long gas lines, such as those used with gas cylinders placed in remote
areas, should be purged if they are contaminated with water or particulates.

When possible, avoid placing gas cylinders in remote locations. It is always best to have gas
cylinders located near the analyzer.

n Use a retaining strap (or other appropriate tether) to secure the gas cylinder.
n Always use the gas lines provided with the analyzer. It is very important that proper gas lines

are used with the analyzer. The necessary lines are provided. They are all 6 feet (2 m). One is
used for the high pressure input, and the other two are used for the low pressure input.

n Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or
entangling gas lines. This will help avoid confusion when maintenance is required.

n Label the gas line at the analyzer inlet for proper identification and maintenance.
n Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the

pressure reads approximately 600 psig (4140 kPag) on the high-pressure gauge.
Contaminants adsorbed to the walls of the cylinder will desorb as the pressure decreases.
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n Input air must be clean, dry and filtered. If using an air compressor, a secondary air filter is
required (MIC part #710-25601-004). The air filter should be regularly checked for fluid buildup
(and drained as required), and the filter element replaced as necessary. Particulates, water
vapor and oil vapor can contaminate the instrument.

Guidelines for Connecting Gases
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11 Troubleshooting and Maintenance

REPLACE A GAS CYLINDER

Analyzer Gauge should indicate
ASAP 15 psig (103 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended pressure could cause personal injury or dam-
age the instrument.

These instructions apply to working with inert gases only. When working with
hazardous gases, follow the safety procedures established by your lab.

A. Gas tubing to instrument
B. Low pressure gauge
C. High pressure gauge
D. Regulator connecter nut
E. Gas cylinder shut-off valve
F. Regulator control knob

Disconnect a Depleted Gas Cylinder

1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-
wise.

2. Disconnect the gas line from the regulator. Gas will be vented from the line. It is not neces-
sary to disconnect the gas line from the analyzer inlet if the cylinder will be replaced imme-
diately with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gas will be
vented from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.
6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the

regulator from the cylinder.
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7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap and
move the cylinder to an appropriate location.

Replace a Gas Cylinder
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11 Troubleshooting and Maintenance

CLEAN AND VERIFY THE GAS LINE

Unit [n] > Diagnostics > Start Diagnostic Test
Always clean the gas lines and verify there are no leaks at the connections after a gas cylinder is
connected. This test examines the gas line from the analyzer to the gas cylinder, then from the
analyzer to the regulator shut-off valve. A report is generated at the completion of the test to verify
that it has passed or failed. Causes and corrective action for a failure are provided.

Confirm that the state for valves and the low pressure gauge are as follows:

A. Gas tubing to instrument
B. Gas regulator shut-off valve -

OPEN
C. Low pressure gauge - 14-15

psig
D. High pressure gauge
E. Gas cylinder shut-off valve -

CLOSED
F. Regulator connecter nut
G. Regulator control knob -

OPEN
H. Brass reducer fitting

1. Select Clean and Verify Analysis Gas Line [n] Test Rev [n] in the Test field. The length of
time a test will run is indicated on the window. The Sequence field indicates the file created
as a result of this test.

2. In theOperator field, enter either the name or initials of the operator performing this test.
3. Select the Report after test option then select Preview. Click Start.
4. From the View drop-down list, select eitherOperation, Instrument Log, or Instrument
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Schematic.
5. The following series of prompts display requiring operator response:

a. This is the gas line clean and leak check test for inlet port [n]. Inlet ports being tested
must be connected to a gas cylinder according to the user manual. A Nupro isolation
valve should be installed on the line between the analyzer and the regulator.

b. The test starts with a manual leak check (requires Snoop or equivalent, and IPA), then
the line and regulator are evacuated for 20 minutes for cleaning. Next, the leak rate of
the gas line is determined.

c. With the regulator set to 15 psig, open the cylinder, regulator shut-off valve, and isol-
ation valve. Check each joint for bubbles with Snoop or equivalent. If a joint is leaking,
attempt tightening (without over-tightening) or replace ferrules.

d. When there are no leaking joints, use IPA to remove water from each joint, then wipe
dry.

e. Close the gas cylinder valve. Leave the regulator shut-off and isolation valves open.
f. User will be needed in 30 minutes to close the isolation valve. ClickOK to begin auto-

mated testing.
6. ClickOK when the test is complete. The test reports display.

7. Click each tab across the top of the window and look for a reading of Passed. A Passed
reading indicates all valves are in a proper state for operation. If any test shows a Failed
reading, refer to the following table to help determine the location of the gas leak.

Tab Test If Failed status, then...
Gas Line to Inlet
Port [n]
Test 1

Gas Line to Gas Cylin-
der Test

This test will show a reading of Failed if any of the
other tabs has a Failed reading. Correct the
failed connection and rerun the test.

Corrective Action

Clean and Verify the Gas Line

ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025 11 - 9



11 Troubleshooting and Maintenance

Tab Test If Failed status, then...
Gas Line to Inlet
Port [n]
Test 2

Gas Line to Isolation
Valve Test

Check for a leak between the gas line and the
isolation valve. Correct the problem and rerun
the test.

Gas Line to Inlet
Port [n]
Test 3

Isolation Valve To
Cylinder Leak Rate

Check for a leak between the isolation valve and
the gas cylinder. Correct the problem and rerun
the test.

Corrective Action (continued)

If a test reports as failed, one or more valves is not in the proper position. Set the valves, then
ensure the appropriate pressure is displayed on the low pressure gauge.

If re-running the test, close the gas cylinder valve before starting the test.

1. Click Close to close the test report. Click Close again to close the test.
2. Repeat steps 1 through 8 for each gas line attached to the analyzer.

ENABLE MANUAL CONTROL
Unit [n] > Enable Manual Control

Show Analysis Schematic on page 2 - 20
Use Enable Manual Control to enable the manual control of certain system valves and pump com-
ponents on the analyzer schematic. When this option is enabled, a checkmark appears to the left
of Unit [n] > Enable Manual Control. If the analyzer schematic is not immediately visible, go to
Unit [n] > Show Instrument Schematic.
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VACUUM PUMPS
The analysis systemmay contain two oil-based pumps, two oil-free pumps, or one of each type. A
high-vacuum pump is installed for each oil-free pump.

ACCESS THE PUMPS

Component Description
A Remove 3 screws then lift panel.

B High vacuum pumps

C Oil-free (or degas) pump

D High-vacuum pump power plug and power switch

Vacuum Pumps
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11 Troubleshooting and Maintenance

HIGH VACUUM PUMPS

Power OFF High-vacuum pumps

A. Use the power switch to power OFF the pumps.

Remove High-vacuum pumps

1. Go to Unit [n] > Enable Manual Control.
2. Go to Unit [n] > Show Degas Schematic.
3. Right-click valves 15 and 13 to open.

4. Power OFF the vacuum pumps.
n For oil-based pumps, disconnect the power plug from the power source.
n For oil-free vacuum pumps, power OFF the pumps.

5. Open valves 13 and 15.
6. When the pressure stabilizes around atmospheric pressure, close valves 13 then 15. This

fills the vacuum section with the backfill gas prior to disconnecting the pump.
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OIL-BASED VACUUM PUMP

The Vacuum Pump Guide can be found on the Micromeritics web page (www.micromeritics.com).

Oil-based Vacuum Pump
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11 Troubleshooting and Maintenance

PREVENTIVE MAINTENANCE

Perform the following preventive maintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventive maintenance procedures and
calibration be performed by a Micromeritics Service Representative every 12 months.

Maintenance Required Frequency
Clean the analyzer As required or every 6 months

Lubricate elevator screw As required or every 6 months. Use a light coat
of lithium grease.

Check analysis port Dewar Weekly

Replace sample tube O-ring As required or every 3 months

Replace port filters Every 30 days

Replace diaphragm(s) in vacuum pump ** Every 12 months

Calibrate manifold temperature sensor Every 12 months

Calibrate system volume Every 12 months

Check analyzer outgassing rate Every 6 months

Test analyzer for leaks As required or every 12 months

Perform reference material analysis As required or every 3 months

** After about 12 to 18 months of operation, the diaphragm(s) in the pump will wear out and
become completely inoperable. To prevent any instrument downtime due to an inoperable
pump, it is recommended that you have the diaphragm(s) replaced by a Micromeritics Ser-
vice Representative every 12 months.
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CHECK ANALYSIS MANIFOLD OUTGAS RATE

1. Close the supply valves (Nupro valves) on the gas inlet lines.
2. Insert leak tight plugs in unused gas inlet ports.

3. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

4. Open valves 18, 8, 17, and 7.
5. Set the servo valve to dose to 1000 mmHg to ensure that it stays open.
6. Evacuate the inlet ports by opening valves 21 to 26.
7. Evacuate a minimum of 20 minutes. Overnight evacuation is preferable.
8. Close valves 8 and 18.
9. Record the pressure as the Initial Reading for Inlet Ports in the following table:

Test Initial
Reading

3 Min.
Reading

Difference Limits OK?

Inlet Ports 30 μ
(0.3 mmHg)

Valve 21 21 μ
(0.0021 mmHg)

Valve 22 21 μ
(0.0021 mmHg)

Valve 23 21 μ
(0.0021 mmHg)

Valve 24 21 μ
(0.0021 mmHg)

Valve 25 21 μ
(0.0021 mmHg)

Valve 26 21 μ
(0.0021 mmHg)

10. Wait 3 minutes, then record the pressure as the 3 Minute Reading in the table.

Check Analysis Manifold Outgas Rate
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11 Troubleshooting and Maintenance

11. Subtract the first reading from the second reading and record in the Difference column.
12. If the value in the Difference column is at or below the value in the Limits column, enter Yes

inOK? Column. If the Difference value is not below the Limits value, a gas inlet valve, inlet
plug, or gas line is leaking from atmosphere.

13. Close all gas inlet manifold valves (21 through 26).
14. Record the pressure as the Initial Reading, then begin timing as soon as the next step is

completed.
15. Gas inlet valves 21 through 26 must remain closed during this procedure. Pressurize the

inlet to valve 21 by opening the supply valve or removing the port plug. This allows gas or air
to pressurize the inlet valve above the seat.

16. After 3 minutes, record the pressure as the 3 Minute Reading. Subtract the first reading
from the second and record in the Difference column.

17. Repeat steps 14 through 16 for the inlet valves 22 through 26.

11 - 16 ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025



CHECK AND CLEAN THE DEWAR

When handling Dewars, follow the precautions outlined in Dewar Precautions on
page 6 - 1.

Always handle glass Dewars with care. Any product incorporating a vacuum is a
potential safety hazard and should be treated with caution. If in doubt, contact your
safety officer.

Ice and suspended frost particles may accumulate in the bottom of the analysis port Dewar.
Particles or deposits exceeding 1/4 in. (6 mm) in depth may jam between the bottom of the sample
tube and the bottom of the Dewar.

Accumulations of fine particles impede liquid nitrogen circulation around the bottom of the sample
tube. This causes the sample temperature to be slightly higher which, in turn, can cause pore
volume measurement errors in those samples exhibiting high isotherm slope above 0.97 relative
pressure.

Accumulated ice is likely to melt and form a pool of water in the Dewar if all liquid nitrogen
evaporates. The water must be removed, otherwise it will solidify when liquid nitrogen is added
and could press on the bottom of the sample tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the Dewar after each use.
Clean on a weekly basis.

1. Remove the Dewar from the analyzer.
2. Pour out liquid nitrogen into an appropriate cryogenic container. Do not re-use liquid nitro-

gen.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

3. Rinse the Dewar with warm water to melt any remaining ice accumulation which may
remain. Dry thoroughly.

4. Replace the Dewar.

Check and Clean the Dewar
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11 Troubleshooting and Maintenance

CLEAN THE INSTRUMENT

The exterior casing of the instrument may be cleaned using a clean, lint-free cloth dampened with
isopropyl alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type
of abrasive cleaner. It is not necessary to remove knobs, screws, etc. while cleaning.

Do not allow liquid to penetrate the casing of the instrument. Doing so could result in
damage to the unit.

Use only a mild detergent in water to clean safety shields. The use of isopropyl
alcohol can damage the shield surface.

LUBRICATE THE ELEVATOR DRIVE ASSEMBLY

The elevator screw is lubricated before it leaves the factory and should not require lubricating. If
the elevator starts to vibrate or becomes noisy when traveling, contact a Micromeritics Service
Representative for disposition.
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PORT FILTERS

Replace the Analysis Port Filter

Before replacing a port filter, ensure that the port valve is closed. Observe the ana-
lysis system schematic to verify valve status.

To avoid analysis problems, the new filter and O-ring must be clean. Wear gloves
when performing this task. Do not touch the parts with bare hands.

1. Remove the Dewar and sample tube (or plug).
2. Close the sample valve.
3. Use a wrench to remove the sample tube fitting from the analyzer.

A. Sample tube fitting
B. O-ring
C. Filter

4. Remove and replace the filter and O-ring. If the O-ring and filter are stuck in the port, use a
fingernail or plastic instrument to remove them. Using a metal instrument may scratch the
sealing surface, causing a leak.

5. Reinstall the analysis port fitting. Securely tighten with a wrench to prevent leaks during
evacuation.

Replace Degas Port Filter

To avoid degassing problems, the new filter and O-ring must be clean. Do not touch
them with bare hands.

Port Filters
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11 Troubleshooting and Maintenance

1. Use a wrench to remove the degas port fitting, filter, and O-ring.
2. Replace the filter and the O-ring.
3. Carefully reassemble the sample tube fitting, filter, O-ring, and manifold connector. Hand

tighten, then tighten with a wrench.

11 - 20 ASAP 2425 Operator Manual
242-42807-01 (Rev B) —Mar 2025



REPLACE THE PSAT TUBE O-RING

A. Connector nut
B. Psat port
C. O-ring
D. P0 tube with isothermal jacket

1. Turn the connector nut counter-clockwise to loosen.
2. Pull the connector nut downward.
3. Gently pull the Psat tube downward to remove it from the Psat port.
4. Remove the O-ring from the Psat tube and replace with a new one.
5. Insert the Psat tube into the Psat port.
6. Slide the connector nut up to the Psat port and turn the connector nut clockwise to tighten.

Replace the Psat Tube O-ring
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11 Troubleshooting and Maintenance

REPLACE THE SAMPLE TUBE O-RING

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring
becomes worn or cracked, it does not provide a good seal and will need to be replaced.

A. Connector nut
B. Ferrule
C. O-ring
D. Sample tube fitting
E. Seal Frit and opener

Before removing (or installing) a sample tube, ensure that the port valve is closed.
Observe the analyzer schematic to verify valve status.

1. Carefully remove the Dewar from the elevator. Take care not to bump the sample tube
bulbs with the Dewar during this process. Place the Dewar aside.

2. Hold the sample tube firmly with one hand and loosen the sample tube connector nut by
turning counter-clockwise.

Do not allow the sample tube connector nut to drop onto the sample tube bulb as it
may break the tube.
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3. Carefully pull the sample tube down until it is free from the port. It may be necessary to
grasp the sample tube with both hands.

4. Remove the O-ring from the top of the sample tube and replace it with a new one.

A. O-ring
B. Ferrule
C. Connector nut

If the O-ring remains inside the sample port, use a pair of tweezers or needle-nose pli-
ers to remove it.

5. While holding the connector nut in place, slide a new O-ring over the sample tube, about
1/4 in. from the top of the tube.

A. Isothermal jacket
B. Connector nut
C. Ferrule
D. O-ring (1/4 in. from top of sample tube)

6. After the new O-ring is in place, insert the sample tube back into the sample port until it is
fully seated.

Replace the Sample Tube O-ring
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11 Troubleshooting and Maintenance

7. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting
(the ferrule and O-ring will move along with the connector nut). Then, turning clockwise,
hand tighten the connector nut to the sample connector.
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POWER INSTRUMENT ON AND OFF

Do not connect or disconnect cables when the instrument is powered ON.

Power ON the equipment in the following order:

1. Computer, monitor, and printer.
2. Analyzer.
3. External vacuum pump (the pump must warm approximately two hours before performing

analyses).

Power OFF the equipment in the following order

1. Exit the analysis program. Failure to do so could result in loss of data. If an analysis is in pro-
gress when closing the application, the following message is displayed:

2459 - An Instrument is busy. A delay in restarting this application
could result in loss of new data. Continue program exit? Yes / No

Yes. Closes the program. The analysis continues and data continue to be collected. The
data will be restored when the application is restarted. Reports queued in the print
manager will print. If a power failure occurs and an uninterruptible power supply (UPS) is
not attached to the analyzer, the data collected after exiting the analysis program are lost.

No. The program remains open, and the analysis continues to run.

2. Computer, monitor, and printer.
3. Analyzer.
4. External pump.

Power Instrument On and Off
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11 Troubleshooting and Maintenance

PERFORM A LEAK TEST
AMicromeritics Service Representative may request that a leak test be performed to determine if
there is a system leak and may also require a copy of the report generated by this test.

The test provides:

n Prompts on preparing the analyzer for the test.
n Approximate time period of the test.
n Prompts in which an operator response is required.

1. Select the test to run.
2. Select Report After Test and choose Preview as the destination.
3. Click Start.
4. Verify all tests have a Passed status by selecting the tabs and looking for the Passed status

for each test run.
5. Click Save As to save the test file results.
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A. Suspend/Resume/
Skip/Play buttons

B. Port report buttons
C. Live graph settings

Perform a Leak Test
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11 Troubleshooting and Maintenance

POWER

The ASAP 2425 is designed to operate with 100/115/230 VAC (± 10%) at 50/60 Hz. Noise-free
power of the correct voltage and frequency, with a safety earth ground, should be available
through a standard wall receptacle.These requirements can be checked by using a circuit
analyzer or a multimeter. Ensure the unit is connected by a three-wire cable with a protection wire
(PE), and that the PE wire is reliably grounded.

Do not connect the ASAP 2425 to the power source until the proper voltage selection is made.
Doing so could result in electrical shock and/or damage to the assembly.

The analyzer and peripheral devicesmust be installed on their own dedicated power
line. Other devices— such as motors, generators, or ovens— should not be placed
on the same power line.

Replacement power supply cords must be rated for the specifications stated above.

The instrument should be placed so that the power switch and jack are easily
accessible. It should not be necessary to move the instrument to make a power
connection. The wall outlet should not be blocked, and there should be sufficient
space around the outlet and in the immediate area so the instrument can establish a
safe and secure power connection and is easily accessible to disconnect the
equipment from the ACmain power supply.

RECOVER FROM A POWER FAILURE
The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progress when
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected
during the analysis will still be present, but the analysis should be restarted in order to produce
complete results.

SERVICE TEST MODE

Options > Service Test Mode

Service Test Mode is a password protected option used to perform certain service tests with the
assistance of a trained Micromeritics Service Representative. This password is supplied by your
Micromeritics Service Representative.

If a menu item is grayed out, it is usually an indication that Service Test Mode is required.
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To exit Service Test Mode, go toOptions > Service Test Mode and deselect the Service Test
Mode option or close the application.

Service Test Mode
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A ADVANCED REPORTS - PYTHON MODULE

The mic Python module is automatically imported when running a user supplied script. The
module provides access to primary and overlay isotherm data and provides support for summary,
tabular, and graphical reports.

n Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

n Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with themic.table call.

n Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.

ADVANCED REPORTS
Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. SeeMicModule Python Calls on page A - 17 for an
example of a Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.
2. Open a sample file with a Complete status.
3. Select Advanced in the view selector drop-down list at the bottom of the window to return to

the tabbed view.
4. On the Report Options tab, select Advanced in the Selected Reports list box, then click

Edit.
5. On the Advanced Report Options window, click Add in the Available Scripts group box to

locate and select the Python script. Repeat for each script to be added.

A Advanced Reports - Python Module
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A Advanced Reports - Python Module

6. In the Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. Click Pressures to add pressure points to the report. ClickOK to return to the Report
Options tab.

8. Select theOverlay samples checkbox to enable the overlay sample feature.
9. On the Report Options tab, click Preview. The Python Reports will be included on the tabs

across the top portion of the Reports window.

Selections Description
Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace,
edit, or remove reports.

Overlay samples (if
shown) [check box]

Use to overlay samples as defined by the function.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 2.

Advanced Reports
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SCRIPTS

Run a Script

1. Open a sample file with a Complete file status.
2. Select Advanced in the view selector drop-down list at the bottom of the window.
3. Select the Report Options tab.
4. Highlight Advanced in the Selected Reports list box, then click Edit.
5. On the Advanced Report Options window, click Add.
6. Select one or more python scripts then click Select. The selected scripts become a part of

the drop-down list in the Available Scripts section of the Advanced Report Options window.
7. In the Select Reports section, select up to five Advanced reports in the drop-down lists.
8. ClickOK.
9. Click Preview on the Report Options tab to view all reports selected in the previous window.

Remove a Script

Select the script in the Available Scripts box then click Remove. The script is removed from the
application however, the original .py text file is not affected.

Edit a Script

Selections Description
Add [button] Adds one or more scripts to the Available Scripts box. The added

scripts then become available as options in the Selected Reports
section.

Edit [button] Edits the script stored within the application but does not affect the
original .py text file.

Overlay samples
[check box]

Select to enable the overlay sample files process.

Pressures [button] Select to include or exclude pressures from the report.

n Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

n Cancel. Discards any changes or cancels the current process.
n Exclude All. Select to exclude all pressure points in the table.
n Include All. Select to include all pressure points in the table.
n OK. Saves and closes the active window.

Remove [button] Removes the script from the Available Scripts box but does not affect
original .py text file.

Scripts
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A Advanced Reports - Python Module

Selections Description
Replace [button] Replaces the contents of the selected script however, the script

name remains the same.
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PYTHON REPORTS

Graphic Report

This script is an example of the mic module producing a graph with two curves:

1 import mic
2 import numpy as np
3
4 mic.graph( 'My Graph', 'X', 'F(X)' )
5 myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 ]

)
6 mic.graph.add( 'X2', myx, myx*myx, marker='o' )
7 mic.graph.add( 'sin(X)', myx, np.sin(myx), marker='^' )

The results are:

Python Reports
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A Advanced Reports - Python Module

Summary Report

This script produces a summary report with two summaries:

1 import mic
2 import numpy as np
3
4 mic.summary( "My Summaries" )
5 mic.summary.add( "Summary A",
6 ["Label 1:", "Label 2:", "Label 3:"],
7 ["val1", "val2", "val3"] )
8 mic.summary.add( "Summary B",
9 ["Label 4:", "Label 5:", "Label 6:"],
10 ["val4", "val5", "val6"] )

The result is:
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Tabular Report

If more than one column is required, the callmic.table is employed. This script produces a tabular
report consisting of two tables.

This script uses the Python package numpy and c-style formatting of the numerical
values.

11 import mic
12 import numpy as np
13
14 mic.table( "My Tables" )
15 mic.table.addtable( "My Set A" )
16 mic.table.addcolumn( "X", ["1.0", "2.0", "3.0"] )
17 mic.table.addcolumn( "Y", ["0.5", "1.0", "1.5"] )
18 x1 = 0.2
19 x2 = 0.5
20 x3 = 3.14159/2
21 mic.table.addtable( "My Set B" )
22 mic.table.addcolumn( "X", ['{:8.3f}'.format(x1),
23 '{:8.3f}'.format(x2),
24 '{:8.3f}'.format(x3)] )
25 mic.table.addcolumn( "sin(X)", ['{:8.3f}'.format(np.sin(x1)),
26 '{:8.3f}'.format(np.sin(x2)),
27 '{:8.3f}'.format(np.sin(x3))] )
28 mic.table.addcolumn( "cos(X)", ['{:8.3f}'.format(np.cos(x1)),
29 '{:8.3f}'.format(np.cos(x2)),
30 '{:8.3f}'.format(np.cos(x3))] )

Python Reports
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A Advanced Reports - Python Module

The result is:
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ACQUIRE BASIC INFORMATION

To acquire the adsorption isotherm and other basic information about the sample being edited, the
callsmic.isotherm,mic.sample_information, andmic.adsorptive_data are applied.

This script produces a graph of the adsorption and desorption isotherms for both relative and
absolute pressure, and prints summaries of the sample information and the adsorptive properties.

1 import mic
2
3 prel, qads, n_ads, warm_fs, cold_fs, mass, desc = mic.isotherm

('rel')
4 mic.graph( 'Graphical Report 1', 'Relative Pressure (P/Po)', 'Quant-

ity Adsorbed (cm³/g STP)' )
5 mic.graph.add( 'Sample Isotherm', prel, qads )
6
7 pabs, qads, n_ads, warm_fs, cold_fs, mass, desc = mic.isotherm

('abs')
8 mic.graph( 'Graphical Report 2', 'Absolute Pressure (mmHg)', 'Quant-

ity Adsorbed (cm³/g STP)' )
9 mic.graph.add( 'Sample Isotherm', pabs, qads )

10
11 mass = mic.sample_information('sample mass')
12 Tanl = mic.sample_information('analysis temperature')
13 dens = mic.sample_information('sample density')
14
15 mic.summary( "Sample Information" )
16 mic.summary.add( "Sample Information",
17 [ "Number of adsorption points:",
18 "Warm free space:",
19 "Cold free space:",
20 "Sample mass:",
21 "Description:",
22 "Analysis temperature:",
23 "Sample density:" ],

Acquire Basic Information
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A Advanced Reports - Python Module

24 [ '{:d}'.format(n_ads),
25 '{:8.3f}'.format(warm_fs) + ' cm³',
26 '{:8.3f}'.format(cold_fs) + ' cm³',
27 '{:8.3f}'.format(mass) + ' g',
28                    desc,
29 '{:8.3f}'.format(Tanl) + ' K',
30 '{:8.3f}'.format(dens) + ' g/cm³' ] )
31
32 csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
33
34 mic.summary.add( "Adsorptive Data",
35 [ "Cross sectional area:",
36 "Hard sphere diameter:",
37 "Density conversion factor:",
38 "Molecular weight:",
39 "Analysis gas:" ],
40 [ '{:8.3f}'.format(csa) + ' nm²',
41 '{:8.3f}'.format(hsd) + ' Å',
42 '{:8.3f}'.format(dcf),
43 '{:8.3f}'.format(mol_weight),
44                    analysis_gas ] )

Note the calls tomic.isotherm andmic.adsorptive_data above are each returning results as a list
with elements of varying return type.
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ACQUIRE REPORT RESULTS

Sample file report results may be accessed using themic.report call. This script prints a summary
of the results of the t-plot and BET reports.

1 import mic
2
3 sa  = mic.report("bet", "surface area")
4 c   = mic.report("bet", "bet constant")
5 vm  = mic.report("bet", "monolayer capacity")
6 esa = mic.report("tplot", "external surface area")
7 vol = mic.report("tplot", "micropore volume")
8
9 mic.summary( "BET and T-plot Results" )
10
11 mic.summary.add( "Report Results",
12 [ "BET surface area:",
13 "BET constant:",
14 "BET monolayer capacity:",
15 "T-plot external surface area:",
16 "T-plot micropore volume:" ],
17 [ '{:10.5f}'.format(sa) + ' m²/g',
18 '{:10.5f}'.format(c),
19 '{:10.5f}'.format(vm) + ' cm³/g',
20 '{:10.5f}'.format(esa) + ' m²/g',
21 '{:10.5f}'.format(vol) + ' cm³/g' ] )

The result is:

Acquire Report Results
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A Advanced Reports - Python Module

Acquiring the results from a pore-distribution report such as the BJH method is done in a similar
way as in the previous script except the return values from themic.report call are slightly different
since they involve lists of data. For example:

1 import mic
2 import numpy as np
3
4 xdat, ydat, desc = mic.report( 'bjhads', 'incremental distribution'

)
5 if not (np.isnan(xdat[0]) or np.isnan(ydat[0])): # NaN indicates BJH

calculation error.
6     mic.graph( 'BJH Adsorption/Desorption', 'Pore Diameter (Å)',

'Incremental Volume (cm³/g)' )
7     mic.graph.add( desc, xdat, ydat )
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The result is:

Acquire Report Results
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ACQUIRE OVERLAY SAMPLE DATA

The call to obtain overlay sample data is similar to the calls for the primary sample. This script
involves two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file usingmic.report
andmic.adsorptive_data have a very similar interface as themic.overlay call, and a summary of
their usage is shown in the example in this topic.

1 import mic
2
3 p, q, n, fsw, fsc, mass, desc = mic.isotherm('rel')
4 p1, q1, n1, fsw1, fsc1, mass1, desc1 = mic.overlay( 1, 'rel')
5 p2, q2, n2, fsw2, fsc2, mass2, desc2 = mic.overlay( 2, 'rel')
6
7 mic.graph( 'Three Sample Isotherms', 
8 'Relative Pressure (P/Po)',
9 'Quantity Adsorbed (cm³/g STP)' )
10
11 mic.graph.add( 'Primary Isotherm', p, q )
12 mic.graph.add( 'Overlay Isotherm 1', p1, q1 )
13 mic.graph.add( 'Overlay Isotherm 2', p2, q2 )
14
15 mic.summary( "A Summary Report" )
16
17 mic.summary.add( "Two samples",
18 [ "Primary sample:",
19 "Overlay sample 1:",
20 "Overlay sample 2:" ],
21 [ desc, 
22                    desc1, 
23                    desc2 ] )
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The results are:

To enable the use of overlay data in the Advanced reports, the following two actions must be
taken prior to running the script:

n Sample files to overlay must be selected, and
n TheOverlay samples checkbox on the Advanced Report Options window must be selected.

Acquire Overlay Sample Data
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ENABLE THE USE OF OVERLAY DATA

1. On the Report Options tab, clickOverlays.
2. On the Plot Overlay Sample Selection window, to move a file from the Available Files list

box to the Selected Files list box, either double-click a file name in the Available Files list
box or click one or more files in the Available Files list box then click Add.

3. ClickOK.
4. On the Report Options tab, highlight Advanced in the Selected Reports list box.
5. Click Edit.
6. Select theOverlay samples checkbox to the right of the selected report.
7. ClickOK.
8. Run the script using the instructions found in Scripts on page A - 3.
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MICMODULE PYTHON CALLS

Tables

Available Mic Python calls for tables:

n Create a new tabular report
n Add a column
n Add a table

Add a Table

This script adds a table to the last created tabular report:

1 mic.table.addtable( name )
2
3 Keyword arguments:
4
5   name --- the table name

Add a Column

This script adds a column to the last created table:

1 mic.table.addcolumn(header, values, align='r'):
2
3 Keyword arguments:
4
5   header --- column header; must be a string (or convertible)
6   values --- column values; must be a list of strings (or con-

vertible)
7   align  --- column alignment; 'r', 'l', 'c' for right, left, and

center justified

MicModule Python Calls
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Create a New Tabular Report

1 mic.table( title='User Table' )
2
3 Keyword arguments:
4
5   title --- the tabular report title (default = 'User Table')
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Summary Reports

Add a Summary Section

This script adds a summary section to the last created summary report:

1 mic.summary.add(name, labels, values):
2
3 Keyword arguments:
4
5   name   --- summary section name
6   labels --- column of labels; must be a list of strings
7 (or convertible) and the same length as values
8   values --- column of values; must be a list of strings
9 (or convertible) and the same length as labels

Create a New Summary Report

1 mic.summary( title='User Summary' )
2
3 Keyword arguments:
4
5   title --- the summary title

MicModule Python Calls
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Graphic Reports

Add a Curve

This script adds a curve to the last created graphical report:

1 mic.graph.add(name, x, y, yyaxis=False, color=None, linestyle='-',
2               marker='a', graphtype='both', interpolation='akima'):
3
4 Keyword arguments:
5
6   name      --- the curve name
7   x         --- list of x values; must be a list of floats
8 (or convertible) and the same length as y
9   y         --- list of y values; must be a list of floats

10 (or convertible) and the same length as x
11   yyaxis    --- place this curve on the yy-axis if True
12                 otherwise place on the y-axis (default = False)
13   color     --- RGB color as an HTML hex string (e.g., '#4169e1')
14 or a three-element list or tuple (e.g.,

[65,105,225]);
15 if None, color is automatically selected (default =

None)
16   linestyle --- line style; (default = '-')
17 '-'        : solid
18 '--'       : dash
19 '.'        : dot
20 '-.'       : dash dot
21 '-..'      : dash dot dot
22   marker    --- marker shape; (default = 'a')
23 '+'        : plus
24 'o' or '0' : circle
25 'x'        : cross
26 '^'        : up triangle
27 'v'        : down triangle
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28 's'        : square
29 'd'        : diamond
30 '8'        : hourglass
31 '~'        : horizontal hourglass
32 '' or None : no marker
33 'a'        : automatically selected
34   graphtype --- graph type; (default = 'both')
35 'curve' or 'c' : curve
36 'points' or 'p' : points
37 'both' or 'b' : curve-and-points
38 'hist' or 'h' : histogram
39   interpolation -- linear or akima spline interpolation

(default='akima')
40 'akima' use akima spline
41 'linear' use linear interpolation

Add a Curve Using the Second Y-Axis

This script adds a curve to the last created graphical report using the second y-axis:

1 mic.graph.addyy(name, xx, yy):
2
3 Add a curve to the last created graphical report using the second
4 y-axis. The arguments to this call are the same as to mic.-

graph.add.

MicModule Python Calls
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Create a New Graphical Report

1 mic.graph(title='User Graph', xlabel='X axis', ylabel='Y axis',
2           yylabel='YY axis',
3           xlinear=True, ylinear=True, yylinear=True,
4           xinvert=False, yinvert=False, yyinvert=False,
5           xrange=None, yrange=None, yyrange=None, xbars_id=''):
6
7 Keyword arguments:
8
9   title    --- the graphical report title (default = 'User Graph')
10   xlabel   --- x-axis label (default = 'X axis')
11   ylabel   --- y-axis label (default = 'Y axis')
12   yylabel  --- yy-axis label (default = 'YY axis')
13   xlinear  --- x-axis linear scale; if false, use log scale
14 (default = True)
15   ylinear  --- y-axis linear scale; if false, use log scale
16 (default = True)
17   yylinear --- yy-axis linear scale; if false, use log scale
18 (default = True)
19   xinvert  --- Invert x-axis if true (default = False)
20   yinvert  --- Invert y-axis if true (default = False)
21   yyinvert --- Invert yy-axis if true (default = False)
22   xrange   --- None, or two values giving the min and max
23                range of the axis.
24   yrange   --- None, or two values giving the min and max
25                range of the axis.
26   yyrange  --- None, or two values giving the min and max
27                range of the axis.
28   xbars_id --- None, or the id of an xbar control created
29                via the mic.control() object
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Get Primary Isotherm Data

1 mic.isotherm(press_type='rel', sample_number=0, item=''):
2
3 Get isotherm data.
4
5 Keyword arguments:
6
7   press_type    --- the pressure basis; use 'rel' for relative pres-

sure,
8 'abs' for absolute (default = 'rel'). This is

ignored
9 if the 'item' argument is also used.
10
11   sample_number --- Sample to retrieve
12 0           : current sample file (default)
13 1 through 8 : corresponding overlay sample file
14
15   item          --- string identifying the item to be returned.
16                     For example; 'absolute pressure', or 'quantity

adsorbed'
17                     The default is an empty string for which the

return
18                     value is the below list of quantities
19
20 Usage for specified item:
21   prel = mic.isotherm(sample_number=0, item='relative pressure')
22
23 Usage with tuple returned:
24   p, qads, n_ads, warm_fs, cold_fs, mass, desc = mic.isotherm

('rel')
25
26   p       --- array of pressure (relative or absolute)
27   qads    --- array of cumulative quantity adsorbed
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A Advanced Reports - Python Module

28   num_ads --- number of points in the adsorption curve
29   warm_fs --- warm free-space
30   cold_fs --- cold free-space
31   mass    --- sample mass
32   desc    --- sample description
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Get Overlay Isotherm Data

1 mic.overlay(overlay_number=1, press_type='rel'):
2
3 Get overlay isotherm data.
4
5 Keyword arguments:
6
7   overlay_number --- the overlay number (1 through 8; default = 1)
8   press_type     --- the pressure basis; use 'rel' for relative

pressure,
9 'abs' for absolute (default = 'rel')

10
11 Usage:
12
13   p, qads, num_ads, warm_fs, cold_fs, mass, desc = mic.overlay(1,

'rel')
14
15   p       --- array of pressure (relative or absolute);
16               empty-array if overlay is unavailable
17   qads    --- array of cumulative quantity adsorbed;
18               empty-array if overlay is unavailable
19   num_ads --- number of points in the adsorption curve;
20 0 if overlay is unavailable
21   warm_fs --- warm (ambient) free-space; 0.0 if overlay is unavail-

able
22   cold_fs --- cold (analysis) free-space; 0.0 if overlay is unavail-

able
23   mass    --- sample mass; 0.0 if overlay is unavailable
24   desc    --- sample description; empty-string if
25               overlay is unavailable
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Get Adsorptive Data for Each Sample

1 mic.adsorptive_data(sample_number=0):
2
3 Get adsorptive data for each sample
4
5 Keyword arguments:
6
7   sample_number --- Identifier for the adsorptive data to retrieve
8 0           : current sample file (default)
9 1 through 8 : corresponding overlay sample

file
10
11 Usage:
12
13   csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
14   csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data(0)
15
16   csa          --- cross sectional area (nm^2)
17   hsd          --- hard sphere diameter (angstroms)
18   dcf          --- density conversion factor (dimensionless)
19   mol_weight   --- molecular weight
20   analysis_gas --- mnemonic for the analysis gas species
21 (e.g., 'CO', 'H2')
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Get Sample Information Item

1 mic.sample_information( item, sample_number = 0 ):
2
3 Keyword arguments:
4
5   item          --- string identifying the item to be returned.
6                     For example; 'sample mass', or 'sample descrip-

tion'
7                     The default is an empty string for which the

return
8                     value is a list of all available keywords
9

10   sample_number --- Sample to retrieve
11 0           : current sample file (default)
12 1 through 8 : corresponding overlay sample file
13
14 Usage:
15
16   all_keywords = sample_information()
17   mass         = sample_information('sample mass')
18   mass         = sample_information('sample mass',0)
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Get Report Results

This script gets report results for the indicted report and sample:

1 mic.report(report_name='', result='', sample_number=0):
2
3 Get report results for the indicated report and sample
4
5 Keyword arguments:
6
7   sample_number --- Identifier for the sample data to retrieve.
8 0           : current sample file (default)
9 1 through 8 : corresponding overlay sample file

10
11 Usage:
12
13   sa                  = mic.report('bet', 'surface area')
14
15   porew, incvol, desc = mic.report('bjhads',
16 'incremental distribution')
17
18 The available report keywords, result keywords and a corresponding
19 description of the result is listed in the table below
20
21    Report        Result                   Description
22 -----------   --------------              -----------
23     bet        surface area               Surface area (m^2/g)
24     bet        bet constant               BET constant (dimen-

sionless)
25     bet        monolayer capacity         Monolayer capacity

(cm^3/g)
26     tplot      external surface area      External surface area

(m^2/g)
27     tplot      micropore volume           Micropore volume (cm^3/g)
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28     bjhads     incremental distribution   Incremental Distribution
29     bjhdes     incremental distribution   Incremental Distribution
30     dhads      incremental distribution   Incremental Distribution
31     hk         incremental distribution   Incremental Distribution
32     dft        incremental distribution   Incremental Distribution
33     nldft      incremental distribution   Incremental Distribution
34
35
36   where the incremental pore distribution result above (for those
37   reports which return this) is a list with three components being,
38
39   porew  --- array of pore dimension boundaries (angstroms);
40              empty-array if unavailable.
41   incvol --- array of incremental pore volumes (cm^3/g);
42              empty-array if unavailable.
43   desc   --- Name of data set; empty-string if unavailable.
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Get Imported Pore Data

1 mic.imported_pore_data(import_number=1):
2
3 Get imported pore data.
4
5 Keyword arguments:
6
7   import_number --- the import number (1 through 8)
8
9 Usage:
10
11   porew, incvol, desc = mic.imported_pore_data(1)
12
13   porew  --- array of pore dimension boundaries (angstroms);
14              empty-array if unavailable.
15   incvol --- array of incremental pore volumes (cm^3/g);
16              empty-array if unavailable.
17   desc   --- Name of data set; empty-string if unavailable.
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B DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In the
experimental physical sciences, theories are often expressed in terms of a model that can be
visualized and described mathematically. Early models of physisorption were quite simple, both
conceptually and mathematically. For very practical reasons, hand computations were required.
Today we can explore complex models that describe adsorption systems on the atomic scale of
size and sub-picosecond time frame. This is not because scientists are smarter, but because of
available tools. The DFT models are created by classical approaches to adsorption as well as
models based on modern statistical thermodynamics.

MODELS BASED ON STATISTICAL THERMODYNAMICS
Included in this group are methods that model the adsorption system in terms of forces acting
between individual molecules.

THEORETICAL BACKGROUND
Traditional adsorption theories attempt to describe experimental adsorption isotherms with an
isotherm equation containing a small number of parameters. At a minimum, these parameters
include the extent of the surface, such as the monolayer capacity (Qm), and the molar intensity of
the gas-surface interaction, such as the Langmuir “K” constant or the BET “C” constant. In some
equations, additional parameters take into account the lateral interaction of adsorbed molecules
with each other. Other theories, such as the Dubinin-Astakhov approach, also include parameters
for the effect of adsorbent porosity.

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based
statistical thermodynamic theory that allows us to relate the adsorption isotherm to the
microscopic properties of the system: the fluid-fluid and fluid-solid interaction energy parameters,
the pore size, the pore geometry, and the temperature.

The following example is provided to understand how such a theory is constructed:

A clean sample of a solid material containing slit-shaped pores of a single width is placed in an
evacuated space. It is kept at a fixed temperature as a known quantity of pure argon gas is
admitted into the space surrounding the sample. The pressure within the space is recorded
over time. In this situation, the pressure falls rapidly from its initial value and gradually
approaches a steady reading, called the equilibrium pressure. The amount adsorbed
corresponds to the quantity of gas effectively removed from the gas phase by the solid
surface. A graph that plots amount adsorbed versus equilibrium pressure is called an
adsorption isotherm.
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B DFT Models

Under such conditions, the argon atoms that randomly enter the pore space feel the presence
of the solid surface as the action of an external attractive force (the dispersion forces or Van
der Waal’s forces) and spend more time near the surface. As a result, the space near the
surface acquires a greater average density of argon atoms than regions farther removed.

If the equilibrium distribution of the gas atoms near the surface could be described as a
function of pressure and the molecular properties of the components of the system, then a
model could be constructed for the adsorption isotherm for the system. Modern physical
chemistry provides several ways to calculate this distribution. All these methods are based on
the fundamental thermodynamic law that such a system adopts a configuration of minimum
free energy at equilibrium. Also needed is a description of the pairwise interaction energy
between atoms, U(s), commonly given by a Lennard-Jones potential:

where

ε = a characteristic energy of the adsorptive,
σ = the diameter of the adsorptive molecule, and
s = the separation distance.

MOLECULAR SIMULATION METHODS

Two simulation techniques are commonly used to determine the distribution of gas molecules in a
system in equilibrium: the molecular dynamics method and the Monte Carlo method. Both of these
are used as reference methods because their results are considered exact.

MOLECULAR DYNAMICS METHOD

In the molecular dynamics method, the position and velocity of individual gas particles are
calculated over time at very short intervals. This method takes into account both the forces acting
between the gas particles themselves and those acting between the gas particles and the atoms
of the simulated surface. As the simulated particles collide with each other and with the surface,
the average concentration of particles in the space near the surface is calculated; this calculation
yields the amount of gas adsorbed.

This method can be thought of as a way to determine the chronological record of the movement of
each particle in the system using time steps of 10-14 seconds. Although the mathematics are
simple, the number of calculations required for a system of even a few hundred particles is
astronomical and challenges even the fastest computers.
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MONTE CARLO METHOD

In the Monte Carlo method, determination of the system equilibrium distribution begins with an
assumption (which may be only approximate) about the initial configuration of particles in the
system. The system is “equilibrated” through a process of randomly selecting one particle and
conditionally moving it a random distance in a random direction.

If the move results in a configuration of lower total energy, then the move is completed and
another particle is randomly selected to be moved.

If the move results in a configuration of higher energy, a probability for that event is calculated,
and a random number between zero and one is generated. If the generated number is smaller
than the probability of the event, then the move is accepted; otherwise, another particle is selected
and the process is repeated. This process continues until the average total energy of the system
no longer decreases; at this point, average configuration data are accumulated to yield the mean
density distribution of particles in the system.

Monte Carlo simulations require considerably less computation time than molecular dynamic
simulations and can yield the same results; however, neither method provides a really practical
way to calculate complete isotherms.

DENSITY FUNCTIONAL FORMULATION
Density functional theory offers a practical alternative to both molecular dynamic and Monte Carlo
simulations. When compared to reference methods based on molecular simulation, this theory
provides an accurate method of describing inhomogeneous systems yet requires fewer
calculations. Because the density functional theory provides accuracy and a reduced number of
calculations, it is the basis embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls separated
by a distance H. The pore is open and immersed in a single component fluid (adsorptive) at a fixed
temperature and pressure. Under such conditions, the fluid responds to the walls and reaches an
equilibrium distribution. In this condition (by the definition of equilibrium), the chemical potential at
every point equals the chemical potential of the bulk fluid. The bulk fluid is a homogenous system
of constant density; its chemical potential1 ) is determined by the pressure of the system using
well-known equations. The fluid near the walls is not of constant density; its chemical potential is
composed of several position-dependent contributions that must total at every point to the same
value as the chemical potential of the bulk fluid.

1 ) Chemical potential may be thought of as the energy change felt by a probe particle when it is
inserted into the system from a reference point outside the system. It can also be defined as the
partial derivative of the grand potential energy with respect to density (or concentration).
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As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free energy,
known thermodynamically as the grand potential energy (GPE). Density functional theory
describes the thermodynamic grand potential as a functional of the single-particle density
distribution; therefore, calculating the density profile that minimizes the GPE yields the equilibrium
density profile. The calculation method requires the solution of a system of complex integral
equations that are implicit functions of the density vector. Since analytic solutions are not possible,
the problemmust be solved using iterative numerical methods. Although calculations using these
methods still require supercomputing speed, the calculation of many isotherm pressure points for
a wide range of pore sizes is a feasible task. The complete details of the theory and the
mathematics can be found in the papers listed under DFT Model References on page B - 17.

The following graphs and accompanying text illustrate the results of using density functional
theory to predict the behavior of a model system.

Figure 1 shows the density profile for argon at a carbon surface as calculated by density functional
theory for a temperature of 87.3 K and a relative pressure of about 0.5.

Figure 1

Density Profile for Argon on Carbon at
87.3 K and a Relative Pressure of 0.5

This figure represents a cross-section of the region near the surface. Note the layerwise
distribution of adsorbate; the first monolayer is sharply defined and a third layer can be
distinguished. The area under the profile curve represents the amount adsorbed per unit area at
this pressure. The positions of the maxima are separated by a distance determined by the size of
the adsorptive atom.
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Given the density profile, the amount adsorbed at the stated pressure can be easily calculated as
the integral over the profile. Repeating this calculation over a range of pressures yields the
adsorption isotherm for the model. If the value of H is very large, the isotherm obtained
corresponds to that of an external, or free, surface. If H is smaller, a range of pressures is reached
where two minima exist for the grand potential, showing the presence of two metastable phases
having different density distributions but the same chemical potential. The phase with the lower
GPE is the stable one. As the pressure is increased, a point is reached where the other phase
becomes the stable one. This phase transition reflects condensation of adsorbate in the pore; the
pressure at which it occurs is called the critical pore-filling pressure. This pressure is analogous to
the condensation pressure predicted by the Kelvin equation in the classical model of pore filling.

Figure 2 shows how the profiles change with pressure for a model pore with H = 40 angstroms.
The inset shows the density profiles for the corresponding points of the isotherm.

Figure 2

Model Isotherm for Argon at 87.3 K in a
40 Å Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half of the
distribution is a mirror image of the profile shown.

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position close
to the surface.

n Inset a shows the profile corresponding to point a on the isotherm where the surface is about
half covered.

n At point b, the first layer is so full that it is more favorable for atoms to start a new layer.
n At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling pressure. In

inset c, the profile shows the density decreasing to near zero (actually the bulk gas density) at 4
or 5 molecular diameters from the surface.

n Inset d shows the profile converging on a density similar to that of bulk liquid argon in the center
of the pore, indicating a phase transition.
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Note that the adsorption isotherms for pores larger than the one shown in the previous graph is
identical up to point c. The lower branch of the isotherm simply continues to a higher pressure for
larger pores. This trend is illustrated in the Figure 3, where isotherms for some larger size pores
are shown. It is clear that pore size is uniquely characterized by a corresponding critical pore-
filling pressure. At large pore sizes, density functional theory produces results for the critical filling
pressures that are in good agreement with those produced by the Kelvin equation.

Figure 3

Model Isotherms for Some Larger Pore
Widths Argon on Carbon at 87.3 K

Figure 4 shows model isotherms for pores in the micropore size range. Note the logarithmic scale
for pressure.

Figure

Model Isotherms in the Micropore Size
Range of Pore Width Argon on Carbon
at 87.3 K
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Pores of 4 Å width, barely larger than the argon atom (3.38 Å), fill at pressures below 1 millitorr.
Pores below 15 Å fill before a monolayer is completed on the surface of the larger pores. In the
micropore size range, the pore volume fills more gradually with pressure and the total shape of the
isotherm is important in characterizing the pore size.

Models Included

Non-Local Density Functional Theory with Density-Independent Weights

N2 - DFT Model
AR - DFT Model

Geometry: Slit
Substrate: Carbon (graphite)
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Using the methods of non-local density functional theory, two sets of isotherms have been
calculated to serve as kernel functions for the characterization of porous solids from adsorption
data. The model isotherms are stored in binary format files. These models assume a slit-like pore
geometry. The pore size range from 4.0 to 4000 Å is covered in 91 classes in a geometric
progression. The class intervals are rounded to the nearest 0.02 molecular diameters. A model for
the free or external surface is included to account for unfilled pores. Each of the 92 model
isotherms has been calculated at 181 pressure points from near 1×10-6 to near 1.00 relative
pressure.

These models are identical to those supplied with the original DOS version of DFT software.
Some slight difference from the DOS results may be noted when they are applied to the same
data due to improvements in the deconvolution algorithm and better regularization of the current
software.

Non-Local Density Functional Theory with Density-Dependent Weights

N2 - Modified Density Functional

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K
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Using the modified Tarazona prescription described by Olivier (see DFT Model References on
page B - 17 [items 3 and 4]), model isotherms were calculated for a wide range of adsorptive
energies to a relative pressure of 0.6. The model makes no provision for pore filling in the
micropore region. If the sample solid contains small mesopores, the isotherm data should be
truncated (using the Select Data Points window) to a suitably low relative pressure to avoid trying
to fit this region; mesopore filling reports as a large area of low energy in the calculated distribution
of adsorptive potential.

The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, i.e.,
for the adsorptive / adsorbent pair divided by Boltzmann constant. The units are therefore Kelvin.

N2 - Cylindrical Pores - Oxide Surface
AR - Cylindrical Pores - Oxide Surface

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using a combination of statistical mechanical calculations and
experimental observations for macroporous silicas and MCM-41 mesoporous silicas as well as
zeolites. The pore-filling pressures were determined as a function of the pore size from adsorption
isotherms on MCM-41 materials characterized by X-ray and other techniques. The variation of the
pore fluid density with pressure and pore size has been accounted for by density functional theory
calculations. The N2 model reports pore sizes ranging from 3.8 to 387 Å and the ARmodel from
3.8 to over 500 angstroms.

References: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A NewMethod for the
Accurate Pore Size Analysis of MCM-41 and Other Silica-Based Meso-
porous Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999).

N2 – Cylindrical Pores – Pillared Clay Surface (Montmorillionite)

Geometry: Cylinder
Substrate: Crystalline Silicate
Category: Porosity
Method: Nitrogen at 77K

Model isotherms were calculated using a combination of statistical thermodynamic Non-Local
Density Functional Theory (NLDFT) calculations and experimental isotherms for reference
samples of montmorillionite. The construction method for the hybrid models was analogous to that
described in the first reference below (Jaroniec et al,1999). The additional references add
additional theoretical details as well as examples of the application of the model to pillared clay
catalysts. This model reports pore widths from 3.8 to 387 angstroms.
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References: Mietec Jaroniec, Michal Kruk, James P. Olivier and Stefan Koch, “A New
Method for the Characterization of Mesoporous Silicas,” Proceedings of
COPS-V, 1999, Studies in Surface Science, Vol 128, Characterization of
porous Solids V , Unger, et al, Eds, Elsevier, Amsterdam, 2000.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
a Pillared Interlayered Clay (PILC) from a Hybrid Density Functional
Theory (DFT) Method,” The Journal of Physical Chemistry B; 2001, 105
(3), 623-629.

M. L. Occelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, “Surface
Area, Pore Volume Distribution, and Acidity in Mesoporous Expanded
Clay Catalysts from Hybrid Density Functional Theory (DFT) and
Adsorption Microcalorimetry Methods,” Langmuir 2002, 18, 9816-
9823.9b.

James P. Olivier, “The Importance of Surface Heterogeneity in
Developing Characterization Methods.” 6th International Symposium on
the Characterization of Porous Solids, Studies in Surface Science and
Catalysis 144, Elsevier, 2002.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
Pillared Rectorite Catalysts from a Hybrid Density Functional Theory
Method,”Microporous and Mesoporous Materials 2003, 57, 291-296.

C02 - DFT Model

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Carbon dioxide at 273 K

Model isotherms were calculated using the non-local prescription of Tarazona, employing
molecular parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model

Geometry: Free surface
Substrate: Any
Category: Surface energy
Method: Argon at 87K

This model was produced in the same manner as the N2 Modified Density Functional model listed
earlier, except applicable to argon adsorbed at 87.3 K.
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N2 - Tarazona NLDFT, Esf = 30.0K

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a cylindrical pore geometry. The wall potential used is k = 30 K, typical for
a silica or alumina surface.

This model file is particularly useful for sizing zeolites or zeolite containing materials that have
substantial micropore volume. The reported pore size range is 3.8 to 387 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Slit Pores by NLDFT
Ar - Carbon Slit Pores by NLDFT

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a slit-like pore geometry. These models are slightly different from N2-DFT
and Ar-DFT models that were calculated using NLDFT with density independent weighting
functions.

The reported pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Finite Pores, As=6, 2D-NLDFT
Ar - Carbon Finite Pores, As=6, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions assuming 2D model of finite slit pores having a diameter-to-width aspect ratio
of 6.

This model is particularly useful for microporous carbon materials. The reported pore size range is
from 3.5 to 250 angstroms.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore
structure analysis.,” The Journal of Physical Chemistry C, 113(45):19382-
19385, 2009.

N2 - Carbon Finite Pores, As=12, 2D-NLDFT
Ar - Carbon Finite Pores, As=12, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the same methods and assumptions that were used in the
model above except in this model, the aspect ratio is equal to 12.

These two finite pore models may be used as a research tool in conjunction with independent
analytical techniques such as high-resolution transmission electron microscopy (HRTEM) and/or
X-ray diffraction (XRD) to obtain comprehensive information about the structure of studied carbon
material.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore
structure analysis.,” The Journal of Physical Chemistry C, 113(45):19382-
19385, 2009.

N2 - Carbon Cylinder, single-wall nanotube by NLDFT
Ar - Argon Cylinder, single-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the graphitic surface of an
infinitely long cylinder.

This model is particularly useful for characterizing carbon single-wall nanotubes. The reported
pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and multiple concentric graphitic
surfaces of infinitely long cylinders.

This model is particularly useful for characterizing carbon multi-wall nanotubes. The reported pore
size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987)

Ar - Zeolites H-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an
infinitely long cylinder.
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This model is particularly useful for characterizing oxides and H+ and (NH4)+ exchanged zeolites.
The reported pore size range is from 3.5 to 300 angstroms.

Ar - Zeolites Me-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an
infinitely long cylinder.

This model is similar to the model above, but it more appropriate is for characterizing alkali metal
exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.

MODELS BASED ON CLASSICAL THEORIES
Both surface energy distribution and pore size distribution may be evaluated using classical
approaches to model kernel functions for use with equation (1) of the DFT Theory. The
Calculations document can be found on the Micromeritics web page (www.micromeritics.com). Be
aware that the deconvolution method only provides a fitting mechanism; it does not overcome any
inherent shortcomings in the underlying theory.

SURFACE ENERGY
The use of classical theories to extract adsorptive potential distribution is mostly of historical
interest. At a minimum, the equation must contain a parameter dependent on adsorption energy
and another dependent on monolayer capacity or surface area. This is sufficient to permit the
calculation of the set of model isotherms that is used to create a library model. The Langmuir
equation has been used in the past, as have the Hill-de Boer equation and the Fowler-
Guggenheim equation. All of these suffer from the fact that they only describe monolayer
adsorption, whereas the data may include contributions frommultilayer formation.

Models Based on Classical Theories
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B DFT Models

PORE SIZE
It is well established that the pore space of a mesoporous solid fills with condensed adsorbate at
pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When
combined with a correlating function that relates pore size with a critical condensation pressure,
this knowledge can be used to characterize the mesopore size distribution of the adsorbent. The
correlating function most commonly used is the Kelvin equation. Refinements make allowance for
the reduction of the physical pore size by the thickness of the adsorbed film existing at the critical
condensation pressure. Still further refinements adjust the film thickness for the curvature of the
pore wall.

The commonly used practical methods of extracting mesopore distribution from isotherm data
using Kelvin-based theories, such as the BJH method, were for the most part developed decades
ago and were designed for hand computation using relatively few experimental points. In general,
these methods visualize the incremental decomposition of an experimental isotherm, starting at
the highest relative pressure or pore size. At each step, the quantity of adsorptive involved is
divided between pore emptying and film thinning processes and exactly is accounted for. This
computational algorithm frequently leads to inconsistencies when carried to small mesopore
sizes. If the thickness curve used is too steep, it finally will predict a larger increment of adsorptive
for a given pressure increment than is actually observed; since a negative pore volume is non-
physical, the algorithm must stop. Conversely, if the thickness curve used underestimates film
thinning, accumulated error results in the calculation of an overly large volume of (possibly
nonexistent) small pores.

The use of equation (1) represents an improvement over the traditional algorithm. Kernel
functions corresponding to various classical Kelvin-based methods have been calculated for
differing geometries and included in the list of models.

MODELS INCLUDED

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Halsey equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:
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Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Halsey Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948).

Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Harkins and Jura equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

References: W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944).
J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966).

Models Based on Classical Theories
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B DFT Models

Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Broekhoff-de Boer equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887g cm-3

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is similar to the above except that cylindrical geometry is assumed, and the film
thickness depends on pore size (see reference).

References: Specifically, equations 20 and 21 in: J.C.P. Broekhoff and J.H. de Boer,
“The Surface Area in Intermediate Pores,” Proceedings of the Inter-
national Symposium on Surface Area Determination, D.H. Everett, R.H.
Ottwill, eds., U.K. (1969).
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DFT MODEL REFERENCES
The papers listed below provide additional information on DFT models:

1. “Determination of Pore Size Distribution from Density Functional Theoretic Models of
Adsorption and Condensation within Porous Solids,” J.P. Olivier and W.B. Conklin, Micro-
meritics Instrument Corp; presented at the International Symposium on the Effects of Sur-
face Heterogeneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland (July
1992).

2. “Classification of Adsorption Behavior: Simple Fluids in Pores of Slit-shaped Geometry,”
Perla B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, Elsevier
Science Publishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density Functional
Theory,” J.P. Olivier, Journal of Porous Materials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity Using Model Isotherms Calculated
by Density Functional Theory,” J.P. Olivier; presented at the Fifth International Conference
on the Fundamentals of Adsorption, Pacific Grove, CA (1995).

DFT Model References
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C EXPORTED DATA EXAMPLE

1 Sample Information
2 Method: Default
3 Sample: Activated Carbon
4 Operator: ELV
5 Submitter: SN 298
6 Mass type: Calculated
7 Empty tube: 35.1473 g
8 Sample + tube: 35.2597 g
9 Sample mass: 0.1124 g

10 Density: 1.000 g/cm³
11 Type of data: Automatically collected
12 Instrument type: 2425
13 Original instrument type: 2425
14 Comments:
15 Sample Tube
16 Sample tube: W1
17 Ambient free space: 1.0000 cm³
18 Analysis free space: 1.0000 cm³
19 Non-ideality factor: 0.0000620
20 Use isothermal jacket: Yes
21 Use filler rod: No

C Exported Data Example
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22 Vacuum seal type: None
23 Degas Conditions
24 Degas conditions: Degas Conditions
25 Eva cu a tio n Ph a se
26 Temperature ramp rate: 10.0 K/min
27 Target temperature: 303 K
28 Evacuation rate: 0.67 kPa/s
29 Unrest. evacuation from: 0.67 kPa
30 Vacuum level: 1e-03 kPa
31 Evacuation time: 10 min
32 H e a tin g Ph a se
33 Sample prep:
34 Stage
35 Temperature (K) Ramp Rate
36 (K/min)
37 Time (min)
38 1 303 10.0 10
39 Eva cu a tio n a n d H e a tin g Ph a se s
40 Hold pressure: 13.3 kPa
41 Ba ckfill
42 Backfill sample tube: Yes
43 Analysis Conditions
44 Analysis conditions: Silica Alumina, Surface Area, N2 @ 77 K

C Exported Data Example
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45 Isotherm collection: Target Pressure
46 Absolute pressure dosing: No
47 Pre ssu re Ta b le
48 Starting Pressure
49 (p/p°)
50 Pressure
51 Increment (p/p°)
52 Ending Pressure
53 (p/p°)
54 0.000000000 0.001000000
55 0.001000000 0.004000000
56 0.004000000 0.007000000
57 0.007000000 0.010000000
58 0.010000000 0.020000000
59 0.020000000 0.030000000
60 0.030000000 0.040000000
61 0.040000000 0.050000000
62 0.050000000 0.060000000
63 0.060000000 0.070000000
64 0.070000000 0.080000000
65 0.080000000 0.090000000
66 Pre ssu re Ta b le
67 Starting Pressure

C Exported Data Example
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68 (p/p°)
69 Pressure
70 Increment (p/p°)
71 Ending Pressure
72 (p/p°)
73 0.090000000 0.100000000
74 0.100000000 0.125000000
75 0.125000000 0.150000000
76 0.150000000 0.175000000
77 0.175000000 0.200000000
78 0.200000000 0.225000000
79 0.225000000 0.250000000
80 0.250000000 0.275000000
81 0.275000000 0.300000000
82 0.300000000 0.325000000
83 0.325000000 0.350000000
84 0.350000000 0.375000000
85 0.375000000 0.400000000
86 0.400000000 0.425000000
87 0.425000000 0.450000000
88 0.450000000 0.475000000
89 0.475000000 0.500000000
90 0.500000000 0.525000000

C Exported Data Example
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91 0.525000000 0.550000000
92 0.550000000 0.575000000
93 0.575000000 0.600000000
94 0.600000000 0.625000000
95 0.625000000 0.650000000
96 0.650000000 0.675000000
97 0.675000000 0.700000000
98 0.700000000 0.725000000
99 0.725000000 0.750000000
100 0.750000000 0.775000000
101 0.775000000 0.800000000
102 0.800000000 0.825000000
103 0.825000000 0.850000000
104 0.850000000 0.875000000
105 0.875000000 0.900000000
106 0.900000000 0.925000000
107 0.925000000 0.950000000
108 0.950000000 0.975000000
109 0.975000000 0.995000000
110 0.995000000 0.958421053
111 0.958421053 0.921842105
112 0.921842105 0.885263158
113 0.885263158 0.848684211

C Exported Data Example
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114 0.848684211 0.812105263
115 0.812105263 0.775526316
116 0.775526316 0.738947368
117 0.738947368 0.702368421
118 0.702368421 0.665789474
119 0.665789474 0.629210526
120 0.629210526 0.592631579
121 0.592631579 0.556052632
122 0.556052632 0.519473684
123 0.519473684 0.482894737
124 0.482894737 0.446315789
125 0.446315789 0.409736842
126 0.409736842 0.373157895
127 0.373157895 0.336578947
128 0.336578947 0.300000000
129 Pre p a ra tio n
130 Fast evacuation: No
131 Evacuation rate: 0.67 kPa/s
132 Unrestricted evacuation from: 0.67 kPa
133 Vacuum setpoint: 1.3 Pa
134 Evacuation time: 0.10 h
135 Leak test: No
136 Use TranSeal: No

C Exported Data Example
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137 Fre e Sp a ce
138 Entered
139 Ambient free space: 27.5196 cm³
140 Analysis free space: 84.6848 cm³
141 p ° a n d Te m p e ra tu re
142 p° type: Measured in Psat tube for each point
143 Temperature type: Entered
144 Temperature: 77.300 K
145 D o sin g
146 Use first pressure fixed dose: Yes
147 First pressure fixed dose: 0.89230 mmol/g
148 Use maximum volume increment: No
149 Target tolerance: 5.0% or 0.6666 kPa
150 Low pressure dosing: No
151 Eq u ilib ra tio n
152 Relative
153 Pressure (p/p°)
154 Equilibration
155 Interval (s)
156 1 1.000000000 10
157 Minimum equilibration delay at p/p° >= 0.995: 600 s
158 Sa m p le Ba ckfill
159 Backfill at start of analysis: Yes

C Exported Data Example
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160 Backfill at end of analysis: Yes
161 Backfill gas: N2
162 Adsorptive Properties
163 Adsorptive: Nitrogen @ 77.35 K (N2)
164 Non-condensing adsorptive: No
165 Maximum manifold pressure: 123.323 kPa
166 Therm. tran. hard-sphere diameter: 3.8600 Å
167 Molecular cross-sectional area: 0.162 nm²
168 Adsorbate molecular weight: 2.00
169 Thermal conductivity: 1.00
170 Non-ideality factor: 0.0000620
171 Density conversion factor: 0.0015468
172 Dosing method: Normal
173 Psa t vs. Te m p e ra tu re Ta b le
174 Saturation
175 Pressure (kPa)
176 Temperature (K)
177 1 80.0192 75.40
178 2 84.5947 75.85
179 3 89.9104 76.35
180 4 96.0481 76.90
181 5 98.9411 77.15
182 6 101.3028 77.35

C Exported Data Example
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183 7 103.7071 77.55
184 8 107.3945 77.85
185 9 113.7597 78.35
186 10 120.4064 78.85
187 Report Options
188 Report options: Report Options
189 Show report title: Yes
190 Report title:
191 Show graphic: Yes
192 Graphic file: miclogo.emf
193 Graphic height: 0.250 in
194 Graphic width: 2.000 in
195 Apply thermal transpiration correction: No
196 Summary: No
197 Isotherm: Yes
198 Iso th e rm R e p o rts
199 Elapsed time: Yes
200 Time between points: No
201 Plot adsorption branch: Yes
202 Plot desorption branch: Yes
203 Quantity adsorbed: Per Gram
204 Tabular report selected: Yes
205 Linear plot selected: Yes

C Exported Data Example
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206 Logarithmic plot selected: Yes
207 Linear absolute plot selected: Yes
208 Pressure composition plot selected: Yes
209 Iso th e rm L in e a r Plo t a xis d a ta
210 Plot curve: Yes
211 Plot points: Yes
212 Overlay samples: No
213 Autoscale X axis: Yes
214 Autoscale Y axis: Yes
215 Iso th e rm L o g Plo t a xis d a ta
216 Plot curve: Yes
217 Plot points: Yes
218 Overlay samples: No
219 Autoscale X axis: Yes
220 Autoscale Y axis: Yes
221 Iso th e rm L in e a r Ab so lu te Plo t a xis d a ta
222 Plot curve: Yes
223 Plot points: Yes
224 Overlay samples: No
225 Autoscale X axis: Yes
226 Autoscale Y axis: Yes
227 Iso th e rm L o g Ab so lu te Plo t a xis d a ta
228 Plot curve: Yes

C Exported Data Example
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229 Plot points: Yes
230 Overlay samples: No
231 Autoscale X axis: Yes
232 Autoscale Y axis: Yes
233 Iso th e rm Pre ssu re Co m p o sitio n a xis d a ta
234 Plot curve: Yes
235 Plot points: Yes
236 Overlay samples: No
237 Autoscale X axis: Yes
238 Autoscale Y axis: Yes
239 BET: No
240 Langmuir: No
241 Freundlich: No
242 Temkin: No
243 t-Plot: No
244 Alpha-S Method: No
245 f-Ratio Method: No
246 BJH Adsorption: No
247 BJH Desorption: No
248 Dollimore-Heal Adsorption: No
249 Dollimore-Heal Desorption: No
250 Horvath-Kawazoe: No
251 NLDFT Advanced PSD: Yes
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252 N L D FT Ad va n ce d PSD R e p o rts
253 Type: DFT
254 Geometry: Slit
255 Model: N2 @ 77 on Carbon Slit Pores by NLDFT
256 Dual sample: ...\Activated Carbon c1003 Carbon Dioxide Tube W1 P...
257 Dual model: CO2@273-Carbon, NLDFT
258 Regularization: Non-negative Regularization: 0.01000
259 R e p o rts
260 Pore Table: Yes
261 Isotherm Table: Yes
262 Cumulative Area Graph: Yes
263 Incremental Area Graph: Yes
264 dA/dW Area Graph: Yes
265 dA/dlog(W) Area Graph: Yes
266 Cumulative Volume Graph: Yes
267 Incremental Volume Graph: Yes
268 dV/dW Volume Graph: Yes
269 dV/dlog(W) Volume Graph: Yes
270 Log Goodness of Fit Graph: Yes
271 Goodness of Fit Graph: Yes
272 DFT Pore Size: No
273 DFT Surface Energy: No
274 Dubinin: No
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275 MP-Method: No
276 Advanced Rpt.: No
277 Options: No
278 Sample Log: No
279 Validation: No
280 Manufacturing: No

C Exported Data Example
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D FREE-SPACE CORRECTION
Free space is that volume of the sample tube which is unoccupied by the sample. The quantity of
gas dosed into the sample tube is calculated from the difference in pressures in the manifold
before and after the dose is delivered. The quantity of gas adsorbed by the sample is calculated
by subtracting the quantity of gas remaining in the free space of the sample tube after equilibrium
is established from the quantity of gas originally dosed into the sample tube. Free space must be
determined accurately to obtain a precise value for quantity adsorbed.

Static-volumetric systems consist basically of a gas manifold joined to a sample tube by an
isolation valve. The manifold section has connections for an absolute pressure transducer, a
temperature gauge, and a vacuum system. It also has inlets for the adsorptive gas and helium. A
Dewar flask containing a cryogenic liquid (usually LN2 at approximately 77 K) is situated so that it
can be raised to immerse most of the sample tube. Two temperature zones exist within the
sample tube when immersed in the cryogenic bath: a warm zone (the volume above the liquid
level and near ambient temperature) and a cold zone (the volume below the liquid level at
cryogenic temperature). Not only must the total free space volume be determined, but it also is
necessary to determine the quantity of gas residing within the “cold” zone since a nonideality
correction must be applied to only that quantity of gas.

The total quantity of gas in the partly immersed sample holder cannot simply be determined using
n = PV/RT because temperature is not constant over the total volume, but instead is distributed as
two temperature zones with a steep temperature gradient between them. A convenient method for
resolving this problem is to derive two factors which, for the existing temperature profile, can be
multiplied by the prevailing pressure to reveal the molar volume of gas contained in the cold zone
and the total quantity residing in the free volume of the immersed sample holder (the analysis free
space).

The analyzer provides the following methods for free space determination:

n Measure
n Calculate
n Enter

MEASURE

Generally, this method, although requiring a little more time (approximately 10 minutes), is the
most preferred one for determining free space. It is simple, automatic, requires very little
information, and essentially is error-proof. With this method, the instrument first evacuates the
manifold and sample tube (containing sample), then isolates the sample tube by closing the valve.
Then the manifold is charged with helium, the pressure measured, and the valve opened allowing
the helium to expand into the sample tube at ambient temperature. Again the pressure is
measured.

D Free-Space Correction
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D Free-Space Correction

The Dewar is raised and the sample tube is cooled to cryogenic temperature. Again pressure
drops; when pressure has equilibrated, the value is recorded. Ambient and analysis free spaces
are calculated from (1) system volume, (2) system, ambient, and bath temperatures, and (3)
measured pressures. From these, the value of the portion of analysis free space at cryogenic
temperature which requires correction for nonideality can be determined.

This method may be undesirable if:

n Helium is unavailable. Free space determination by the analyzer requires the use of helium.
n Analysis speed is a major factor. A helium free space measurement of 10 to 15 minutes is

required.
n The sample tends to absorb and retain helium for a prolonged period of time or if it adsorbs

helium.

CALCULATE
This method is the most rapid and efficient way of compensating for free space. With the sample
tube free space procedure, Helium-free analysis can be achieved. Ensure the following is
accomplished:

1. Perform a blank or sample tube free space analysis on the sample tube.

2. Load the blank analysis file data into the sample tube file or use the sample tube file from a
sample tube free space analysis.

3. Enter the analysis bath temperature (found on the p° and Temperature window).

4. Enter the sample mass and density (found on the Sample Description tab).

ENTER
This method allows for entering predetermined values for the ambient and analysis free spaces.
The values to enter may be obtained in one of two ways:

n A pre-analysis free space calibration of the sample tube containing sample.
n The total free space of an empty sample tube is measured and the displacement of the sample

calculated from its mass and density and subtracted from the total free space.

In either procedure, ensure that the level (or, in cases where the Isothermal Jacket is used, the
effective level) of the cryogen bath on the sample tube is the same when the analysis is performed
as it was when gathering data for free space calculations.
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E MAINTAIN HIGH-PURITY GASES

The analysis system was designed to accurately measure the surface area of all types of
materials. It is important that the gases (especially krypton) used for these measurements be of
highest purity, especially when analyzing low surface area samples. Three ways to ensure high-
purity gases are to always maintain:

n Thoroughly purged gas pressure regulators.
n Non-permeable gas lines.
n Leak-free connections.

Impure gas is strongly indicated, for example, if a series of measurements on a low surface area
material yields decreasing specific surface areas with decreasing quantities of sample. The
analyzer uses very small amounts of helium; therefore any residual air in the regulator can distort
results of subsequent analyses for quite some time.

Micromeritics offers the following suggestions to assist in maintaining high-purity gases
(particularly helium):

n Use metal gas lines only.
n Remove trapped air from the regulator and gas lines.

USE METAL GAS LINES
Always use metal gas lines which have been carefully cleaned of any oils and greases used in the
manufacturing process. Do not use plastic or rubber gas lines. When these types of permeable,
nonmetallic gas lines are used with helium, contaminants accumulate at a much faster rate. This
causes errors in analysis results and can also contaminate a clean sample.

REMOVE TRAPPED AIR
When connecting the regulator to the gas cylinder, air is unavoidably trapped on the high and low
pressure sides of the regulator, as well as in the gas lines. Remove as much of this air as is
possible before opening the gas cylinder valve. If this air is allowed to remain in the regulator, it
will mix with the helium and cause inaccurate results in subsequent analyses. Or if the valve is
open for any length of time, the air trapped on the high pressure side may diffuse back into the gas
cylinder and contaminate its entire contents.

There are two methods for removing trapped air from the regulator lines: the Purge Method and
the Evacuation Method.

E Maintain High-Purity Gases
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EMaintain High-Purity Gases

PURGE METHOD

This is the preferred method for removing trapped air.

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

If multiple instruments are installed, choose the correct Unitmenu.

2. Close all valves by right-clicking each valve, then click Close.
3. Open the regulator shut-off valve.
4. Open the gas cylinder valve briefly and allow the regulator to be charged with gas until the

high pressure gauge reads just over half the tank pressure, then quickly close the valve.

A. Gas tubing to instrument
B. Low pressure gauge
C. High pressure gauge
D. Regulator connecter nut
E. Gas cylinder shut-off valve
F. Regulator control knob

5. Use the Pressure Control knob to set the output pressure (gas cylinder pressure gauge) to
15 psig.

6. Loosen the fitting at the instrument helium inlet until the low pressure side drops to approx-
imately 3 psig (0.02 MPa), then tighten the fitting.

7. Repeat steps 4, 5, and 6 three times.
8. Briefly open the gas cylinder valve, then use the Pressure Control knob to reset the reg-

ulator output pressure to 15 psig.
9. After the pressure has stabilized (indicating there are no leaks), open the gas cylinder valve.
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EVACUATION METHOD

To use this method, the gas tank must be within 10 feet of the instrument.

1. Do one of the following:

If... Then...
The regulator has not
been filled with gas and
the gas line is attached
to the instrument:

Close the gas cylinder valve.

Open the regulator shut-off valve.

The regulator is filled
with gas:

Close the gas cylinder valve.
Open the regulator shut-off valve.
Loosen the helium inlet fitting (or nut) on the instrument.
Allow all of the gas in the regulator to expel from the line (pressure
reading will be zero).
Retighten the helium inlet fitting (or nut).

2. Go to Unit > Enable manual control (if the instrument schematic is not displayed, go to
Unit > Show instrument schematic).

If multiple instruments are installed, ensure the correct Unitmenu is selected.

3. Close all valves, then open valves 6, 7, and 10.
4. Allow evacuation to continue for 20 minutes. This pulls a vacuum on the helium line to the

gas cylinder. The manifold pressure transducer should fall close to zero.

Allow evacuation for a full 20 minutes. If evacuation time is too short, trapped air may
remain in the lines.

5. Close valves 6, 7, and 10.

E Maintain High-Purity Gases
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F SAMPLE DATA WORKSHEET FOR GAS ADSORPTION
Sample tube identification:

Sample Mass (g)
Before Degas After Degas After Analysis

1. Mass of empty sample tube set g

2. Mass of sample tube set plus sample g g g

3. Mass of sample (step 2 minus step 1) g g g

Degas Information
Degas apparatus
Temperature (°C)
Time (hours)
Actual time started
Actual time finished

Degas Notes:

F Sample Data Worksheet for Gas Adsorption
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